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Chapter 1

1. Overview of System Administration

Underlying the applications and tools you use on your workstation is the IRIX™ operating
system (a version of the UNIX® operating system). IRIX is much more flexible and
powerful than traditional personal computer operating systems in these ways:
•

IRIX is a multiuser operating system, which means several users can work on the
system simultaneously and maintain private files.

•

IRIX makes the workstation a multi-tasking system, which means the workstation
can run several applications, print files, and update files simultaneously.

•

IRIX lets you connect the workstation to a network where you can transparently
transfer files to and from another system or peripheral device.

•

IRIX lets you add a broad range of hardware peripherals such as printers, terminals,
disk drives, and modems without additional software.

Along with the advanced capabilities of the IRIX operating system come certain
responsibilities for setting up, maintaining, and troubleshooting it. This set of
responsibilities is known as system administration. Click a topic below for more
information.
•

“Choosing an Administrator” describes the responsibilities and permission levels of
different users.

•

“Performing System Administration Tasks” describes how to administer a system
using the System Manager’s interactive guides and the IRIX shell.
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Choosing an Administrator
You need to decide who will be responsible for keeping the system in good running order
and, if the system is connected to a network, who will work in conjunction with the
network administrator to access network services.

About User Privileges
Because many people may use the same system, it provides a built-in security scheme
where you can grant different people different capabilities for changing the system.
There are three levels of capability:
User

Any person who has a login account on the system. When users log in,
they can change only their personal workareas. Users can run the
interactive guides from the System Manager window, but guides that
change system information are not available unless a user knows the
password for the root account or has been assigned specific
administrative privileges.

Privileged User
A person whose login account includes administrative privileges. The
Administrator (see below) of the system can assign privileges to users
on an individual basis. Depending on what privileges a user has been
assigned, that user can use the interactive guides to make changes to the
system. For information about using the Privilege Manager to assign
privileges, see “Setting System Administration Privileges.”
Administrator The person who can use the most privileged account, the root account.
This person should have a personal login account for daily use, but,
when there are serious system problems to correct, the person logs in to
the root account to change system information using the interactive
guides or using the IRIX shell. The Administrator can change
information in the root account (such as the password) and log in to an
IRIX shell as root. Because there is only one root account, there is only
one Administrator per system.
This guide assumes that you are the Administrator of your own system
and as such, have access to the root account and password.
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Choosing an Administrator

In a large, secure, networked environment run by an experienced network administrator,
the scheme could work in this manner:
•

The network administrator is the Administrator for every system; this means that the
network administrator is the only person who can use the root account and who
knows the root password.

•

The Administrator creates a standard personal login account for each person who
uses a particular system; the average is three users per system.

•

Out of all the users, the Administrator selects one person to be responsible for
maintaining the system daily; the Administrator adds administrative privileges to
this person’s account using the Privilege Manager. See “Setting System
Administration Privileges” for more information.

In a smaller, less secure environment where each person has one system, the scheme
could work in this manner:
•

Each user is completely responsible for maintaining his or her own system. Users
typically perform administrative tasks while logged in to their personal accounts.
But when a user must use the IRIX shell with administrative privileges, the user
logs into the root account.

•

The Administrator adds login accounts for other people who occasionally need to
use the system. If one of these users ever needs to perform administrative tasks, the
Administrator assigns the appropriate privileges to the user’s account. See “Setting
System Administration Privileges” for more information.

The System Administrator’s Responsibilities
As the Administrator for a system, you are responsible for performing these tasks:
•

Setting up the system initially as a standalone system or as a member of an existing
network. (See “Setting Up Your System.”)

•

Creating login accounts so all users of the system can access it. (See “Creating a User
Login Account.”) If the system will be connected to a network, the Administrator
may work in conjunction with the network administrator.

•

Connecting any peripheral devices and configuring software so that the devices
work properly. (See “Setting Up Peripheral Connections” and “Setting Up Printer
Connections.”)
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•

Setting up a connection over a phone line using ISDN or a modem. (See the ISDN
User’s Guide for information about configuring ISDN; the guide also provides
information about setting up PPP (point-to-point protocol) connections. See
“Setting Up Network Connections” for information about setting up a modem.)

•

Installing application software and updating system software. (See Chapter 4,
“Installing and Removing Software.”)

•

Performing regular backups of the entire filesystem and, in some cases, of individual
users’ data, and restoring data when it is lost. (See “Backing Up and Restoring.”)

•

Monitoring and troubleshooting the system to keep it working efficiently and
properly. (See Chapter 6, “Managing Disks and Filesystems,” and Chapter 7,
“Maintaining the System,” and Chapter 8, “Troubleshooting.”)

If your system is part of a network, you are also responsible for these tasks:

4

•

Contacting the network administrator before connecting your system to the network.
The network administrator provides information that you need to uniquely identify
your system on the network and to ensure that the regular users of your system can
have accounts on other systems on the network. (See “Setting Up Network
Connections.”)

•

Making all, some, or none of your system’s directories available to all, some, or
none of the other systems and users on the network. (See “Making Your Disk Space
Available to Other Users.”)

•

Providing access to printers on other systems so the users working on your system
can send files to them. (See “Accessing a Printer Connected to a Remote
Workstation.”)

•

Providing access to removable media on other systems so the users working on
your system can use them. (See “Accessing Removable Media Devices Across the
Network.”

•

Providing access to disk space that’s available on other systems on the network.
(See “Using Disk Space on Other Systems.”)

Performing System Administration Tasks

The Network Administrator’s Role
The responsibilities of a network administrator vary greatly from site to site. If you will be
using the network, it’s important to contact the network administrator to understand all
the services that are available to you. In general, the network administrator is responsible
for these tasks:
•

Setting up and maintaining the network so connections are reliable and data is
transferred as quickly as possible.

•

Creating, maintaining, and periodically distributing a list of all systems and users
so that each has a unique identity on the network.

•

Setting up and maintaining network services such as electronic mail and the
Network Information Services (NIS).

For more information on network administration, see Chapter 1, “Understanding Silicon
Graphics’ Networking Products,” Chapter 2, “Planning a Network,” and Chapter 3,
“Setting Up a Network” in IRIX Admin: Networking and Mail.

Performing System Administration Tasks
You have the following options for performing system administration tasks.
•

The System Manager window provides access to the System Administration guides.
These interactive guides lead you step-by-step through the various system
administration tasks, such as adding a user account. Each guide consists of pages in
which you enter information. After you finish filling out the pages, you simply click
a button and your system completes the task. For more information, see “Using the
System Manager’s Interactive Guides.”

•

The IRIX shell accepts IRIX commands that you use for more advanced
administrative tasks.

This online information describes how to use the interactive System Administration
guides to perform most of the administration tasks; in cases where an interactive guide
does not exist for a particular task, you must use IRIX commands or edit system files. If
you prefer to perform all administrative tasks without using the interactive guides, see
the IRIX Admin set of guides (choose “Online Books” from the Help toolchest, and look
in the SGI_Admin bookshelf). Regardless of whether you edit system files manually or
use the interactive guides, you are changing the same system files.
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Using the System Manager’s Interactive Guides
To use the interactive system administration guides, follow these steps:
1.

Choose System Manager from the System toolchest.
The righthand column of the System Manager window displays an overview of the
System Manager and each of its categories. The lefthand column displays a table of
contents, organized by the various categories of guides.

2. To view the various guides, select categories in the lefthand column.
When you click a category, a list of the guides in that category appears in the
righthand column, along with several brief descriptions.
3. To open an interactive guide, click the title of the guide in the righthand column.
After a couple of seconds, the first page of the guide appears. This first page
describes the guide and tells you how many pages you’ll need to fill out to complete
it. (Most guides consist of four to ten pages.)
4. Read the information on the first page to learn about the guide and then click the
Next button to continue.
5. Enter information in the pages as requested, clicking the Next button to go to each
subsequent page.
If you want to go back to an earlier page, click the Prev button. You can also go back
to the first page of the guide using the Prev button.
The last page of the guide, usually titled “Confirm your settings,” gives you the
opportunity to view all of the settings you made in the previous pages.
6. If you agree with the settings on the last page, click the OK button to have the
system implement them.
If necessary, you can click Prev to go back and change any of the settings. You also
have the opportunity to quit without performing the task by clicking the Cancel
button.
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Overview of the Categories

The System Manager window provides the following categories of guides. You can find
descriptions of each category in the System Manager Overview window.
Software

Includes the Software Manager, which you can use to install software;
and the License Manager, which you use to add, remove, and update
software licenses on your system.

Hardware and Devices
Provides guides that let you manage printers, modems, serial devices,
hard disk drives, and removable media devices like CD-ROM, floppy,
and tape drives.
Security and Access Control
Provides guides to help you improve system security, manage user
accounts, control access to files, share files and directories, share printers
and removable media devices, and change users’ privileges on the
system.
Network and Connectivity
Includes guides that let you set up network connections on your local
network and over phone lines (including ISDN), turn on NIS (Network
Information Services), turn on NFS® (Network File System), mount
remote filesystems, and modify network settings.
Files and Data Contains guides that allow you to mount and unmount local
filesystems, and perform backups of important files and directories on
your workstation.
System Performance
Provides guides to help you improve performance by creating logical
and virtual swap space. Also gives you access to information about your
system, including the System Log and the System Administration Log.
The window also includes “Overview,” discussed earlier, and “About This System,”
which lets you view basic information about your system, including the version of
operating system running, the amount of main memory available, and so on.
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About the Managers

Many of the categories listed above also include Managers. You can use Managers to
view information about particular areas of your system, such as printers, serial devices,
filesystem, shared resources, and so on. You can also access various guides from within
a Manager window. For example, when you open the Serial Device Manager in the
Hardware and Devices category, a window appears and provides information about all
the serial devices currently connected to your system. The window also includes Add and
Delete buttons, which, when clicked, open the “Add a Serial Device” and “Delete a Serial
Device” guides, respectively.

Using the Shell Window
To perform administrative tasks that are not supported by the interactive guides, use the
root account in a shell window. The home directory for the root account is the root (/) directory
of the filesystem. The user logged in to the root account can move, change, and delete every
file and directory on the system, regardless of who owns them and what type of
permissions they have set. Be sure to create a password for the root account that only you,
as the Administrator, know. (See “Improving System Security.”)
Note: Some UNIX and IRIX documents refer to the user of the root account as the

superuser.
When you’re already logged in as a regular user, you can start a shell window and log in
as root by following these steps:
1.

Choose “Open Unix Shell” from the Desktop toolchest.

2. Position your cursor within the new window and type
login root

Then press <Enter>.
If a prompt for a password appears, type the password, then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>. (See
“Creating, Changing, and Deleting Passwords” to create, change, or remove a
password.)
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You are now logged in to the root account and are located in the root (/) directory. When you
are logged in as root, the IRIX prompt is a pound sign (#) rather than a percent sign (%).
To log out of the root account, type
logout

Then press <Enter>. The shell window disappears.
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2. Getting Started

This chapter contains these sections:
•

“Setting Up Your System”

•

“Logging In to Your System”

•

“Logging Out of the System”

Setting Up Your System
This section describes the how to use System Setup, an online, interactive guide. After
you complete System Setup, your system will have the basic information it needs to
create a personal workarea for you and to let you communicate with other systems and
people on your network.
System Setup takes you through a number of steps such as improving your system’s
security, putting your system on an existing network, creating a user account for
yourself, customizing your desktop, and setting up your connection to the World Wide
Web. To run System Setup, follow the steps below.
Note: If you plan to connect your system to an existing network, contact your network

administrator for a login name for yourself, a hostname and IP address for your system. If
your network runs NIS, also request your NIS domain name.
1.

Log in to the EZSetup account.
When you turn on your workstation, the login window appears after the system
finishes starting up. Use the left mouse button to double-click the EZsetup icon; this
launches System Setup.

2. Make your system secure.
You can improve your system’s security by helping to prevent access to your system
by unauthorized users. Step 1 lets you open the “Improve System Security” guide.
For more information, see “Improving System Security.”
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3. Set up your network connection.
If your system is already physically connected to a network, you need to configure
networking on your system. Step 2 lets you open the “Set Up and Start
Networking” guide. For more information, see “Setting Up an Ethernet
Connection.”
4. Create a user login account for yourself.
Step 3 lets you open the “Add a User Account” guide. For more information, see
“Creating a User Login Account.”
5. Customize your work environment.
Step 4 provides two sets of steps that let you set up your connection to the World
Wide Web and customize your user environment on the system.
After you complete the last step, click the Quit System Setup button. A notifier may
appear concerning JavaScript; click OK to restart the system.
The “Restart the System” guide appears; follow the instructions in the guide.
After the system restarts, you see the login window.
6. If you want to perform additional administration tasks, go to “Performing Other
Administration Tasks” for more information. (You may need to log into the root
account to perform the tasks; see “Logging In to Your System” for information.)
7. If you want to log in to your new user account now, follow the instructions in
“Logging In to Your System.”

Performing Other Administration Tasks
After you’ve set up your basic system, you may want to perform one or more of the
following administration tasks using the interactive System Administration guides. The
guides are available in the System Manager; to open the System Manager, choose
“System Manager” from the System toolchest. For more information, see “Using the
System Manager’s Interactive Guides.”
Note: You’ll need to log into the root account to perform most of these tasks. See

“Logging In to Your System” for instructions.
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•

If your system is connected to a network and if the network runs Network
Information Services (NIS), set up NIS on your system; see “Turning On NIS.”

•

If your system is connected to a network, and you want to share files with other
users, set up Network File System (NFS); see “Turning On NFS.”

•

Customize your network settings; see “Modifying Network Settings.”

•

Create login accounts for each person who will use the system; see “Creating a User
Login Account.”

•

Install additional software options or applications; see “Installing Software.”

•

Set up peripherals, such as a printer, disk drive, or modem; see “Setting Up Printer
Connections” and “Setting Up Peripheral Connections.”

•

Set up a connection over a phone line; see the ISDN User’s Guide, available online,
for information about configuring ISDN and about creating Point-to-Point Protocol
(PPP) connections using ISDN or a modem.

•

Develop a plan for backing up and restoring your system, and learn how to
implement it; see “Backing Up and Restoring.”

•

Set the time and date so the system can accurately track system activity; see “Setting
the Time and Date.”

Logging In to Your System
To log in to your personal workarea on the system, follow these steps:
1.

In the login window, find the icon that is labeled with your login name and
double-click it; if your account has no password, the system logs you in.
If an icon for your account doesn’t appear in the login window, type your login
name in the field and press <Enter>.

2. If a Password field appears, enter the password, then click the Login button.
To add new user accounts on the system, see “Creating a User Login Account.”
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Logging Out of the System
You can log out of the system to end your current login session. Make sure you save all
your work before you log out.
To log out of the system, follow these steps:
1.

Choose Log Out from the Desktop toolchest.
A notifier appears and asks if you want to log out now.

2. Click Yes to log out now or click No if you want to continue your login session.
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3. Setting Up Network, Peripheral, and Printer
Connections

This chapter contains these sections:
•

“Setting Up Network Connections”

•

“Setting Up Peripheral Connections”

•

“Setting Up Printer Connections”

Setting Up Network Connections
This section describes how to set up and test your network connection, make changes to
your network settings, set up a modem connection, and enable electronic mail. Click a
topic for more information:
•

“Understanding Networking”

•

“Setting Up an Ethernet Connection”

•

“Setting Up Other Network Connections”

•

“Setting Up a New Ethernet Network”

•

“Modifying Network Settings”

•

“Turning On NIS and NFS”

•

“Testing the Network Connection”

•

“Setting Up Electronic Mail”

•

“Setting Up a Modem”
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Understanding Networking
A network can provide these valuable services:
•

It lets you efficiently and transparently share peripheral hardware such as printers
and drives.

•

It lets you quickly and easily share data and applications.

•

It provides many channels of communication, including electronic mail, electronic
bulletin boards, and teleconferencing.

Fundamentally, a network expands a system’s capabilities in a simple, cost-effective way.
Because you can access peripherals, directories, and files on other systems as if they were
connected directly to your own system, your system essentially has
•

unlimited disk space

•

as many input and output devices as are on the network, such as scanners and
printers

•

the ability to read as many media types as there are drive types on the network,
such as CD, tape, or floppy

•

a large assortment of applications (depending on how the software licensing is
arranged)

Note: To share files and directories transparently, you need to purchase the optional NFS

networking software.
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Setting Up Network Connections

You can set up a network connection in a number of ways:
•

If there is an existing Ethernet network available and you can connect your system
to it via an Ethernet cable, see “Setting Up an Ethernet Connection.”

•

If there is an existing Ethernet network available but you cannot connect your
system to it via an Ethernet cable, you can do one of the following:
–

Use your system’s serial port, the standard UUCP and PPP software, and an
optional modem to connect via a telephone line; see “Setting Up a Modem.”

–

Use your system’s ISDN port (if it has one), the standard ISDN software, and
optional hardware to connect via an ISDN telephone line; see the ISDN User’s
Guide for information.

–

To connect to an existing FDDI, TokenRing, or Sync Serial network, you must
purchase optional communications boards, and may need optional software
from Silicon Graphics. Then see “Setting Up Other Network Connections.”

–

If there is no existing Ethernet network available, you can set up a new one; see
“Setting Up a New Ethernet Network.”

Overview of the Network Interface Manager
The Network Interface Manager displays information about the network interfaces
configured on the system. It includes the name of the network interface, the hostname of
your workstation (including domain information), your workstation’s IP address, and
whether an interface is your primary network interface.
You can use the Get Info button to display information about a network interface. Select
the interface in the window and click Get Info. A Network Interface Panel appears and
displays information about the selected interface.
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About the Menus

The Task menu contains these choices:
•

“Configure” opens the “Set Up and Start Networking” guide, which lets you
configure a network interface on your system in order to connect your workstation
to an existing network. This command is equivalent to the Configure button. See
“Setting Up an Ethernet Connection” or “Setting Up Other Network Connections”
for information.

•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Network Interface Manager window. Any changes you made
using the guides are saved. This command is equivalent to the Close button.

The Arrange menu contains this choice:
•

“By Interface” lets you list the interfaces alphabetically.

•

“By Hostname” lets you list the interfaces alphabetically according to the name of
the corresponding workstation.

•

“By IP address” lets you list the interfaces by their IP addresses.

Setting Up an Ethernet Connection
Your system comes standard with an Ethernet port and the TCP/IP software that you need
to connect your system to an existing Ethernet network. The information below assumes
that you have physically connected your system to an existing Ethernet network using
an Ethernet cable, and that your network administrator has provided you with
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•

a hostname and IP address for your system

•

your network’s NIS domain name (you need this only if your network runs NIS)

•

an active Ethernet connection

Setting Up Network Connections

To set up networking on your system, use the “Set Up and Start Networking” interactive
guide, available in the System Manager. Choose “System Manager” from the System
toolchest, and then select the Network and Connectivity category in the lefthand column
of the System Manager window. In the righthand column, click “Set Up and Start
Networking.” The guide appears and leads you through the steps necessary to set up
networking on your system. (To set up an Ethernet connection, most users will want to
choose “ec0” as the network interface; Step 2 in the guide lets you do this.)
Note: If you have more than one network port installed, you need to perform the steps

in the “Set Up and Start Networking” guide for each port.
To test your network connection, see “Testing the Network Connection.”

Setting Up Other Network Connections
Your system comes standard with Ethernet hardware and software. You may also
purchase these optional networking interface products:
•

FDDI

•

TokenRing

•

Sync Serial

Once the optional board and its supporting software are installed, contact your network
administrator for this information:
•

a hostname and IP address for your system

•

your network’s NIS domain name (you need this only if your network runs NIS)

You can turn on networking software by using the “Set Up and Start Networking”
interactive guide, available in the System Manager window. Choose “System Manager”
from the System toolchest, and then select the Network and Connectivity category in the
lefthand column. In the righthand column, click “Set Up and Start Networking.” The
guide appears and leads you through the steps necessary to set up a network connection
using the optional product you’ve installed.
To try out your new network connection, see “Testing the Network Connection.”
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Setting Up a New Ethernet Network
This information describes how to set up a small Ethernet network of Silicon Graphics
systems. It does not cover the issues involved in integrating Silicon Graphics systems
into other types of existing networks, or the issues involved in connecting your small
network to the larger Internet system.
If possible, select one person to set up and take care of the network. It does not require
much maintenance, and having someone in charge can eliminate confusion later. This
person is referred to as the network administrator in other online information. This person
must also be the Administrator for his or her own system, which will be the master system
on the network.
The network administrator will assign a unique name (a hostname) and a unique number
(an IP address) to each system on the network. The hostname should be 10 lower-case
characters or less, and cannot contain any spaces or special characters; the IP address is
four numbers separated by periods (.) such as 100.1.1.1.
To set up your network, follow these steps:
1.

Physically connect the systems with Ethernet cables and transceiver boxes.

2. Start up all of the systems.
3. On the master system (the system that the network administrator uses), set up
networking using the “Set Up and Start Networking” interactive guide. Cchoose
System Manager from the System toolchest, select the Network and Connectivity
category, and then click “Set Up and Start Networking” in the righthand column.
See “Setting Up Network Software on the Master System” for details on turning on
the software on the master system.
4. On each of the other systems, set up networking using the “Set Up and Start
Networking” interactive guide.
See “Setting Up Network Software on the Client Systems” for details on turning on
the software on other systems.
To try out your new network, see “Testing the Network Connection.”
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Setting Up Network Software on the Master System

You need to set up networking on the master system. Before performing these steps,
make sure you know the hostname and IP address of each client system on the network;
it’s probably a good idea to write this information down.
Follow these steps:
1.

Log into the master system as root.

2. Open the “Set Up and Start Networking” guide.
Choose “System Manager” from the System toolchest, select the Network and
Connectivity category, and then click “Set Up and Start Networking.”
3. Follow the step-by-step instructions in the guide and then click OK on the last page.
4. Create a master list of hostnames and IP addresses on the master system.
■

Open a shell window by choosing “Open Unix Shell” from the Desktop
toolchest.

■

Create a file called /etc/hosts with a text editor such as jot by typing
jot /etc/hosts

Then press <Enter>.
■

In the /etc/hosts file, type the hostnames and IP addresses of the client systems
on the network. Use the following format, substituting your client systems’ IP
addresses and hostnames for the examples below:
190.10.6.5

■

mergatroid.eng.sgi.com

Save the file and quit jot.

5. Log out of the master system by choosing “Log Out” from the Desktop toolchest.
Now you need to set up the client systems; see “Setting Up Network Software on the
Client Systems.”
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Setting Up Network Software on the Client Systems

Once the master system is set up (see “Setting Up Network Software on the Master
System”), you must set up software on the rest of the systems that are connected to the
network.
On each client system on the network, follow these steps:
1.

Log in to the client system as root.

2. Open the “Set Up and Start Networking” guide.
Choose “System Manager” from the System toolchest, select the Network and
Connectivity category, and then click “Set Up and Start Networking.”
3. Open a shell window by choosing “Open Unix Shell” from the Desktop toolchest.
4. Copy the hosts list from the master system to the client system by typing
rcp guest@IPaddress:/etc/hosts /etc/hosts

Then press <Enter>. Replace IPaddress with the IP address of the master system.
5. Log out of the system by choosing “Log Out” from the Desktop toolchest.
To try out the new network, see “Testing the Network Connection.”

Understanding the Host List
Each system on a network has a unique hostname and IP address. On an established
network, the network administrator creates a master list of all hostnames and IP addresses,
and stores it in the /etc/hosts file on the master system.
If you are setting up a new, small network (that is, if you need to build a master list), see
“Setting Up a New Ethernet Network.” If you have a host list already but need to add
another host, you can use the “Modify Networking” guide; see “Adding Hosts to a Host
List.” All hosts that you add using this guide are added to the end of the /etc/hosts file.
To delete a host from the hosts list, an experienced Administrator must delete the host’s
line from the /etc/hosts file using a text editor such as jot or vi.
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Adding Hosts to a Host List

You can use the “Modify Network Settings” guide to add a host to the list of hosts that
your system can access across the network. (The list of hosts is located in the /etc/hosts
file.) You cannot delete hosts from the list using this guide.
Follow these steps:
1.

Open the “Modify Network Settings” guide
Choose “System Manager” from the System toolchest, select the Network and
Connectivity category, and then click “Modify Network Settings.”

2. Click the Next button until you reach the page titled “Add an Entry to the Hosts
File.”
3. Follow the instructions on that page.
4. After you’ve added a new host to the hosts file, go to the last page in the guide and
click the OK button to update your /etc/hosts file.

Modifying Network Settings
After you’ve set up basic networking on the system, you may want to make changes to
certain networking settings on the system. The “Modify Network Settings” guide lets
you make these changes:
•

Disable the primary networking interface on your workstation if it isn’t currently
connected to the network. (You may find this useful if you’re planning to use ISDN
to connect to a remote workstation over a phone line.)

•

Add a default route to the system’s routing table in order to enable your workstation
to establish a connection with a remote workstation.

•

Enable IP forwarding in order to supply routing information to your workstation.

•

Add the hostname of a remote workstation to your local hosts file to enable
communications between the two workstations.

To open the guide, choose “System Manager” from the System toolchest, if it isn’t already
running. Select the Network and Connectivity category and click “Modify Network
Settings.”
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Turning On NIS and NFS
NFS is optional software that enables you to access files and directories located on remote
systems on the network as if they were located on your local system.
Turning On NFS

To turn on NFS, open the System Manager window if it’s not already open (choose
System Manager from the System toolchest). Select the Network and Connectivity
category and then click “Set up and Start NFS” in the righthand column. The guide
appears and leads you through the necessary steps.
Note: If you do not have the NFS software installed, the system displays an error

message and exits the “Set Up and Start NFS” guide. You need to purchase NFS and use
the Software Manager to install it; then you can restart the “Set Up and Start NFS” guide.
Once you’ve turned on NFS, you can use the “Find Remote Resources” window to locate
items available for sharing on the network. You can open this window using one of these
methods:
•

Choose “Access Files” from the Desktop toolchest and then choose “On a Remote
Workstation” from the rollover menu.

•

Choose “System Manager” from the System toolchest, select the Network and
Connectivity category, and then click “Find Remote Resources” in the righthand
column.

For additional information, see “Sharing Directories With Other Systems” and “Finding
Another System’s Shared Resources” in the Desktop User’s Guide.
To turn off NFS, select the Network and Connectivity category and click “Turn Off NFS”
in the righthand column; a guide appears. Once you turn off NFS, you won’t be able to
share files with other users on the network.
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Turning On NIS

NIS (Network Information Services) provides a centralized database of information
about systems on the network. Your system can take advantage of this service to look up
the hostname or IP address of a particular system on the network. Turn on NIS only if
your network administrator tells you it is necessary and provides you with an NIS
domain name.
To turn on NIS, open the System Manger window if it’s not already open (choose System
Manager from the System toolchest). Select the Network and Connectivity category and
then click “Set Up and Start NIS” in the righthand column. The guide appears and leads
you through the necessary steps.
Note: If you do not have the NIS software installed, the system displays an error

message and exits the “Set Up and Start NIS” guide. You need to purchase NIS and use
the Software Manager to install it, then you can restart the “Set Up and Start NIS” task.
To turn off NIS, select the Network and Connectivity category and then click “Turn Off
NIS” in the righthand column; a guide appears. Once you turn off NIS, your system
won’t be able to use NIS to find information about other systems on the network.

Testing the Network Connection
To test a network connection, follow these steps:
1.

Choose “Host QuickFind” from the Find toolchest.

2. In the field, type the name of a system that you know is running and is connected to
the network.
•

If the icon for the system appears in the drop pocket window, your network
connection is working.

•

If the icon does not appear, try typing the name of another system. If an icon
still does not appear, see “Troubleshooting Network Errors.”
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Setting Up Electronic Mail
You can set up your system to send and receive electronic mail (e-mail) once you have
verified that the network connection works (see “Testing the Network Connection”).
The IRIX e-mail system has two parts:
•

The first part is the application that you use to read, compose, and send mail; your
system comes with Netscape Mail. For information about using Netscape Mail, see
the online help in Netscape.

•

The second part is sendmail, the mechanism that interprets your mail messages and
sends them to the correct location.

The following sections give you a brief introduction to how sendmail works, then show
you how to set up mail automatically by using the configuration program
/usr/etc/configmail setup. For more detailed information on sendmail, see Chapter 8, “IRIX
sendmail,” in IRIX Admin: Networking and Mail.
About sendmail

sendmail routes mail through a network using two pieces of information: your system’s
domain name and the hostname of your domain’s forwarder (the system that forwards mail
from your domain to other domains). You can obtain this information from your network
administrator.
A domain is a group of systems whose hostnames have the same suffix; this suffix is the
domain name. For example, mars.bldg1.abc and saturn.bldg1.abc belong to the bldg1.abc
domain, while venus.bldg2.abc belongs to the bldg2.abc domain.
To simplify network administration and increase network efficiency, large networks
typically consist of several domains. For example, company abc has one large network
that connects systems that are in buildings 1, 2, and 3. Its overall network is abc and it
consists of three domains: bldg1.abc, bldg2.abc, and bldg3.abc. All systems that physically
reside in building 1 are in the bldg1.abc domain, and so on. Often systems that are part of
the same domain are physically close to each other. A typical hostname on this network
can be mars.bldg1.abc.
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Small networks typically consist of a single domain, or may not even use the concept of
domains. For example, company xyz has a simple one-domain network called xyz; all
hostnames end in .xyz. Because all hostnames have the same suffix, the suffix has no
significance, so company xyz can simply drop the suffix and therefore drop the concept
of domains altogether.
If the hostname that you chose with your network administrator has a period (.) in it,
your site uses domains. Your domain name is everything that follows the first period. For
example, the domain name of host mars.bldg1.abc is bldg1.abc.
When you send mail to a system that is in your domain, sendmail delivers the mail
directly to that system. When you send mail to a system that is in a different domain,
sendmail delivers the mail to the forwarder host in your domain. The forwarder host
knows how to reach hosts in other domains, so it forwards the mail to the correct
location.
sendmail uses the information in the /usr/lib/sendmail.cf file to identify the local domain
and the forwarder host. “Automatically Configuring sendmail” shows you how to run a
program to add domain and forwarder information to sendmail.cf.
Automatically Configuring sendmail

To configure sendmail automatically, follow these steps:
1.

Log in as root through a shell window.
■

Choose “Open Unix Shell” from the Desktop toolchest.

■

Position your cursor within the new window and type
login root

Then press <Enter>.
If a prompt for a password appears, type the password, then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
2. Rename /etc/sendmail.cf, in case you need it in the future, by typing
mv /etc/sendmail.cf /etc/sendmail.cf.orig

Then press <Enter>.
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3. Stop sendmail from running by typing
/etc/init.d/mail stop

Then press <Enter>.
4. Run the configuration program.
■

Start the program by typing
/usr/etc/configmail setup

Then press <Enter>.
You see a message that ends with these lines:
Current setting: [domain name]
Suggested setting: ([domain name])
Enter new setting, “.” for null:
■

If your network uses domains, type the domain name (everything after the first
period in your hostname), then press <Enter>.
If it does not use domain names, type. (a period) and press <Enter>.
You see a message that ends with these lines:
Suggested setting:
Enter new setting, “.” for null:

■

Type the root domain name, then press <Enter>.

■

You see this message, followed by the system prompt:
=== SETUP COMPLETE ===

5. Restart sendmail by typing
/etc/init.d/mail start

Then press <Enter>.
6. Log out of the root account by typing
logout

Then press <Enter>. The shell window disappears.
To test the setup, try sending mail to other users on systems that are in your own domain
and other domains.
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For information about manually configuring sendmail, see Chapter 8, “IRIX sendmail,”
in IRIX Admin: Networking and Mail.

Setting Up a Modem
Silicon Graphics supports a number of modems including Hayes, Motorola,
Practical Peripherals, Supra, and USRobotics modems. Telephone lines cannot
transfer data as quickly as Ethernet cables, so a modem connection is always slower than
a direct Ethernet connection. If possible, purchase the highest-speed modem that the
system can support.
For more information about setting up modems, see Chapter 1, “Terminals and
Modems,” in IRIX Admin: Peripheral Devices.
You can set up a modem in two different ways:
•

As a dial-out modem, you use the modem to call another modem to log in to the
system to which that modem is connected.

•

As a dial-in/dial-out modem, other users can call your modem and you can call other
modems.

To set up a modem, follow these steps:
1.

Physically connect the modem to a serial port on the system, and connect the modem
to a telephone jack. See the owner’s guide included with your system and the
documentation included with your modem for instructions and cabling
information.
Note: Do not connect the system to the modem with an ordinary telephone cable or

a cable that you used to connect the modem to a PC; it will not transmit information
correctly.
2. Find out the modem type and the baud rate. (See the documentation that came with
the modem.)
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3. Contact your network administrator to
•

decide which connection type is best for you

•

decide whether you should set the modem up for dial-out or dial-in/dial-out
access

•

ask the network administrator set up the access software on the network so you
can log in

•

obtain the telephone number and IRIX commands that you need to access the
network

4. Install the eoe.sw.uucp software. It is shipped with every system on tape or CD, but is
not necessarily installed on your disk. Check whether it’s installed by opening a
shell window and entering
versions eoe.sw.uucp

If it’s installed, you see this line:
I eoe.sw.uucp UUCP utilities.

If the line does not appear, eoe.sw.uucp is not installed. See “Installing Software” to
install it.
5. Check the documentation included with your modem to determine the modem’s
baud rate (the speed at which the modem can send and receive information).
6. Use the “Add a Modem” guide to configure a modem connection on your system.
Choose System Manager from the System toolchest, select the Hardware and
Devices category, and then click “Add a Modem.”
7. Test the modem connection by calling up another modem. See “Testing a Dial-Out
or Dial-In/Dial-Out Connection.”
For information about accessing the “Add a Modem” guide from the Serial Device
Manager, see “Overview of the Serial Device Manager.”
For information about using the modem to establish a PPP (Point-to-Point Protocol)
connection with a computer at a remote location, see “Setting Up a Modem Connection
Using PPP (Point-to-Point Protocol).”
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Testing a Dial-Out or Dial-In/Dial-Out Connection

Use the cu utility to dial out to another modem. Follow these steps:
1.

Make sure the modem is connected to both the system and a working telephone
line.

2. Make sure the modem is turned on.
3. Dial out to another modem using cu and the telephone number.
•

To call another modem at 1-800-555-1212, for example, type
cu 18005551212

Then press <Enter>.
•

If everything is working, you hear the modem dialing. After a few moments
you see this message:
Connected

Go on to step 4.
•

If you do not hear dialing or see the Connected message, press <Ctrl-C>. Then
try calling again, adding the -d (debug) option to the cu command line. For
example, retry the connection by typing
cu -d 18005551212

Then press <Enter>.
The -d option reports all the activities of the modem. Look for error messages,
and check the edits you made to turn on modem software. Also check all cable
connections.
4. If you do not see the login prompt, press <Enter>.
•

If the login prompt is garbled or does not appear, press the <Pause> or <Break>
key and try again.

5. When you see the login prompt, log in to the system.
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6. When you have finished using the remote system, log out. Often this breaks the
connection to the remote modem (that is, it hangs up the telephone). You know the
connection is broken when you see these messages:
Lost Carrier
Disconnected

If logging out does not break the connection, try these methods:
•

Press <Enter> twice.

•

Press <Ctrl-C>.

•

Type ~.

Deleting a Modem

You use the “Remove a Modem” guide to delete a modem from your system. Open the
System Manager if it isn’t already running. (Choose System Manager from the System
toolchest.) Select the Hardware and Devices category and then click “Remove a
Modem.” The guide appears and leads you through the necessary steps.

Setting Up a Modem Connection Using PPP (Point-to-Point Protocol)
After you configure a modem on your system, you can set up a modem connection to
communicate with other computers by using PPP (Point-to-Point Protocol). You can set
up an incoming PPP connection, so that remote computers can connect to your
workstation over a phone line, or you can set up an outgoing PPP connection, so your
workstation can connect to a remote computer over a phone line.
Note: You can also use PPP to establish an ISDN connection with a remote computer. For

information, see the ISDN User’s Guide, which is provided online.
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Overview of the PPP Manager

The PPP Manager provides access to a number of guides that let you set up, change, and
delete PPP Connections. To open the PPP Manager, open the System Manager if it isn’t
already running. (Choose System Manager from the System toolchest.) Select the
Network and Connectivity category and then click “PPP Manager.” (You can also open
the individual PPP guides.)
The PPP Manager window displays the name of each PPP connection on the system,
whether the connection is incoming or outgoing, and the type of hardware being used
for the connection.
You can use the Get Info button to display detailed information about a connection. Select
the name of the connection in the PPP Manager window and click Get Info. A PPP Status
Panel appears and displays the name of the connection, the type of connection (outgoing
or incoming), the hardware being used (ISDN or modem), and the status of the
connection (closed or open). The PPP Status Panel also lets you open or close an outgoing
connection. See “Opening an Outgoing PPP Connection” for more information
About the Menus

The Task menu in the PPP Manager window contains these choices:
•

“Add Outgoing” opens the “Add an Outgoing PPP Connection” guide, which lets
you create an outgoing PPP connection between your workstation and a remote
computer. This command is equivalent to the Add Outgoing button. See “Creating a
PPP Connection” for information.

•

“Add Incoming” opens the “Add an Incoming PPP Connection” guide, which lets
you create an incoming PPP connection between a remote computer and your
workstation. This command is equivalent to the Add Incoming button. See “Creating
a PPP Connection” for information.

•

“Delete” opens the “Delete a PPP Connection” guide, which lets you remove an
incoming or outgoing PPP connection from your system. This command is
equivalent to the Delete button. See “Deleting a PPP Connection” for information.

•

“Modify” opens the “Modify an Incoming PPP Connection” guide or the “Modify
an Outgoing PPP Connection” guide, depending on the type of connection you
select. These guides let you make changes to an existing connection. This command
is equivalent to the Modify button. See “Modifying a PPP Connection” for
information.
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•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the PPP Manager window. Any changes you made using the guides
are saved. This command is equivalent to the Close button.

The Arrange menu contains these choices:
•

“By Name” lists the connections alphabetically by their names.

•

“By Type” lists the connections according to their type (incoming or outgoing).

•

“By Hardware” lists the connections according to the hardware being used (ISDN
or modem).

The Help menu contains a list of help topics. To view a topic, choose it from this menu.
Creating a PPP Connection

You need to create a PPP connection for each remote computer with which you want to
communicate. You can create as many PPP connections as you need. You can even create
more than one connection with a particular remote computer. For example, you may
want to create an outgoing connection using a modem and one using ISDN.
To create a PPP connection, use the “Add an Incoming PPP Connection” or the “Add an
Outgoing PPP Connection” guide, depending on the type of connection you want to set
up. You can open these guides using one of these methods:
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•

Open the System Manager, select the Network and Connectivity category, and click
the name of the guide that you want to open.

•

Open the System Manager, select the Network and Connectivity category, click
“PPP Manager,” and then click the Add Outgoing or the Add Incoming button. (You
can also choose “Add Incoming” or “Add Outgoing” from the Task menu.
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Modifying a PPP Connection

You can make changes to an existing PPP connection using the “Modify an Incoming PPP
Connection” and “Modify an Outgoing PPP Connection” guides.
You can open these guides using one of these methods:
•

Open the System Manager, select the Network and Connectivity category, and click
the name of the guide that you want to open.

•

Open the System Manager, select the Network and Connectivity category, click
“PPP Manager,” select the connection you want to change, and then click the Modify
button. (You can also select the connection and choose “Modify” from the Task
menu.)

Deleting a PPP Connection

You can remove an existing PPP connection from your system using the “Delete a PPP
Connection” guide.
You can open this guide using one of these methods:
•

Open the System Manager, select the Network and Connectivity category, and click
“Delete a PPP Connection.”

•

Open the System Manager, select the Network and Connectivity category, click
“PPP Manager,” select the connection you want to remove, and then click the Delete
button. (You can also select the connection and choose “Delete” from the Task
menu.)
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Opening an Outgoing PPP Connection

You establish a connection between your workstation and a remote computer by opening
a PPP outgoing connection that you previously created. See “Creating a PPP
Connection” for information about creating a PPP connection.
To open an outgoing connection, follow these steps:
1.

Open the PPP Manager.

2. Double-click the name of the outgoing connection that you want to open.
You can also select the connection and click the Get Info button.
3. Click the Open Connection button in the PPP Status Panel.
The PPP Status Panel changes the status of the connection to “Open.”
Closing a PPP Connection

To close a connection, follow these steps:
1.

Open the PPP Manager.

2. Double-click the name of the connection that you want to close.
You can also select the connection and click the Get Info button.
3. Click the Close Connection button in the PPP Status Panel.
The PPP Status Panel changes the status of the connection to “Closed.”

Setting Up Peripheral Connections
Adding a new peripheral device such as a drive or an input device requires at least two
steps:
1.

Physically set up the device and connect it to a SCSI, parallel, or serial port on the
system.
Note: With SCSI devices, you must also select an unused SCSI address. See your

system owner’s guide.
2. Set up system software so it can communicate with the device.
3. If necessary, set up a software application so it can access the device.

36

Setting Up Peripheral Connections

The system can detect most SCSI devices and set them up automatically. When you
connect a device to a serial or parallel port, the system usually cannot detect the device
or set it up. The rule of thumb is this: If you connect a device, turn it on, power up the
system, and log in to the system and do not see either a configured icon or a notifier
requesting information about the device, you must set up system software.
Click a topic for more information:
•

“Setting Up SCSI Peripherals”

•

“Overview of the Serial Device Manager”

•

“Setting Up Serial Peripherals”

•

“Setting Up Parallel Peripherals”

Setting Up SCSI Peripherals
Before connecting a device to a SCSI port, make sure you power off the system. (See
“Shutting Down or Restarting the System” for instructions.) After the system has been
powered off, connect the device to a SCSI port, turn on the device, and restart the system;
the system detects and recognizes most new devices.
•

If the device is a printer, you must use the Printer Manager to set up printing
software; see “Setting Up a SCSI Printer.”

•

If the device is a hard disk drive, the system automatically places an icon for the
device on your desktop. You need to use the “Mount a Local Filesystem” guide to
specify a directory from which the system can access the disk; this process is called
mounting a filesystem.
You can open the “Mount a Local Filesystem” guide from the Filesystem Manager
or the Disk Manager.

•

•

Choose “Filesystem Manager” from the System toolchest. Click the Mount Local
button in the window.

•

Choose “System Manager” from the System toolchest. Select the Hardware and
Devices category and click “Disk Manager.” Choose “Mount Disk’s Filesystem”
from the Task menu.

If the device is a removable media device, such as a floppy, CD, or tape drive, the
system automatically sets up the system software for you, and places an icon for the
device on your desktop. For more information about removable media devices, see
“Overview of the Removable Media Manager.”
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Note: To let other people access your CD drive to install software across the network,

see “Allowing Remote Users to Install Software From Your CD Drive.”
This list shows the names that the system assigns to devices:
tape drive

An icon for each tape drive appears on your desktop. Each tape
drive is labeled DAT or QIC, depending on whether it’s a DAT or
QIC format drive (see also “About Tape Formats and Capacities”).
If you have more than one DAT drive, each subsequent drive will
include a number in its label. For example, a second DAT drive will
be labeled DAT2.

CD drive

An icon for each CDROM drive appears on your desktop. The first
CD drive that you connect is labeled cdrom and has a mount point of
/cdrom; the second is labeled cdrom2 and has a mount point of
/cdrom2.

floppy or floptical drive
An icon for each floppy or floptical drive appears on your desktop.
The first floppy or floptical drive that you connect is labeled floppy
and has a mount point of /floppy; the second is labeled floppy2 and has
a mount point of /floppy2.
SyQuest drive An icon for each SyQuest drive appears on your desktop. The first
SyQuest drive that you connect is labeled syquest and has a mount
point of /syquest; the second is labeled syquest2 and has a mount
point of /syquest2.
Zip drive

An icon for each Zip drive appears on your desktop. The first Zip
drive that you connect is labeled zip and has a mount point of /zip; the
second is labeled zip2 and has a mount point of /zip2.

Jaz drive

An icon for each Jaz drive appears on your desktop. The first Jaz
drive that you connect is labeled jaz and has a mount point of /jaz; the
second is labeled jaz2 and has a mount point of /jaz2.

PCcard drive

An icon for each PCcard drive appears on your desktop. The first
PCcard drive that you connect is labeled pccard and has a mount
point of /pccard; the second is labeled pccard2 and has a mount point
of /pccard2.

For information on formatting and using floppy and floptical disks, see “Formatting
Floppy and Floptical Disks.” If you encounter problems using removable media, see
“Troubleshooting Problems With Removable Media.”
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Allowing Remote Users to Install Software From Your CD Drive

You need to edit an IRIX file to allow remote software installation from a CD that’s
connected to your system. If you do not edit this file, remote users will be able to view
the release notes on a software distribution CD, but will not be able to install the software
that it contains.
To allow remote software installation, follow these steps:
1.

Log in as root through a shell window.
■

Choose “Open Unix Shell” from the Desktop toolchest.

■

Position your cursor within the new window and type
login root

Then press <Enter>.
If a prompt for a password appears, type the password then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
2. Edit /etc/inetd.conf.
■

Open the file with a text editor such as jot by typing
jot /etc/inetd.conf

Then press <Enter>.
■

Find the line that begins with “tftp”:

tftp dgram udp wait guest /usr/etc/tftpd tftpd -s /usr/local/boot /usr/etc/boot
■

At the end of this line, add the full pathname of your CD drive, for example,
/CDROM. The last part of the line (note that this is not the complete line) would
then look like this:
tftpd -s /usr/local/boot /usr/etc/boot /CDROM

■

Save your changes and quit the text editor.

39

Chapter 3: Setting Up Network, Peripheral, and Printer Connections

3. Inform the system of the change by typing
killall -HUP inetd

Then press <Enter>. It may take a few minutes for the change to take effect.
4. Log out of the root account by typing
logout

Then press <Enter>. The shell window disappears.

Overview of the Serial Device Manager
The Serial Device Manager lets you view information about the serial devices currently
configured on your system. Serial devices include input devices (such as a mouse or
tablet), MIDI devices, and terminals. The Serial Device Manager also provides access to the
various guides that let you manage serial devices.
To open the Serial Device Manager, select the Hardware and Devices category in the
System Manager window, and then click “Serial Device Manager.”
You can use the Get Info button to view detailed information about a selected device,
including the name of the device, the serial port it is attached to, the type of device, and
any additional information available about the device.

About the Menus
The Task menu contains these choices:
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•

“Add Input or Terminal Device” opens the “Add a Serial Device” guide, which lets
you set up a new serial device attached to your system. This command is equivalent
to the Add button. See “Setting Up Serial Peripherals” for more information.

•

“Add Modem” opens the “Add a Modem” guide, which lets you set up a new
modem attached to your system. See “Setting Up a Modem” for more information.

•

“Add MIDI” opens the “Add a Serial Device” guide, which lets you set up a new
MIDI device attached to your system. This command is equivalent to the Add
button. See “Setting Up Serial Peripherals” for more information.
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•

“Delete Input or Terminal Device” opens the “Delete a Serial Device” guide, which
lets you notify your system that you’ve disconnected a serial device from your
workstation. This command is equivalent to the Delete button. See “Deleting Serial
Peripherals” for more information.

•

“Delete Modem” opens the “Delete a Modem” guide, which lets you notify your
system that you’ve disconnected a modem from your workstation. See “Deleting a
Modem” for more information.

•

“Delete MIDI” opens the “Delete a Serial Device” guide, which lets you notify your
system that you’ve disconnected a MIDI device from your workstation. This
command is equivalent to the Delete button. See “Deleting Serial Peripherals” for
more information.

•

“Printer Manager” opens the Printer Manager, which lets you add, modify, and
delete printers from your system, See “Overview of the Printer Manager” for more
information.

•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Serial Device Manager window. Any changes you made using
the guides are saved. This command is equivalent to the Close button.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.

Setting Up Serial Peripherals
This section describes how to configure your system to use a serial peripheral. Once the
peripheral is set up, the system automatically makes it public, that is, makes it accessible
to all other systems on the network.
Note: This section does not describe how to configure modems or printers. See “Setting

Up a Modem” or “Overview of the Printer Manager.”
Before you configure your system for the peripheral, see your system’s owner’s guide for
detailed information on how to
•

find or build a serial cable that can transfer data from the system to the peripheral

•

connect the serial peripheral to a serial port on your system
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1.

Turn on the peripheral.

2. If the System Manager window is not already open, open it now by choosing
“System Manager” from the System toolchest.
3. In the System Manager window, select the Hardware and Devices category, and
then click “Add a Serial Device.”
The “Add a Serial Device” guide appears and leads you through the steps to set up
your serial device.
Note: At this time the Port Setup tool supports only CalComp tablets. See the system

release notes for information on setting up other types of tablets.
4. If you configured a terminal, you may want to test the setup.
■

Make sure the terminal is powered on and is connected to the system.

■

On the terminal’s keyboard, press the <Enter> key and the <Pause> or
<Break> key several times, until you see the login prompt.

■

If you cannot get the prompt, turn the terminal off and on again, then try again.

■

Log in to the system, then log out. The terminal is ready to use.

Deleting Serial Peripherals

When you physically disconnect a peripheral from your system, you should also remove
the peripheral’s icon from the list of serial ports in the Serial Device Manager. The system
cannot detect a disconnected serial peripheral, so this is the only way the Serial Device
Manager can display an accurate list of available ports.
Note: The “Remove a Serial Device” guide does not allow you to delete modems or

printers. See “Deleting a Modem” or “Deleting a Printer.”
You use the “Remove a Serial Device” guide to disconnect a serial device. You can open
the guide from the System Manager window by selecting the Hardware and Devices
category and then using one of two methods:
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•

Click “Disconnect a Serial Device” in the righthand column of the System Manager
window.

•

Click “Serial Device Manager” in the righthand column of the System Manager
window. In the window that appears, select the device you want to disconnect by
clicking its icon and then clicking Delete.

Setting Up Printer Connections

Note: If you attempt to delete a printer, a message appears telling you to use the Printer

Manager. See “Overview of the Printer Manager” for more information.
After you disconnect the device, the icon disappears from the Serial Device Manager
window, and the port is available for use.

Setting Up Parallel Peripherals
The serial device guides available in the System Manager do not support parallel
peripherals. To set up a parallel printer, see “Setting Up a Parallel Printer.” To set up other
parallel devices, see the documentation that came with the device.

Setting Up Printer Connections
You can set up your system to access printers that are directly connected to your system,
or to other systems on the network.

Overview of the Printer Manager
The Printer Manager lets you set up software for a new local printer, access printers that
are connected to other systems on the network, and set system-wide settings for printers.
Each user can use the Printer Manager to view all available printers and to drag printers
onto the desktop for convenient access. See “Printing Files” in the Desktop User’s Guide
for information on printing files from the desktop.
If the Printer Manager is not already running, start it by choosing “Printer Manager”
from the System toolchest or by clicking the words Printer Manager now. You can also
access the Printer Manager from the System Manager in the “Hardware and Devices”
category.
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About the Menus
The Printer menu contains these choices:
•

“Add” lets you set up a new printer that’s connected to either your own system or
to another system on the network. This command is equivalent to the Add button.

•

“Change Connection” lets you change the setup information about the selected
printer.

•

“Delete” removes the selected printer from the list of available printers. This
command is equivalent to the Delete button.

•

“Set Default” makes the selected printer the default printer. This command is
equivalent to the Default button.

•

“Show Queue” shows the Printer Status panel for the selected printer.

•

“Set Options” lets you set printer-specific options for the selected printer. This item
is available only if the printer is connected to a system that has the optional
Impressario™ software. (For more information, see “About Impressario” in the
Desktop User’s Guide.) This command is equivalent to the Options button.

•

“Send Test Page” sends a one-page print job to the selected printer.

•

“Exit” quits the Printer Manager.

The Arrange menu contains these choices:
•

“by Printer Name” sorts the list of printers alphabetically by name.

•

“by Hostname” sorts the list alphabetically by the hosts to which the printers are
connected.

•

“by Printer Type” sorts the list alphabetically by the types of printers.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.
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Setting Up Printing Software
You can set up software for printers that are either connected directly to the system or are
connected to other systems on the network. If the Impressario software is installed on the
system, you can also set up software for printers that are connected directly to a network
using a network adaptor. For more information, see “About Impressario” in the Desktop
User’s Guide.
•

“Setting Up a Serial Printer” describes how to set up a printer that’s connected to a
serial port.

•

“Setting Up a Parallel Printer” describes how to set up a printer that’s connected to
a parallel port.

•

“Setting Up a SCSI Printer” describes how to set up a printer that’s connected to a
SCSI port.

•

“Accessing a Printer Connected to a Remote Workstation” describes how to access a
printer that’s connected to another workstation on the network. It includes
instructions for accessing printers attached to Macintosh computers or PCs on the
network.

•

“Accessing a Printer Directly Connected to the Network” describes how to access a
printer that is connected to the network with a network adaptor.

Setting Up a Serial Printer

Follow these steps to set up software for a serial printer:
1.

Physically connect the printer to a serial port on your system using the serial cable
provided with the printer, then power on the printer.

2. If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager now.
3. Choose “Add” from the Printer menu or click the Add button.
4. In the Add Printer window, click in the New Printer Name field and type in a name.
You can choose any name you like. It can consist of up to 14 letters and numbers,
and can include an underbar (_); it cannot include any spaces or special characters
such as #, @, &, or /.
5. Next to Printer Connected To, click the Local Host box.
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6. Complete the Location Code and Location Description fields.
•

In the Location Code field, enter a code that helps identify the printer location.
For example, your network administrator might want you to enter the mailstop
of the system the printer is attached to.

•

In the Location Description field, enter a description that helps you remember
where the printer is located. For example, you might enter “Roger’s cube at the
back of building 1.”

7. In the Printer Type list, choose the type that best describes your printer.
Note: If the appropriate type of printer does not appear in the list, you may not have

the correct printer driver software installed. Contact the printer’s manufacturer.
8. Specify the printer’s serial connection, handshake, and baud rate; you can find
handshake and baud rate information in the manual that came with the printer.
•

Next to Printer is Attached To, click Serial.

•

From the menu button next to Serial Port, choose the port number to which you
connected the printer.

•

From the Handshake menu button, choose the printer’s handshake. (A software
handshake is the same as xon/xoff flow control.)

•

Choose the printer’s baud rate from the Baud Rate menu button.

9. Have the system set up the printer, or cancel your request.
•

When the information is correct, click Apply and then click OK.

•

To cancel your request, click Cancel.

10. The printer appears in the Printer Manager window. You can drag the printer’s icon
onto the desktop for easy access.
Setting Up a Parallel Printer

Follow these steps to set up software for a parallel printer:
1.

Physically connect the printer to a parallel port on your system using the parallel
cable provided with the printer, then power on the printer.

2. If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager now.
3. Choose “Add” from the Printer menu or click the Add button.
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4. In the Add Printer window, click in the New Printer Name field and type in a name.
You can choose any name you like. It can consist of up to 14 letters and numbers,
and can include an underbar (_); it cannot include any spaces or special characters
such as #, @, &, or /.
5. Next to Printer Connected To, click the Local Host box.
6. Complete the Location Code and Location Description fields.
•

In the Location Code field, enter a code that helps identify the printer location.
For example, your network adminstrator might want you to enter the mailstop
of the system the printer is attached to.

•

In the Location Description field, enter a description that helps you remember
where the printer is located. For example, you might enter “Roger’s cube at the
back of building 1.”

7. In the Printer Type list, choose the type that best describes your printer.
Note: If the appropriate type of printer does not appear in the list, you may not have

the correct printer driver software installed. Contact the printer’s manufacturer.
8. Specify the printer’s connection.
•

Next to Printer Attached To, click Parallel.

•

If you have more than one parallel port, click the port you connected the printer
to in the list next to Parallel Ports.

9. Have the system set up the printer, or cancel your request.
•

When the information is correct, click Apply and then click OK.

•

To cancel your request, click Cancel.

10. The printer appears in the Printer Manager window. You can drag the printer’s icon
onto the desktop for easy access.
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Setting Up a SCSI Printer

The software necessary to support SCSI printers is part of the Impressario product. If
Impressario and a driver that supports a SCSI printer are both installed on the system,
you will see SCSI as an option next to Printer is Attached To in the Add Printer window.
To install the Impressario software, see “Installing Software.”
Follow these steps to set up software for a SCSI printer:
1.

Shut down your system by choosing “System Shutdown” from the System
toolchest, then turning off the system’s power.

2. Assign an unused SCSI address to the printer (see also “About SCSI Devices,
Controllers, and Addresses”), and physically connect it to a SCSI port on your
system using the SCSI cable provided with the printer. Then power on the printer
(see your owner’s guide and the printer’s manual for more information).
3. Power on your system.
4. If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager now.
5. Choose “Add” from the Printer menu or click the Add button.
6. In the Add Printer window, click in the New Printer Name field and type in a name.
You can choose any name you like. It can consist of up to 14 letters and numbers,
and can include an underbar (_); it cannot include any spaces or special characters
such as #, @, &, or /.
7. Next to Printer Connected To, click the Local Host box.
8. Complete the Location Code and Location Description fields.
•

In the Location Code field, enter a code that helps identify the printer location.
For example, your network adminstrator might want you to enter the mailstop
of the system the printer is attached to.

•

In the Location Description field, enter a description that helps you remember
where the printer is located. For example, you might enter “Roger’s cube at the
back of building 1.”

9. In the Printer Type list, choose the type that best describes your printer.
Note: If the appropriate type of printer does not appear in the list, you may not have

the correct printer driver software installed. Contact the printer’s manufacturer.
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10. Specify the printer’s connection.
•

Next to Printer is Attached To, click SCSI.

•

In the list of SCSI printers that appears, click one to select it. If no printers
appear, click the Rescan button.

11. Have the system set up the printer, or cancel your request.
•

When the information is correct, click Apply and then click OK.

•

To cancel your request, click Cancel.

12. The printer appears in the Printer Manager window. You can drag the printer’s icon
onto the desktop for easy access.
Accessing a Printer Connected to a Remote Workstation

This information applies to you if you want to access a printer that’s connected to another
workstation on your network.
Follow these steps to access a printer that’s connected to another system on the network:
1.

If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager now.

2. Choose “Add” from the Printer menu or click the Add button.
3. In the Add Printer window, click in the New Printer Name field and type in a name.
You can choose any name you like. It can consist of up to 14 letters and numbers,
and can include an underbar (_); it cannot include any spaces or special characters
such as #, @, &, or /.
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4. Specify that the printer is connected to another workstation, and specify the other
workstation’s hostname and local name for the printer.
•

Next to Printer Connected To, click the Remote Host box.

•

Click in the Remote Host Name field and type in the name of the workstation to
which the printer is connected.

•

Click the List Printers button to see a list of all printers that are connected to the
remote Silicon Graphics workstation.

•

Click a printer to select it; it appears in the Remote Printer Name field. (You can
also type the name of a printer in the Remote Printer Name field. If you do, you
must also type the printer name in the New Printer Name field; these names will
typically be the same.)
Note: List Printers only works when the remote workstation is an SGI

workstation. If the remote workstation is not an SGI workstation, you may need
to get a list of valid printer names from the system administrator of the remote
workstation.
5. Have the system set up the printer, or cancel your request.
•

When the information is correct, click Apply and then click OK.

•

To cancel your request, click Cancel.

6. The printer appears in the Printer Manager window. You can drag the printer’s icon
onto the desktop for easy access.
Accessing a Printer Directly Connected to the Network

Impressario provides the software necessary to support printers that are directly
connected to the network with a network adaptor. Impressario supports the HP JetDirect
network card as well as other network adaptors that emulate the HP JetDirect card.
Follow these steps to set up software for a printer directly connected to a network:
1.

Physically connect the printer to the network. See the owner’s manual that came
with the printer for instructions. Make sure that you set up the printer’s network IP
address using the instructions that came with the printer. Printers with built-in
network cards must often be turned off and on after the network address is set.
If the printer is already connected to the network, ask the network administrator for
the hostname or IP address of the printer. You need this information to complete the
setup.
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2. If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager now.
3. Choose “Add” from the Printer menu or click the Add button.
4. In the Add Printer window, click in the New Printer Name field and type in a name.
You can choose any name you like. It can consist of up to 14 letters and numbers,
and can include an underbar (_); it cannot include any spaces or special characters
such as #, @, &, or /.
5. Next to Printer Connected To, click the Local Host box.
6. Complete the Location Code and Location Description fields.
•

In the Location Code field, enter a code that helps identify the printer location.
For example, your network adminstrator might want you to enter the mailstop
of the system the printer is attached to.

•

In the Location Description field, enter a description that helps you remember
where the printer is located. For example, you might enter “Roger’s cube at the
back of building 1.”

7. In the Printer Type list, choose the type that best describes your printer.
Note: If the appropriate type of printer does not appear in the list, you may not have

the correct printer driver software installed. Contact the printer’s manufacturer.
8. Specify the printer’s connection.
•

Next to Printer is Attached To, click Network. (If you do not see Network, then
Impressario has not been installed.)

•

In the Printer’s Name (or IP Address) field that appears, type the hostname or IP
address that has been assigned to the printer.

•

In the Printer Attached to Network With list, select a printer network adaptor that
best describes the printer’s network adaptor.

9. Have the system set up the printer, or cancel your request.
•

When the information is correct, click Apply and then click OK.

•

To cancel your request, click Cancel.

10. The printer appears in the Printer Manager window. You can drag the printer’s icon
onto the desktop for easy access.
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Once you’ve configured the printer, other workstations on the network can access the
printer from the system that has just been configured because the system is now acting
as a print server for the network printer. As a print server, the system accepts print jobs
from multiple computers (other UNIX workstations, personal computers, and so on),
queue them in the order received, prepare the files to be printed, and then print them on
the network printer.
It is recommended that you configure only one or two workstations as print servers for
any one network printer. The other computers on the network should then use the print
servers to access the network printer. See “Accessing a Printer Connected to a Remote
Workstation” for information about accessing a print server.
Accessing a Macintosh or PC Printer Across the Network

You can access a printer connected to a Macintosh computer running AppleShare. You
can also access a printer connected to a PC running NetWare. By using the “Mount a
Macintosh or PC Printer” guide, you can set up your system to send print jobs to a remote
Macintosh or PC printer.
To open the guide, select the Hardware and Devices category in the System Manager and
then click “Mount a Macintosh or PC Printer.” The guide appears and takes you through
the necessary steps. Later, if you want to make the printer inaccessible, you can use the
“Unmount a Macintosh or PC Printer” guide, also available in the Hardware and Devices
category.

Changing the Setup of a Printer
When you change the physical setup of a printer—for example, when you connect it to a
different port on your system or when someone moves a printer from one system to
another system on the network—you must use the Printer Manager to change the setup
information. If you do not change the information, you will not be able to access the
printer.
If the Printer Manager is not already running, start it by choosing “Printer Manager”
from the System toolchest or by clicking the words Printer Manager now.

52

Setting Up Printer Connections

Follow these steps to change the setup information:
1.

In the Printer Manager window, select the printer’s icon, then choose “Change
Connection” from the Printer menu.

2. In the Change Connection window, you can change all of the information about the
printer except its name. See “Setting Up Printing Software” for details.
Note: If you want to change the name of the printer, you must delete the printer (see

“Deleting a Printer”) then add it as if it were new (see “Setting Up Printing
Software”).
3. Have the system set up the printer with the new information, or cancel your
request.
•

When the information is correct, click OK.

•

To cancel your request, click Cancel.

Deleting a Printer
You can delete a printer from the Printer Manager. Typically you do this if the printer has
been permanently removed from your system or from another system on the network.
Notify other users on your network before you delete a printer that is directly connected
to your system. If other users have added your printer as a network printer on their
systems, they will no longer be able to access the printer once you delete it.
If the Printer Manager is not already running, start it by choosing “Printer Manager”
from the System toolchest or by clicking the words Printer Manager now.
To delete a printer, follow these steps:
1.

In the Printer Manager window, select the printer’s icon, then choose “Delete” from
the Printer menu or click the Delete button.
If there are jobs in the printer’s queue, a notifier appears that lets you either cancel
all the jobs, or send them to a different printer; see “Canceling or Moving Print Jobs
to a Different Printer.”

2. A dialog appears to confirm that you want to delete the printer; to do so, click the
OK button.
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Canceling or Moving Print Jobs to a Different Printer

If there are jobs in the queue of a printer that you are deleting, you can either cancel those
jobs or move them to a different printer. (You can access the options below by selecting a
printer’s icon in the Printer Manager window and clicking “Delete.”)
•

To cancel all jobs, click the box next to Delete jobs from queue, then click the OK
button.

•

To move the jobs to a different printer, click the box next to Move jobs to printer, select
a printer from the list by clicking it, then click the OK button.

•

To cancel your request to delete the printer, click the Cancel button.

Designating a Default Printer
From the desktop, people can send files to a particular printer in two ways:
•

Select a file and choose “Print” from the Selected toolchest or menu. The system
sends the file to the default printer for the system.

•

Drag a file onto a specific printer, or drag a file onto PrintPanel and specify a printer.
The system sends the file to that printer.
PrintPanel is available in the Printing section of the Icon Catalog. Choose “Icon
Catalog” from the Find toolchest and then choose “Printing” from the rollover
menu.

Follow these steps to designate a default printer for all users on the system:
1.

If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager now.

2. Select the printer’s icon, then choose “Set Default” from the Printer menu or click
the Default button. A label appears above the list of printers that indicates which
printer is the system default.
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Setting Printer-Specific Options
If the optional Impressario software is installed on the system to which a printer is
connected (see “About Impressario” in the Desktop User’s Guide), users can customize the
way a printer handles individual print jobs by following these steps:
1.

If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager now.

2. Select the printer’s icon, then choose “Set Options” from the Printer menu or click
the Options button.
The Options window for that printer appears.
Note: If “Set Options” is greyed out, the selected printer is not an Impressario

printer.
When a user changes the settings, a notifier requests whether the setting is to be used for
only that user or for all users on the system (All Users).
You can also use the PrintPanel to customize the way a printer prints a particular job,
whether or not the optional Impressario software is installed. To use PrintPanel, follow
these steps:
1.

Choose “File QuickFind” from the Find toolchest and enter PrintPanel.

2. When the PrintPanel icon appears in the drop pocket, drag it onto your desktop.
3. To customize a print job, drag the file onto the PrintPanel icon; a settings panel
appears.
See “About PrintPanel” in the Desktop User’s Guide for more information.
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Checking a Printer’s Queue
Follow these steps to view a printer’s queue:
1.

If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager.

2. Select the printer’s icon, then choose “Show Queue” from the Printer menu (or just
double-click the printer’s icon). The Printer Status panel for that printer appears.
You can also view the queue by double-clicking the printer’s icon in your desktop, or by
double-clicking the printer’s name in PrintPanel.
For information on managing the queue, use the Help menu in the Printer Status panel.

Printing a Test Page from Printer Manager
Follow these steps to send a test page to a printer:
1.

If the Printer Manager is not already running, start it by choosing “Printer
Manager” from the System toolchest or by clicking the words Printer Manager now.

2. Select the printer’s icon, then choose “Send Test Page” from the Printer menu.

Setting Up lpr
The Printer Manager supports remote access to systems that support the BSD lpr
protocol. To access an lpr printer connected to a remote workstation, see “Accessing a
Printer Connected to a Remote Workstation.”
The Silicon Graphics print spooler can also accept print jobs from remote non Silicon
Graphics systems that use the BSD lpr protocol. (Many personal computers and other
UNIX systems use the BSD lpr protocol.) As a result, the Silicon Graphics print spooler
can act as a print server for many non Silicon Graphics systems. You do not have to
perform any special configuration steps to enable an Silicon Graphics workstation to
accept BSD lpr print jobs.
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4. Installing and Removing Software

This chapter shows you how use the Software Manager to install software products that
you receive from Silicon Graphics. To install products from other vendors, please see the
software installation instructions that accompany the products. In some cases, you can
also install their products using the Software Manager.
Software from Silicon Graphics is distributed on compact discs (CDs). Typically you
install software from a CD-ROM drive that’s connected either to your own system or to
another system from Silicon Graphics. In some cases a network administrator may use the
CD to create a distribution directory on your own system or on another system on your
network from which you can install the software.
This chapter contains these sections:
•

“Overview of the Software Manager”

•

“About the Menus”

•

“Installing Software”

•

“Viewing Installed and Available Software”

•

“Removing Installed Software”

•

“Saving or Loading a Custom Selection of Software”

•

“Setting Software Manager Preferences”

•

“Troubleshooting Software Installation”

•

“Advanced Topics”

For more information on software installation or troubleshooting, see IRIX Admin:
Software Installation and Licensing.
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Overview of the Software Manager
The Software Manager lets you install and remove both operating system software and
optional product software. Any user can use the Software Manager to view a list of
installed software, but only the Administrator (or anyone who knows the password for the
root account) can use it to install or remove software. You can start the Software Manager
using any of these methods:
•

Choose “Software Manager” from the System toolchest.

•

In the System Manager, select the Software category and click “Software Manager.”
To open the System Manager, choose “System Manager” from the System toolchest.

•

Double-click a CD drive icon that contains a CD with software on it.

If you are not logged in to the root account and the root account has a password, a dialog
box appears that requests the password. If you do not know the password, click the
Continue button, and Software Manager starts in read-only mode where you can view
available and installed software, but cannot install or remove software.
For more information, click a topic:
•

“About the Menus”

•

“Installing Software”

•

“Viewing Installed and Available Software”

•

“Removing Installed Software”

•

“Saving or Loading a Custom Selection of Software”

•

“Setting Software Manager Preferences”

•

“Troubleshooting Software Installation”

•

“Advanced Topics”

For help on a specific item or area in the Software Manager window, choose “Click for
Help” from the Help menu, then click on the item or area.
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About the Menus
The Software Manager has five menus. Click the menu name below for details on the
menu choices:
•

“The File Menu”

•

“The Selected Menu”

•

“The Software Menu”

•

“The Panes Menu”

•

“The Help Menu”

The File Menu
The File menu contains these choices:
•

“Browse Directory” brings up a file browsing window from which you can choose a
directory that contains software that you want to install. The directory then appears
in the Available Software drop pocket.

•

“Open Distribution” brings up a window that lets you select the distribution that
contains the software you want to install.

•

“Open Additional Distribution” brings up a window that lets you select and open
another distribution which contains software that you want to install. The current
distribution remains open; you will be able to install software from all opened
distributions.

•

“Close Distribution” lets you select one of the currently opened distributions and
close it.

•

“Load Selections” brings up a file browsing window from which you can open a file
that contains a custom selection of software. Such files were previously created
using Software Manager’s “Save Selections” choice.

•

“Save Selections” saves the current custom selections of software in a file that you
can later open by choosing “Load Selections.”

•

“Start Installation /Removal” starts the actual installation and/or removal of
software. It is identical to the Start button that appears in the middle of the Software
Manager window.
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•

“Stop Installation/Removal” stops the installation or removal that is currently in
progress. It is identical to the Stop button that appears in the middle of the Software
Manager window.

•

“Manage Conflicts” brings up a window in which you can resolve problems that the
Software Manager identifies while trying to install or remove software. It is
identical to the Conflicts button that appears in the middle of the Software Manager
window.

•

“Recalculate Disk Space” checks whether you have enough disk space to install the
software you currently have selected for installation. The Software Manager
automatically recalculates disk space each time you make a selection; use this menu
choice when your amount of free disk space changes independent of the Software
Manager (for example, when you remove some files using the desktop or a shell
window while the Software Manager is running).

•

“Set Preferences” brings up a window in which you can modify standard behaviors
of the Software Manager.

•

“Relocate Product” lets you move a product from its original location on a disk to a
different filesystem. You may find this useful if the current filesystem does not have
enough space for a particular product.
Note: Not every product can be relocated. If you select a product in the Software
Inventory list and the “Relocate Product” menu item does not appear highlighted,
then the product cannot be relocated.

•

“Exit” exits the Software Manager.

Button Equivalents to Choices in the File Menu

The Start button starts the actual installation or removal of software. It is identical to the
“Start Installation/Removal” choice in the File menu.
The Stop button stops the installation or removal that is currently in progress. It is
identical to the “Stop Installation/Removal” choice in the File menu.
The Conflicts button brings up a window in which you can resolve problems that the
Software Manager identifies while trying to install or remove software. It is identical to
the “Manage Conflicts” choice in the File menu.
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The Selected Menu
The Selected menu lets you select software for installation or removal, and find specific
software in the Software Inventory list. Its choices become available when you click the
Customize Installation or Manage Installed Software buttons. The menu contains these
choices:
•

“Mark Install” places a check mark in the Install box next to the product that is
selected in the Software Inventory list. The product will not be installed until you
click the Start button.

•

“Mark Remove” places a check mark in the Remove box next to the product that is
selected in the Software Inventory list. The product is not removed until you click the
Start button.

•

“Unmark (Keep)” removes a check mark that may appear in the Install or Remove
box next to the product that is selected in the Software Inventory list. When you click
the Start button, the product is not installed or removed.

•

“Release Notes” displays the release notes that correspond to the product that is
selected.

•

“Get Info” brings up a window that contains information about the selected
product.

•

“Mark Upgrades to Install” places a check mark in the Install box next to all upgrade
products (products that are newer versions of products that are currently installed)
that are available.

•

“Mark New Products to Install” places a check mark in the Install box next to all new
products (products that have never been installed on the system).

•

“Mark Related Upgrades” places a check mark next to all upgrade products and the
related new products that are required by those upgrade products.

•

“Unmark All” removes all check marks from all Install and Remove boxes. The Start
button is greyed out after you choose “Unmark All,” since no software is marked
for installation or removal.

•

“Find” brings up a window that lets you search the Software Inventory list for each
product, subsystem, or file that contains a specific combination of characters.
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•

“Find and Mark” brings up a window that lets you search the Software Inventory list.
Once all matches are found, you can mark all or some of the matches for installation
or removal.

•

“Move to Parent” changes the selection from a particular subsystem or file to the
product or subsystem that contains that original subsystem or file. For example, if a
subsystem within the product IRIS Showcase were selected and you chose “Move to
Parent,” the entire IRIS Showcase product would become selected. See also “About
Product Structure: Products, Subsystems, and Files.”

The Software Menu
The Software menu controls your view of the Software Inventory list. When you choose an
item in the menu whose check box is empty, a check mark appears in the box to indicate
that the item will now appear in the Software Inventory list. You can choose as many items
as you like; the more you choose, the longer the list becomes. Most of the items become
available when you click the Customize Installation or Manage Installed Software buttons.
The menu contains these choices:
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•

“New Products” shows all available products that are new; a product is considered
new when it or an older version of the product has never been installed on your
system.

•

“Upgrade Products” shows all available products that are upgrades to (newer
versions of) products that are already installed on your system.

•

“Patch Upgrade Products” shows all available products that contain bug fixes to
products that are already installed on your system.

•

“Same Products” shows all available products that are identical to products that are
already installed on your system.

•

“Downgrade Products” shows all available products that are older versions of
products that are already installed on your system.

•

“Installed Products” shows all products that are currently installed on your system.

•

“Short Product Names” displays the abbreviated, hierarchical product name in the
Product column.
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•

“Subsystems Only” displays only subsystems (no products or files) in the Product
column.

•

“Configuration Files Summary” brings up a window that shows every configuration
file on the system, and gives you an option to view only those files that a privileged
user, Administrator, or network administrator has changed on your system using the
System Manager interactive guides or a text editor. See also “Checking
Configuration Files.”

The Panes Menu
The Panes menu lets you control which portions (called panes) of the Software Manager
window are displayed. By default, the Available Software, Software Inventory, and
Status/Disk Space panes are shown, so check marks appear next to these three items on
the menu.
To hide one of the three default panes, choose it from the menu; the check mark
disappears along with the pane; to view a pane that’s not displayed, choose it from the
menu. Software Manager retains your pane choices, so whatever panes are displayed
when you quit Software Manager are displayed the next time you start Software
Manager.
•

“Available Software” displays the Available Software drop pocket, pathname field,
path bar, recycle button, and Lookup button. You specify the location of the available
software in this pane; see “Specifying the Location of Available Software.”

•

“Software Inventory” displays only the Upgrade Products and New Products check
boxes when the LED on the Default Installation button is lit. When you click the
Customize Installation button, it displays a detailed list of all available software;
when you click the Manage Installed Software button, it displays a detailed list of all
installed software.

•

“Status/Disk Space” displays the Status area and the Disk Space menu button and
graphical space representation.

•

“Command” displays a text field in which you can type a subset of the standard Inst
(the command-line version of Software Manager) commands. For details, see
“Using Inst Commands in the Command Pane.”

•

“Log” displays a detailed, scrolling log of Software Manager messages.
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The Help Menu
The Help menu contains these choices:
•

“Click for Help” turns your cursor into a question mark. When you click this cursor
over any item or area of the Software Manager window, a help window appears
that describes the specific item or area.

•

“Overview” starts a help window that gives you an overview of the Software
Manager.

•

Each task-oriented topic starts a help window that covers the topic.

•

“Index” brings up a window that contains an index to all the help topics that are
available for the Software Manager. When you double-click a topic in the Index
window, the appropriate help window appears.

•

“Keys and Shortcuts” displays a window with information about keyboard
shortcuts that you can use to navigate through and make selections in the Software
Inventory list.

•

“Product Information” displays version information about the Software Manager.

Installing Software
If the root account has a password, you need to know it in order to install software.
Installing software is a three step process:
1.

Specify where the software is located; see “Specifying the Location of Available
Software.”

2. Choose to install either
•

upgrade products and/or new products (see “Performing a Default Installation”)

•

a custom selection of products or parts of products (see “Performing a Custom
Installation”)

For more information, see “About Default and Custom Installations.”
3. Start the installation by clicking the Start button.
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Click a topic for more information:
•

“Installing an Operating System Upgrade”

•

“About Default and Custom Installations”

•

“Performing a Default Installation”

•

“Performing a Custom Installation”

•

“About Product Structure: Products, Subsystems, and Files”

•

“Checking Configuration Files”

Installing an Operating System Upgrade
The Software Manager lets you upgrade your workstation to a new version of the
operating system. You can also use Inst as described briefly in your system’s owner’s
guide, or as described in detail in IRIX Admin: Software Installation and Licensing. In
general, upgrading the operating system consists of these steps:
1.

Shut down all running applications.

2. Have all remote users log off.
3. Make a full backup of all user and system files; see “Backing Up Files.”
4. Open the Software Manager by choosing “Software Manager” from the System
toolchest.
5. Follow the instructions in “Specifying the Location of Available Software” to
identify the location of the new operating system software.
6. Follow the instructions in “Performing a Default Installation” or “Performing a
Custom Installation,” depending on what type of installation you want to do.
7. The Status area reports the progress of the system upgrade. When it has successfully
completed, you’ll see a message in the status area.
8. Depending in the type of installation you’ve performed, the system either restarts
automatically or prompts you to restart after the installation is completed.
If the Software Manager encounters any problems or if an error occurs during the system
upgrade, the Software Manager automatically transfers you to Inst. (This also happens if
you click the Stop button during the system upgrade.) For brief descriptions of some
common Inst commands, see “Using Inst Commands in the Command Pane.” See IRIX
Admin: Software Installation and Licensing for more information about using inst.
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Specifying the Location of Available Software
Silicon Graphics distributes software on compact disks (CDs). You typically access the
new software from a CD drive that’s connected to either your own system or to another
system on your network whose CD drive allows software installation (see “Allowing
Remote Users to Install Software From Your CD Drive”).
In some sites, a network administrator copies the contents of the CD into a distribution
directory on a server system on your network so that you can access the new software
from a directory rather than a CD. (See also “Setting Up a Distribution Directory.”)
The first step in installing software is to tell the Software Manager where the software is
located. If the CD that contains the software distribution appears as an icon on your
desktop, just double-click the icon. This launches the Software Manager and specifies the
software’s location.
If the CD icon is not on your desktop, you can specify the location of the software by
following these steps:
1.

If the Software Manager is not already running, start it by choosing “Software
Manager” from the System toolchest, or by clicking the words Software Manager.
If the root account on your system has a password, a dialog box appears that requests
the password. If you do not know the password, click the Continue button, and
Software Manager starts in read-only mode where you can view available and
installed software, but cannot install or remove software.

2. Place the software CD into a CD drive that’s connected to your system or to another
system on the network. If you’re installing from a distribution directory, get the
system’s hostname and the full pathname of the directory from your network
administrator.
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3. Drag the CD or directory icon from your desktop into the Available Software drop
pocket in the Software Manager window, then click the Lookup button.
•

If the CD drive is connected to another system, choose “On a Remote
Workstation” from the Shared Resources rollover menu in the System toolchest.
Type the name of the remote workstation and press <Enter>; the resources
available on that workstation appear in the window. Drag the CD drive onto
your desktop; you can then drag it into the Available Software drop pocket (in the
System Manager window) and click the Lookup button.

•

If the software is in a directory that is on another system, click in the pathname
field labeled Available Software, type the remote system’s hostname, a colon (:),
and the full pathname of the directory, then press <Enter> or click the Lookup
button. For example, to specify a directory named /dist on a system named
mars, enter
mars:/dist

Then click the Lookup button.
If the drop pocket or pathname field does not accept the CD or directory, the CD or
directory does not contain installable software.
4. If you want to specify an additional distribution directory or CD, choose “Open
Additional Distribution” from the File menu.
The “Open Additional Distribution” window appears. Select a distribution using
one of these methods.
•

Select the name of a distribution that appears in the list of available ones and
click the Add button.

•

If the software is in a directory that is on another system, click in Distribution
field, type the remote system’s name, a colon (:), and the full pathname of the
directory, then click the Add button. (See Step 3 above for more information.)

•

Click the Browse button to open a file browsing window and then navigate
through the system’s directories to located the distribution directory. After you
locate the distribution you want, select it and click the Add button.

5. Software Manager is now ready to do a default installation (see “Performing a
Default Installation”).
To view all the available software or to install a custom selection of software
instead, click Customize Installation (see “Performing a Custom Installation”).
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About Default and Custom Installations
Once you specify the location of software to the Software Manager, it makes these
assumptions:
•

You want to automatically install the default set of products, so the LED is lit on the
Default Installation button.

•

You want to install all products that are newer versions of software that is already
installed).

•

You want to install all the default subsystems of the new software that is available
but is not yet installed on your system.

Each product consists of several parts; some are required for the product to work, others
are optional. See also “About Product Structure: Products, Subsystems, and Files.”
To install the default and required portions of the selected products, click the Start
button; see “Performing a Default Installation.”
To set up a custom installation of software, click the Customize Installation button. The
Software Inventory list displays a full listing of all software that is available from the CD
or distribution directory, and lets you
•

install specific products (both new and upgrade) and/or subsystems by selecting
them individually; you can expand products to view and select their various
subsystems and can expand subsystems to view and select their various files.

•

install older versions of products that are already installed

Note: For information about how to install and remove software at the same time, see

“Removing and Installing Software at the Same Time.”
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Performing a Default Installation
Use the default installation to install all default subsystems of upgrade products and all
default subsystems of new products. For more information, see “About Default and
Custom Installations.”
If there is a password on the root account, only the Administrator can install software (or a
user who has been granted the appropriate privileges; see “Overview of the Privilege
Manager” for information.) If the Software Manager is not already running, start it by
choosing “Software Manager” from the System toolchest, or by clicking the words
Software Manager.
Note: If the root account on your system has a password, a dialog box appears that requests
the password. If you do not know the password, click the Continue button, and Software
Manager starts in read-only mode where you can view available and installed software,
but cannot install or remove software.

To install default software automatically, follow these steps:
1.

Specify the location of the new software by dragging a CD or directory icon into the
Available Software drop pocket, then clicking the Lookup button. See also “Specifying
the Location of Available Software.”
If the drop pocket does not accept a CD or directory icon, the CD or directory does
not contain installable software.

2. Make sure the yellow LED is lit on the Default Installation button.
3. To start the installation, click the Start button in the middle of the Software Manager
window.
The Status area reports the progress of the installation in a series of stages: Initialize,
Install, and Post Install. (If the Status area is not displayed, you can display it by
choosing “Status/Disk Space” from the Panes menu.)
•

If the installation requires more than one CD, the Software Manager will
prompt you for the next CD.

•

If Software Manager encounters any installation conflicts, it displays a Conflicts
window in which you can resolve the conflict. See “Resolving Installation or
Removal Conflicts.”
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•

If Software Manager reports that you do not have enough disk space to install
the software you have selected, you can free disk space at this time by removing
other software products (see “Removing Installed Software”) or by selecting
fewer products or subsystems to install (see “Saving or Loading a Custom
Selection of Software”). If this does not result in enough disk space, you may
need to move some user files onto backup tapes, a second disk, or other systems
on the network. See also “Freeing Disk Space.”

•

If Software Manager reports a different sort of problem, see “Troubleshooting
Software Installation.”

4. When the installation is complete, a dialog reports that the installation was
successful. This dialog may also report the following:
•

Desktop and Icon Catalog icons for the products will not appear until the next
time you log in.

•

You must restart the system before the products will work.

5. At this time you can do the following:
•

Install more software from the same CD or distribution directory (see “Saving
or Loading a Custom Selection of Software”), or specify a new location from
which to install additional software; see “Specifying the Location of Available
Software.”

•

View or remove installed software; click Manage Installed Software, and see
“Viewing Installed and Available Software” or “Removing Installed Software.”

•

Stop using Software Manager; choose “Exit” from the File menu. The Status
pane reports all exit commands, then the Software Manager window
disappears.

6. To use your new software, see the documentation that came with the software. It
tells you where on the system the software is located, and how to run it.
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Performing a Custom Installation
By clicking the Customize Installation button you can install
•

only some of the upgrade or new products that are available (rather than all of
them)

•

only the required subsystems of a product, or the required subsystems plus some of
the optional subsystems

•

older versions (downgrades) of products that are already installed

While making a custom selection of software, you can also
•

remove software at the same time; see “Removing and Installing Software at the
Same Time”.

•

save your custom selections in a file that others can load directly into the Software
Manager; see “Saving or Loading a Custom Selection of Software”.

When you click the Customize Installation button, you’re requesting a more informative
view of the software that’s available.
If there is a password on the root account, only the Administrator can install software. If the
Software Manager is not already running, start it by choosing “Software Manager” from
the System toolchest, or by clicking the words Software Manager.
Note: If the root account on your system has a password, a dialog box appears that requests
the password. If you do not know the password, click the Continue button, and Software
Manager starts in read-only mode where you can view available and installed software,
but cannot install or remove software.

To install a custom selection of software, follow these steps:
1.

Specify the location of the new software by dragging a CD or directory icon into the
Available Software drop pocket, then click the Lookup button. See also “Specifying the
Location of Available Software.”
If the drop pocket does not accept a CD or directory icon, the CD or directory does
not contain installable software.
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2. Click the Customize Installation button.
You’ll see a wait cursor, and a series of progress indicators appear in the Status area
as the Software Manager scans all the available software. After several seconds (or a
few minutes if there are several products available), the Software Inventory pane
displays all of the available software.
By default, when you click Customize Installation, the Software Inventory pane shows
all available new products, upgrade products, patch upgrade products, same products,
and downgrade products.
3. Change your view of the available software, if you like; for more information, see
“Viewing Installed and Available Software.”
•

View fewer types of products in the Software Inventory list by choosing a type
(which removes the checkmark) from the Software menu. For example, if you
do not want the list to include downgrade products, choose “Downgrade
Products” from the Software menu.

•

View the next level of product structure detail for a specific product by clicking
the folded arrow icon next to the product’s name in the list. See also “About
Product Structure: Products, Subsystems, and Files.”

•

View only the smallest installable unit of the products by choosing (placing a
checkmark next to) “Subsystems Only” from the Software menu.

4. Choose which products you want to install (or remove).
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•

To choose one product at a time, either click to place a checkmark in the Install
box next to the product, or select the product and choose “Mark Install” from
the Selected menu.

•

To choose not to install a product, either remove the checkmark from the Install
box, or select the product and choose “Unmark (Keep)” from the Selected
menu.

•

To choose all upgrade products or all new products, choose “Mark Upgrades to
Install” or “Mark New Products to Install” from the Selected menu.

•

To choose only part of a product (a subsystem), click the folded arrow icon next
to the product to see its subsystems, then click the Install box next to those parts
you want to install.

•

To choose a product or part of a product to remove, choose “Installed Products”
from the Software menu to display installed products; then, in the Remove
column, click in the check box next to the item.
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Note: When you choose to install an upgrade product, a blue check mark appears in

the Remove box next to the currently installed version of the product. This indicates
that by installing the new version, the current version will be removed (replaced).
See also “Removing and Installing Software at the Same Time.”
5. After you’ve made all your selections, make sure they do not cause any installation
conflicts.
If you select a combination of software that cannot be safely installed on the system
(for example, prerequisite products are missing, or you did not select a required part
of a product), the Software Manager reports this in the Status area, and the Conflicts
button in the middle of the window becomes active.
To resolve conflicts, click the Conflicts button, and see “Resolving Installation or
Removal Conflicts.”
6. Make sure you’re comfortable with how much disk space the new software uses.
The Disk Space area shows existing disk space that’s in use, and shows in blue how
much additional space the new software requires. See also “Checking Available
Disk Space.”
If the Disk Space area is not displayed, you can display it by choosing “Status/Disk
Space” from the Panes menu.
If you do not have enough disk space to install the software you have selected, the
disk space pie turns red. You can free up disk space at this time by removing other
software products; see “Removing Installed Software.” If this does not result in
enough disk space, you may need to move some user files onto backup tapes, a
second disk, or other systems on the network. See also “Freeing Disk Space.”
7. To start the installation, click the Start button in the middle of the Software Manager
window.
The Status area reports the progress of the installation; if this area is not displayed,
you can display it by choosing “Status/Disk Space” from the Panes menu. When it
has successfully completed, you’ll see a message in the status area.
If the software manager encounters a problem, it displays a notifier; see
“Installation Ends Before It Is Complete.”
8. When the installation is complete, a dialog reports that the installation was
successful. This dialog may also report the following:
•

Desktop and Icon Catalog icons for the products will not appear until the next
time you log in.

•

You must restart the system before the products will work.
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9. At this time, you can do any of the following:
•

Install more software from the same CD or distribution directory, or specify a
new location from which to install additional software; see “Specifying the
Location of Available Software.”

•

View or remove installed software; click Manage Installed Software, and see
“Viewing Installed and Available Software” or “Removing Installed Software.”

•

Stop using Software Manager; choose “Exit” from the File menu.

10. To use your new software, see the documentation that came with the software. It
tells you where on the system the software is located, and how to start it up.

Checking Available Disk Space
The Software Manager displays the amount of disk space that is currently used and free
(available) for each disk on your system. If the Disk Space area is not currently shown,
you can display it by choosing “Status/Disk Space” from the Panes window.
The Software Manager automatically recalculates disk space when you click the
Customize Installation or Manage Installed Software button, and updates the disk space pie
chart. When your amount of free disk space changes independent of the Software
Manager (for example, when you remove some files using the desktop or a shell window
while the Software Manager is running), you can force Software Manager to recalculate
the disk space by choosing “Recalculate Disk Space” from the File menu.
Understanding the Disk Space Pie Chart

The disk space pie chart represents the total amount of space that’s available on the disk
directory whose name is displayed on the Disk Space menu button. See also “Viewing Space
on Different Disks or Disk Directories.”
The dark grey portion of the disk space pie chart shows the relative amount of space that
is currently being used; the precise amount in KB is shown to the right of the pie chart
and the dark grey square that is labeled Used. The white portion shows the relative
amount of free space; the precise amount in KB is shown to the right of the pie chart and
the white box that is labeled Free.
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When you choose items for installation or removal, a new wedge appears in the pie chart.
This wedge shows the change in disk space use that takes place once you install or
remove the items you selected. The color of the wedge and its corresponding Net Change
box indicate the positive or negative effects of your selections:
•

A light green wedge and box show that your selections will use up some of your
free space. The precise amount in kilobytes (KB) is shown to the right of the Net
Change box, and is always a positive number.

•

A dark blue wedge and box show that your selections will free some of your used
space. The precise amount in kilobytes (KB) is shown to the right of the Net Change
box, and is always a negative number.

•

A red wedge and box show that your selections require more disk space than you
have available. The precise amount of additional disk space you need to install all of
your selections is shown next to the Needs extra box.

•

The Overhead box displays additional, temporary disk space the Software Manager
requires to perform the installation. This “overhead” disk space will become
available again after you complete the installation.

Viewing Space on Different Disks or Disk Directories

The menu button next to Disk Space is labeled with the name of the disk or disk directory
(partition) that is displayed in the Disk Space area. New systems with one disk have only
one disk directory called / (root); this is the default disk directory that is shown in the
Disk Space area. Even when you have more than one disk, new software is installed onto
/.
If your system has more than one disk, or if your disk is divided into several disk
directories, choose the disk directory whose space you want to check from the menu
button.
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About Product Structure: Products, Subsystems, and Files
All software that the Software Manager can install is made up of several hierarchical
parts:
•

The product is the largest unit that you can display in the Software Inventory pane.
The operating system consists of several products that are required for the system to
work. You can also install several optional products.

•

Every product contains at least one subsystem. Each subsystem is a logical grouping
of product parts. For example, a product may have three subsystems; one that
contains online books, one that contains all software that is required for the product
to work, and one that contains all optional components of the product. The
subsystem is the smallest installable component of a product.

•

Each subsystem contains at least one file. You can view the list of files that make up
a subsystem, but you cannot install or remove individual files using the Software
Manager.

Note: Some advanced users may want to view a fourth structural component, called an

image; for information on viewing images, see “Setting Advanced Preferences.”
By default, the Software Inventory pane shows only products. To display the subsystems
that make up a product, click the folded arrow icon next to the product. To display the
files that make up a subsystem, click the folded arrow icon next to the subsystem. To
re-fold the arrow and hide the smaller components, click the unfolded arrow icon.
To view only subsystems (no products), choose “Subsystems Only” from the Software
menu. When only subsystems are displayed, you can still expand them to view the files
they contain.
In a hierarchical structure like this one, a unit that contains other units is called a parent,
and each unit it contains is called a child. The parent of a file is a subsystem, and the
parent of a subsystem is a product. To locate the parent of a specific child, select the child,
then choose “Move to Parent” from the Selected menu. For example, when you are
viewing a long list of subsystems, you can select a subsystem, then choose “Move to
Parent” from the Selected menu to find the product that contains the subsystem. The
parent becomes highlighted (selected) in the Software Inventory list.
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Checking Configuration Files
When you install a product, the product often includes some files that you customize (or
configure) either from within the application, or by editing the files using a text editor. A
file that you customize for your specific system or site is called a configuration file.
When you install upgrade products, the Software Manager does not destroy the
information in your configuration files. It either
•

saves your old configuration file, but renames the old version (filename.O) and uses
a new version

•

saves your old configuration file and uses it, but also installs the new version under
a new name (filename.N)

To view the list of all configuration files on your system, or a list of all configuration files
that have been changed, follow these steps:
1.

Click the Manage Installed Software button.

2. Choose “Configuration Files Summary” from the Software menu.
3. In the Configuration Files window, specify which files you want to list.
•

To see a list of all configuration files on your system, click the radio button next
to All Files.

•

To see a list of only those configuration files that you have changed and for
which another version may be installed (for example, where both filename and
filename.N exist on the system), click the radio button next to Modified Files.
When your system shows changed configuration files, you can ignore the new
configuration files; check the two different versions and decide to use one
version as is; or merge the contents of both versions. For details, see
“Understanding and Merging Configuration Files.”

4. To close the window, click the Close button.
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Viewing Installed and Available Software
The Software Manager offers two standard views:
•

Click Manage Installed Software to view all software that is currently installed on
your system; it is displayed in the Software Inventory list. In this default view, you
will not see any software that is available for installation.

•

Click Customize Installation to view software that is available from the CD or
distribution directory that is specified in the Available Software pathname field; it is
displayed in the Software Inventory list. By default, this shows new products, upgrade
products, patch upgrade products, same products, downgrade products, and not
installed products. It does not show any products that are already installed.

Regardless of which standard view you start with, you can change it using the Software
menu. Click a topic for more information:
•

“Changing Your View of Installed and Available Software”

•

“Understanding the Software Inventory List”

•

“Viewing Required and Optional Software”

•

“Finding Specific Software”

Changing Your View of Installed and Available Software
You can change your view using the Software menu in these ways:
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•

Add or remove checkmarks on the Software menu next to “New Products,”
“Upgrade Products,” “Patch Upgrade Products,” “Same Products,” “Downgrade
Products,” or “Not Installed Products” to view or hide these types of available
software.

•

Add or remove the checkmark on the Software menu next to “Installed Products” to
view or hide the complete list of software that is currently installed.

•

Add or remove the checkmark on the Software menu next to “History” to view or
hide the complete list of software that was at one time installed but is not currently
installed.

•

Place a checkmark next to “Short Product Names” to see abbreviated names in the
Product column; remove the checkmark to see the full names.

Viewing Installed and Available Software

•

Place a checkmark next to “Subsystems Only” to view only the smallest installable
or removable part of the products (the subsystems); remove the checkmark to see
the top-level products. See also “About Product Structure: Products, Subsystems,
and Files.”

•

Choose “Configuration Files Summary” to see a separate window that contains a
list of every site- and user-specific configuration file contained in the products. See
also “Checking Configuration Files.”

By using the Software menu in these ways, you can make your view of available and
installed software as simple or comprehensive as you like. You can also view more detail
about the structure of each product by clicking the folded arrow icon next to the
product’s name in the list; see also “About Product Structure: Products, Subsystems, and
Files.”

Understanding the Software Inventory List
You can control the contents of the Software Inventory list using the Software menu (see
“Viewing Installed and Available Software”). For details on the information shown in
each column, click a column name:
•

“The Remove Column”

•

“The Install Column”

•

“The Product Column”

•

“The Status Column”

•

“The Size Column”

•

“The Type Column”

You can also use keyboard shortcuts to navigate the list and make selections; see
“Keyboard Shortcuts in the Software Inventory List.”
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The Remove Column

The Remove column contains check boxes that correspond to the item shown in the
Product column. When you place a checkmark in a Remove check box, you are selecting
that item for removal.
You can place a checkmark in a Remove check box by either clicking in the box, or
selecting the item in the Product column and choosing “Mark Remove” from the Selected
menu.
When you select for installation a newer version of a product that is already installed
(that is, when you choose to replace an installed product with an upgrade product), a
blue checkmark (rather than a red checkmark) automatically appears in the Remove check
box next to the installed product. See also “Removing and Installing Software at the Same
Time.”
The Install Column

The Install column contains check boxes that correspond to the item shown in the Product
column. When you place a checkmark in an Install check box, you are selecting that item
for installation.
You can place a checkmark in an Install check box by either clicking in the box, or
selecting the item in the Product column and choosing “Mark Install” from the Selected
menu.
The Product Column

The Product column shows whether an item is a product, subsystem, or file (see also
“About Product Structure: Products, Subsystems, and Files”), and displays the item’s full
name. When you select an item by clicking on it, the name of the product that contains
the selected item appears in the text field next to the Product column label.
Immediately to the left of the item’s description (Product, Sub, or File) is a folded arrow
icon. To see what the item contains, click this icon. When the arrow is expanded the
column displays more detail about a product’s content. You can eliminate the detail and
re-fold the arrow icon by clicking it.
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The Status Column

The Status column describes the item relative to the software that is currently installed.
Descriptions that appear in boldface type indicate that the item is available for
installation (is on the CD or in the distribution directory). Descriptions that appear in
normal type indicate that the item is not available for installation; it is either installed on
the system or has been removed.
•

New (in boldface type) indicates that the item is available for installation, and that it
or an older version of the product has never been installed on your system.

•

Upgrade (in boldface type) indicates that the item is available for installation, and is
part of an upgrade product; it is a newer version of a product that is already
installed.

•

Patch Upgrade (in boldface type) indicates that the item is available for installation,
and is part of a patch upgrade product; it contains bug fixes for a version of a
product that is already installed.

•

Same Version (in boldface type) indicates that the item is available for installation,
and is the same version of a product that is already installed.

•

Older Version (in boldface type) indicates that the item is available for installation,
and is part of a product that is older than the version of the product that is already
installed; it is a downgrade product.

•

Not Installed (in boldface type) indicates that the item is available for installation,
and that it has been available for installation before but has never been installed;
this description only appears in the Managed Installed view.

•

Installed (in normal type) indicates that the item is already installed on the system.

The Size Column

The Size column shows how much disk space (in kilobytes) an installed item occupies,
and shows how much disk space an uninstalled item will occupy once it is installed.

81

Chapter 4: Installing and Removing Software

The Type Column

The Type column uses character codes to provide additional information about each
subsystem that may help you decide which subsystems to install or remove. The character
codes do not appear next to the product or a file. To see the codes, you must click the
folded arrow icon next to a product, or you can choose “Subsystems Only” from the
Software menu.
More than one character code may appear next to a subsystem. This list describes each
code:
R

The subsystem is required for the basic operating system (IRIX) to run.

D

The subsystem is not required for IRIX to run, but the manufacturer
recommends installing it; it is selected for installation by default. An
example of default subsystems are those that provide the graphical
Indigo Magic Desktop; if you choose not to install these, your system
will provide only IRIX shells as an interface.

B

You must restart the system after installing the subsystem.

O

The subsystem was installed as part of a maintenance release.

E

The subsystem is empty and therefore should not be installed.

C

The subsystem can be installed only by a diskless client system.

If no character codes appear next to a subsystem, it is probably (but not always) an
optional component of the product. For example, most manufacturers do not designate
subsystems that contain clip art as default, since they often are unwanted and occupy
large amounts of disk space.
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Keyboard Shortcuts in the Software Inventory List

You can navigate through the Software Inventory list and make selections by clicking in
the list, then using these keyboard shortcuts:
<Home>

Go to the top of the list and select the first item.

<End>

Go to the bottom of the list and select the last item.

<Page Up>

Scroll the contents of the list one up one windowful.

<Page Down>

Scroll the contents of the list down one windowful.

<-> or up arrow

Move the cursor to the item that is immediately above the current
selection.
<Enter> or down arrow

Move the cursor to the item that is immediately below the current
selection.
<i>

Mark selected item for installation.

<r>

Mark selected item for removal.

<k>

Unmark (keep) selected item so it will not be installed or removed.

The similar keyboard shortcuts that are available from the Selected menu work at any
time; you do not need to first click in the Software Inventory list.

Viewing Required and Optional Software
The Software Manager displays an R in the Type column next to each subsystem that is
required for the operating system (IRIX) to run, and places a D in this column next to all
subsystems that are selected for installation by default (that the manufacturer
recommends installing); it does not place these codes next to the product or files. See also
“The Type Column.”
To check whether a subsystem is required or recommended for the operating system to
run, you can do one of the following:
•

Click the folded arrow icon next to a product to display the subsystems.

•

Choose “Subsystems Only” from the Software menu to view only the subsystems.
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At this time the Software Manager does not indicate conclusively whether a specific
subsystem of an optional product is required for the product to run. If no character code
appears next to a subsystem, it is likely that the subsystem is not required. For conclusive
information, view the product’s release notes by following these steps:
1.

Select the product from the Software Inventory list.

2. Choose “Release Notes” from the Selected menu.
3. Use the scroll bar and the Prev Chapter and Next Chapter buttons to read through the
release notes. See Chapter 2 for information about which subsystems are required.

Finding Specific Software
To find specific software, such as a product, subsystem, or file (see also “About Product
Structure: Products, Subsystems, and Files”), choose either “Find” or “Find and Mark”
from the Selected menu.
The Find window lets you search for strings within products, subsystems, and files; see
“Finding Strings Within Products, Subsystems, and Files.”
The Find and Mark window lets you search for products and subsystems and mark or
unmark them for installation or removal; see “Finding and Marking Products and
Subsystems.”
Finding Strings Within Products, Subsystems, and Files

To use the Find window, choose “Find” from the Selected menu, then follow these steps:
1.

In the Find field, type the name or a part of the name of the software that you want
to find.
For example, to find all the products or subsystems that contain Release Notes,
enter Release Notes. To find all products or subsystems that contain the string Exe,
enter Exe (you do not need to use a wildcard character such as *).
The string you enter is compared to either the long or short names, depending on
which view of the names you selected from the Software menu.
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2. Customize the way the Find window searches for the name. By default, it searches
each product and subsystem for the exact string that you enter in the field.
•

Click the box next to Search Files if you also want to search all files that make up
all the products.

•

Click in the box next to Ignore Case if you want to find all instances of the string,
regardless of whether characters in the string are uppercase or lowercase. By
default, there is a check mark in this box.

3. Click the Search button to start the search.
When the search is complete, the window reports how many matches it found, and
the first matching item in the Software Inventory list is selected.
To stop the search before it is complete, click the Stop Search button.
4. Browse through all the matches.
•

To move forward through the list, click the Search button.

•

To move backward through the list, click the Previous button.

5. Search for a different string, or close the window.
•

To search for a different string, type a new string in the Find field, then click the
Search button.

•

To close the Find window, click the Close button.

Finding and Marking Products and Subsystems

To use the Find and Mark window, choose “Find and Mark” from the Selected menu,
then follow these steps:
1.

In the Find field, type the name or a part of the name of the product or subsystem that
you want to find.
For example, to find all the products or subsystems that contain release notes, enter
release notes. To find all products or subsystems that contain the string Exe, enter
Exe (you do not need to use a wildcard character such as *).
The string you enter is compared to either the long or short names, depending on
which view of the names you selected from the Software menu.
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2. Customize the way the Find window searches for the name. By default, it searches
each product and subsystem for the exact string that you enter in the field.
Click in the box next to Ignore Case if you want to find all instances of the string,
regardless of whether characters in the string are uppercase or lowercase. By
default, there is a check mark in this box.
3. Click the Search button to start the search.
When the search is complete, the window reports how many matches it found, and
the first matching item in the Software Inventory list is selected.
4. Browse through all the matches.
•

To move forward through the list, click the Search button.

•

To move backward through the list, click the Previous button.

5. Mark or unmark for installation or removal some or all of the matches.
When you mark a product or subsystem that’s already installed, it is marked for
removal (a checkmark appears in its Remove column); when you mark an available
product or subsystem, it is marked for installation (a checkmark appears in its
Install column.)
•

To mark or unmark only the match that’s selected in the Software Inventory list,
click the Mark or Unmark button. After you click the button, the next match
becomes selected. Use the Search and Previous buttons to find other specific
matches to mark or unmark.

•

To mark or unmark all matches, click the Mark Matches or Unmark Matches
button.

6. Search for a different string, or close the window.
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•

To search for a different string, type a new string in the Find field, then click the
Search button.

•

To close the Find window, click the Close button.

Removing Installed Software

Removing Installed Software
The Administrator can use the Software Manager to remove only software that was
installed using the Software Manager or Inst. You can remove software while installing
other software (see “Removing and Installing Software at the Same Time”) or in an
independent removal session.
To remove software, follow these steps:
1.

If the Software Manager is not already running, start it by choosing “Software
Manager” from the System toolchest or by clicking the words Software Manager.
If the root account on your system has a password, a dialog box appears that requests
the password. If you do not know the password, click the Continue button, and
Software Manager starts in read-only mode where you can view available and
installed software, but cannot install or remove software.

2. In the Software Manager window, click Manage Installed Software.
You’ll see a wait cursor, and a series of progress indicators appear in the Status area
as the Software Manager locates all the installed software. After several seconds or
minutes, the Software Inventory pane displays all software that was installed using
the Software Manager.
3. Find and identify the products or parts of products that you want to remove.
•

To find an item by searching for a specific string, choose “Find” from the
Selected menu.

•

To determine whether an item is required for the operating system or an
optional product to work properly.

4. In the Remove column, click in the check box next to each item that you want to
remove.
•

To remove an entire product, click in the Remove check box in the line where the
word Product appears in the Product column. This automatically selects each
subsystem that makes up the product.

•

To remove part of a product (a subsystem), click the folded arrow icon that
appears next to the product that contains the item you want to remove, then
click in the Remove check box that’s next to the item.
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5. Check for removal conflicts.
If you select a combination of software that cannot be safely removed (for example,
if you selected an item that is required for the operating system or an optional
product to work), the Software Manager reports this in the Status area, and the
Conflicts button in the middle of the window becomes active.
To resolve conflicts, click the Conflicts button.
6. To remove the selected software, click the Start button in the middle of the Software
Manager window.
7. When the removals are complete, a dialog reports that the removals were successful.
At this time you can do any of the following:
•

Remove other products.

•

Install software by specifying a location

•

Stop using Software Manager; choose “Exit” from the File menu.

Removing and Installing Software at the Same Time
You can remove and install software simultaneously in three different cases:
•

When available upgrade products (newer versions of installed products) are selected
for installation, the appropriate subsystems of the installed (older) versions of the
products will be automatically removed and replaced by the newer versions. You
do not have to explicitly request that the installed versions be removed. The
Software Manager places a blue checkmark in the Remove box of the installed
version.
You can click the Manage Installed Software button to view these checkmarks, and
can then click Customize Installation to continue your customization. All selections
that you make are retained.
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•

When you click Customize Installation, select some items for installation, choose
“Installed Software” from the Software menu, and explicitly select some installed
items for removal, both installations and removals take place when you click the
Start button.

•

When your selections cause a conflict, the Conflicts window lets you select items for
installation or removal that can resolve the conflict. The installation or removal
takes place when you click the Start button.

Saving or Loading a Custom Selection of Software

In all cases, the Disk Space area predicts the net change in disk space use that occurs after
all installations and removals are complete.
Note: If you need to remove software because you don’t have enough disk space to

perform a desired installation, see “Troubleshooting Software Installation” for
instructions.

Saving or Loading a Custom Selection of Software
The Software Manager lets you save your custom selections of software in a file so that
the same custom installation can be performed again at a later time. This is especially
useful in sites where a network administrator loads software on all systems, and wants all
systems to have an identical inventory of software.
The custom selection that you save is unique to the distribution directory or CD that you
specified in the Available Software field. In other words, other users can use the custom
selection file only if they specify a distribution directory or CD that contains the same
software that yours did when you saved the selections.
Note: You must save the custom selections before you start the software installation.

To save your custom selections, follow these steps:
1.

Choose “Save Selections” from the File menu.

2. In the Save Selections window, enter a full pathname for the file in the Selection field.
3. Click the OK button.
To load a file that contains custom selections, follow these steps:
1.

In the Available Software field, specify a distribution directory or CD that contains the
same software as was specified when the custom selections were saved.

2. Choose “Load Selections” from the File menu.
3. In the Load Selections window, enter a full pathname for the file in the Selection
field.
4. Click the OK button.

89

Chapter 4: Installing and Removing Software

Setting Software Manager Preferences
You can customize many aspects of the Software Manager’s behavior using the
Preferences window. Most of the customizations are useful only for a network
administrator or very advanced users. See also “Setting Advanced Preferences” in this
guide; also see the IRIX Admin: Software Installation and Licensing.
To customize the Software Manager’s behavior, follow these steps:
1.

Choose “Set Preferences” from the File menu.

2. Select a preference that you want to set or learn about.
A description of the preference appears in the Preference Description pane, and any
controls you need to use to set the preference appear below the pane.
3. Adjust the controls below the Preference Description pane, then set the preference by
clicking the Apply button.
4. Close the window by clicking the Close button.

Troubleshooting Software Installation
The Software Manager has several built-in troubleshooting tools:
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•

Informative dialogs provide status information and warnings.

•

The Conflicts window reports installation conflicts and helps you resolve them; see
“Resolving Installation or Removal Conflicts.”

•

The Status area and Log pane provide information throughout an installation
and/or removal session; see “Viewing Status and Log Information.”

•

The system file /var/inst/INSTLOG contains all status and error messages from each
Software Manager and inst session.

Troubleshooting Software Installation

Click a problem for information on solving it.
•

“Resolving Installation or Removal Conflicts”

•

“System Cannot Find the New Software”

•

“Installation Ends Before It Is Complete”

•

“Not Enough Disk Space for Installation”

For comprehensive, advanced troubleshooting information, see IRIX Admin: Software
Installation and Licensing.

Resolving Installation or Removal Conflicts
When you are customizing an installation, Software Manager monitors your installation
and removal choices as you make them. When it detects that you have selected a
combination of software that cannot be safely installed or removed, it alerts you by
making the Conflicts button active. When you click the Conflicts button, the Conflicts
window appears in which you can resolve the problem. In an automatic installation, the
Conflicts button does not become active; Software Manager automatically displays the
Conflicts window.
Note: In many cases, as you customize your installation, you can create and resolve

conflicts as you click in the Install and Remove check boxes. You may want to wait to view
the Conflicts window until you have made all your selections.
Click a topic for more information:
•

“Understanding Different Types of Conflicts”

•

“Making Your Conflict Resolution Choices”

•

“Switching Distributions to Resolve a Conflict”
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Understanding Different Types of Conflicts

Conflicts usually arise when on e of the following occurs:
•

Your selections do not include one or more products that are required for the
operating system to run. This can happen when you do not select a required
product for installation, or when you select a required, installed product for
removal.

•

The system is missing one or more prerequisite products. This can happen when a
prerequisite product is not currently installed, when you select a product for
installation and then select a prerequisite product for removal, or when you select a
product for removal that is a prerequisite product for other products that are
already installed.

•

You select incompatible products. This can happen when you choose to install a
version of a product that cannot work on (is incompatible with) the current version
of the operating system software, or when you choose to install two different
versions of the same product.

•

You select a product for installation that is an older version of a product that is
already installed.

•

You select a patch upgrade product (a product that corrects problems with a base
product) for installation, and select its base product for removal.

Making Your Conflict Resolution Choices

The Conflicts window describes each conflict (see also “Understanding Different Types
of Conflicts”), and gives you several options for resolving the conflict; choose only one
of these options. If software that you need to install to resolve a conflict is not available,
the option is shown, but is not active; see “Switching Distributions to Resolve a Conflict.”
1.
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Note the total number of conflicts. Often when you resolve one conflict, it either
resolves or creates many other conflicts. As you proceed, note how the total number
of conflicts at the top of the window changes.

Troubleshooting Software Installation

2. Read the description of each conflict and its resolution options, then choose an
option using these guidelines:
•

When you have selected an optional product that is incompatible with the rest
of the operating system, do not install it.

•

When you have selected incompatible products, choose to install the newer
version of a product.

•

When the system is missing one or more prerequisite products or subsystems,
choose to install the prerequisites.
If the prerequisite is not available (that is, it is not located on the CD or in the
distribution directory that’s specified in the Available Software field) the option is
shown but is not active; to install the software, see “Switching Distributions to
Resolve a Conflict.”

3. When you have resolved all conflicts, the Conflicts window closes automatically.
4. In the Software Manager window, the Start button should now be active; click it to
start the software installation or removal.
Switching Distributions to Resolve a Conflict

When you want to resolve a conflict by installing a product that is not available (that is,
it is not located on the CD or in the distribution directory that’s specified in the Available
Software field), follow these steps:
1.

In the Conflicts window, choose “Open Additional Distribution” from the File
menu.
The “Open Additional Distribution” dialog box appears and prompts you to enter
another distribution.

2. Remove the existing CD from the CD drive.
3. Place the new CD into the drive that’s connected to your own system or to another
system on the network. If you’re installing from a distribution directory, get the
system’s hostname and the full pathname of the directory from your network
administrator.
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4. In the “Open Additional Distribution” window, select a distribution using one of
these methods.
•

Select the name of a distribution that appears in the list of available ones and
click the Add button.

•

If the software is in a directory that is on another system, click in Distribution
field, type the remote system’s name, a colon (:), and the full pathname of the
directory, then click the Add button.

•

Click the Browse button to open a file browsing window and then navigate
through the system’s directories to located the distribution directory. After you
locate the distribution you want, select it and click the Add button.

Viewing Status and Log Information
Both the Status area and the Log pane provide information throughout an installation
and/or removal session.
The Status area provides high level, easy to understand information and warnings. To
view it, choose “Status/Disk Space” from the Panes menu.
The Log pane provides very detailed information which is especially useful when you
encounter problems (other than installation conflicts) during an installation. To view it,
choose “Log” from the Panes menu.
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System Cannot Find the New Software
The system cannot find the software when any of the following occurs:
•

There is no CD in a drive that you specified.

•

The remote CD drive that you specified is not enabled for remote software
installations. Contact the Administrator of the system to check whether this is the
case. (See also “Allowing Remote Users to Install Software From Your CD Drive.”)

•

Your system cannot contact the system on the network that has the software. See
“Troubleshooting General Network Errors.”

•

You entered an incorrect distribution directory name.
This typically happens when you are installing from a remote CD drive, and the
drive is not accessible from (is not mounted at) the /CDROM directory.
Choose “Shared Resources” from the Desktop toolchest and then choose “On a
Remote Workstation” from the rollover menu. Type the name of the remote
workstation to which the CD drive is connected. A list of the available devices
appears. Drag the /CDROM folder icon from the window into the Available
Software drop pocket in the Software Manager.
Also, be sure to complete the full pathname with /dist, which is the name of the
directory on the CD in which the software is stored. For example, the full pathname
for new software on a CD whose pathname is /drives/cdrom on a system named mars
is mars:/drives/cdrom/dist.

Installation Ends Before It Is Complete
If an installation ends before it is complete (for example, if the Software Manager
unexpectedly quits), you can attempt to finish the installation session by following these
steps:
1.

If the Software Manager window is still available, choose “Exit” from the File menu.

2. Restart the Software Manager by choosing Software Manager from the System
toolchest, or by clicking the words Software Manager now.
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3. Before the main Software Manager window appears, you see a notifier that
describes the location of the software, lists products that were selected for
installation but were not installed, and gives you several choices. Review these
options:
•

Retry the previous installation. This is the default selection; the Software
Manager window appears, and the Software Manager attempts to complete the
installation.

•

Restore the previous installation session. This starts up Software Manager so
you can review the installed and uninstalled software. You can then either quit
Software Manager without completing the installation, or resume the
installation by clicking the Start button.

•

Ignore the previous installation session. This starts up Software Manager with
no history of the previous installation.
Note: When you choose to ignore the session, the Software Manager saves the

session information in the file /var/inst/.checkpoint.O. If you ever want to
complete the session, choose “Load Selections” from the File menu, and enter
this filename.
4. Choose an option, then click the OK button.
5. If you chose to resume or view the installation session and you see an error
message, see “Resolving Errors During a Resumed Installation Session.”
Installation of Operating System Ends Before it is Complete

If the installation of a new operating system ends before it is complete (either because
you clicked Stop or because the system encountered errors), the Inst prompt appears. You
must now use Inst commands to resume, quit, or troubleshoot the installation. For more
information, see IRIX Admin: Software Installation and Licensing.
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Resolving Errors During a Resumed Installation Session

When you resume an installation session that ended unexpectedly (before it was
complete), you may encounter these errors:
•

The distribution <pathname> does not exist. The distribution that was in place

for the initial installation session is no longer there. This could happen when a
network administrator removes a distribution directory.
•

Invalid product <product> in selections file. The distribution directory or

CD still exists, but it contains a set of products that is different from the set that was
there during the initial installation. This typically happens when the original CD
was removed and replaced with a different one.
•

Conflicts must be resolved. Conflicts that didn’t exist during the initial

installation now exist. If the Conflicts window is not displayed, click the Conflicts
button to resolve them, and see “Resolving Installation or Removal Conflicts.”
•

Installation requires too much space. The system no longer has enough disk

space to complete the installation. Select fewer products or subsystems to install, or
remove other data from your disk; see “Freeing Disk Space.”

Not Enough Disk Space for Installation
If you need to free up disk space to perform an installation, you can use one of these
methods:
•

Remove products by following these steps:
1.

Choose “Save Selections” from the File menu to save your current selections in
a file.

2.

Choose “Unmark All” from the Selected menu to clear all current selections.

3.

Click Manage Installed Software.

4.

Select products for removal and click Start.

5.

See “Removing Installed Software” for more information about removing
products.

6.

When the products have been removed, choose “Load Selections” from the File
menu to restore your original selections.
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•

Relocate products by following these steps:
1.

Click Manage Installed Software.

2.

Choose “Relocate Products” from the File menu.
If this item is not available in the menu, it means that your system does not
contain any products that can be relocated.

3.

In the “Relocate Products” window, look for products that are located on
filesystems with small amounts of free disk space.
Look at the “Filesystems” column in the window for information.

4.

Select the products you want to relocate (you can select more than one) and
then click the Apply button.
Depending on the size of the products being relocated, the operation may take
awhile.

Advanced Topics
This section contains information for experienced system or network administrators. For
comprehensive advanced information, see IRIX Admin: Software Installation and Licensing,
available online.
Click a topic for more information:
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•

“Setting Up a Distribution Directory”

•

“Using Inst Commands in the Command Pane”

•

“Setting Advanced Preferences”

•

“Understanding and Merging Configuration Files”

Advanced Topics

Setting Up a Distribution Directory
To copy new software from a distribution CD into a directory on a server system so users
can install from this distribution directory across the network, follow these steps:
1.

Copy the dist directory from the CD onto a server system.

2. On the server system, allow remote installations by editing /usr/etc/inetd.conf.
3. Provide the server’s hostname and the full pathname of the dist directory to all users
who need to install the software.
For more details, see “Setting Up an Installation Server” in IRIX Admin: Software
Installation and Licensing.

Using Inst Commands in the Command Pane
The command line version of Software Manager is called Inst. You can run Inst from
either a shell window or from a limited version of the operating system called the
miniroot. Inst commands are fully documented in IRIX Admin: Software Installation and
Licensing.
If you use both Software Manager and Inst, you may find it convenient at times to use a
subset of the more complex but often more powerful Inst commands while using
Software Manager. To issue Inst commands, follow these steps:
1.

Choose “Log” from the Panes menu. All output from the commands you type in the
Command field appears in the Log pane.

2. Choose “Command” from the Panes window.
3. In the Command text field that appears above the Log pane, enter the command; then
press <Enter>.
The Command pane supports these inst commands:
install <string> The string is the name of a product, image, or subsystem that you want

to mark for installation. It can contain the wildcard character *
(asterisk). This way you can choose to install, for example, all
subsystems that contain man pages by typing: install *.man
remove <string>

The string is the name of a product, image, or subsystem that you want
to mark for removal. It can also contain the wildcard character *
(asterisk).
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keep <string>

The string is the name of a product, image, or subsystem that you want
to keep in its current installation state; you do not want to install or
remove the item. The string can also contain the wildcard character *
(asterisk).

set <preference>

The preference is a preference listed in the Set Preferences window.

files <product>

Lists all files in the product.

space

Calculates disk space and displays it in the Disk Space pane.

recalculate

Recalculates the disk space and displays it in the Disk Space pane. This
is the same as choosing “Recalculate Disk Space” from the File menu.

save <filename>

This is the same as choosing “Save Selections” from the File menu and
typing a filename in the window that appears.

load <filename>

This is the same as choosing “Load Selections” from the File menu and
typing a filename in the window that appears.

from <distribution>Specifies the location (source) of a software distribution. This is the

same as clicking the Locate button.
open <distribution> Adds a new distribution to the list.
close <distribution>

Closes the specified distribution.
config

Lists every configuration file, and places an m next to those that have
changed.

hardware

Displays a brief summary of your system’s hardware configuration.

filter <type>

Selects the type of products (for example, new, upgrade) to be
displayed.

show

Describes the current view shown in the Software Inventory list.

sort <field>

When a subsequent list command is given, the list will be sorted with
the specified field (for example, product, size) first.

list

Shows available software products.

help

Lists help topics.

go

Starts the installation.

quit

Quits the Software Manager.

For a summary of all Inst commands, see IRIX Admin: Software Installation and Licensing.
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Setting Advanced Preferences
The Set Preferences window supports three levels of preferences. By default, it shows a
small, often-used set of preferences. You can also view advanced preferences and hidden
preferences.
To view and set advanced preferences, follow these steps:
1.

Choose “Set Preferences” from the File menu.

2. Select swmgr_visible_resources from the Swmgr Preferences list, then choose to
view transient (those that last for this session only) and/or expert (those that are for
experienced system administrators) preferences by clicking in the appropriate check
box.
3. Click the Set button. This displays all advanced preferences in the Swmgr Preferences
list.
4. Select a preference to see its description in the Preference Description pane, and to
make buttons appear that help you set the preference.
Note: For people familiar with using Inst, you can view images that make up

products by setting the expert resource hide_image_products to FALSE.
5. Choose values using the buttons, then click the Set button.
To view hidden preferences, follow these steps:
1.

Choose “Set Preferences” from the File menu.

2. Select swmgr_visible_resources from the Swmgr Preferences list, choose to view
expert preferences by clicking in the expert check box, then click the Set button.
3. Select show_hidden_resources from the Swmgr Preferences list, click the radio
button next to TRUE, then click the Set button. All hidden preferences are now
displayed in the list.
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Understanding and Merging Configuration Files
When you install upgrade products, the Software Manager does not destroy the
information in your configuration files. It does one of the following:
•

saves your old configuration file, but renames the old version (filename.O) and uses a
new version

•

saves your old configuration file and uses it, but also installs the new version under
a new name (filename.N)

You need to identify the configuration files that have changed, then decide whether you
want to
•

use the new version and risk losing some configuration changes you made in the
past

•

use your old version and ignore possible enhanced features contained in the new
version

•

merge the old and new versions by adding previous changes to the new version and
naming it filename (rather than filename.O or filename.N)

Follow these steps:
1.

Identify configuration files that have changed.
•

Click the Manage Installed Software button.

•

Choose “Configuration Files Summary” from the Software menu.

•

Click the radio button next to Modified Files.
The list shows all changed configuration files, and places an m next to the
version of the file that was in use prior to the installation.

2. Compare the two versions of the file using the gdiff command.
•

Choose “Open Unix Shell” from the Desktop toolchest.

•

In the shell window, type
gdiff <filename1> <filename2>
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3. Decide whether you want to use either file as is to merge them.
•

To use a file as is, you may need to rename it. For example, to use filename.N,
rename it filename.

•

To merge files, carefully transfer past edits from your old configuration file to
the newer version of the file. If you are unfamiliar with the configuration files or
are uncomfortable about the risks associated with damaging a configuration
file, contact an experienced IRIX administrator to help you merge the files.
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The System Manager provides a number of different interactive guides that help you
create and manage user login accounts.
Click a topic for more information:
•

“Overview of the User Manager”

•

“Understanding User Accounts, Groups, and the Network”

•

“Creating a User Login Account”

•

“Modifying a User Login Account”

•

“Creating, Changing, and Deleting Passwords”

•

“Deleting a User Login Account”

Overview of the User Manager
The User Manager displays the following information about existing user login accounts
on the system.
•

The Login Name column shows the login name of each user.

•

The Full Name column shows the real name of the person who owns the login
account.

•

The Group Name column shows the group to which the user belongs.

The User Manager also provides access to guides that let you add, modify, and delete
user accounts, as well as assign and change user account passwords.
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You can use the Get Info button to display detailed information about a user account. See
“Viewing User Login Account Information” for more information.
You can create and add users to a group, but not delete users from groups or delete
groups. See “Managing User Groups” for this information.

About the Menus
The Task menu contains these choices:
•

“Add Account” opens the “Add a User Account” guide, which lets you create a
new user account on the system. This command is equivalent to the Add button. See
“Creating a User Login Account” for more information.

•

“Change Password” opens the “Modify Any Account Password” guide, which lets
you change the password on a user’s account. This command is equivalent to the
Password button. See “Creating, Changing, and Deleting Passwords” for more
information.

•

“Edit Account” opens the “Modify a User Account” guide, which lets you make
changes to an existing user account on the system. This command is equivalent to
the Edit button. See “Modifying a User Login Account” for more information.

•

“Delete Account” opens the “Remove a User Account” guide, which lets you delete
an existing user account from the system. This command is equivalent to the Delete
button. See “Deleting a User Login Account” for more information.

•

“Configure Auto Login” opens the “Configure Auto Login” guide, which lets you
enable or disable automatic logins. When you enable auto login for a specific login
account, that account is automatically opened when the system starts up.

•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Filesystem Manager window. Any changes you made using the
guides are saved. This command is equivalent to the Close button.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.

106

Understanding User Accounts, Groups, and the Network

Understanding User Accounts, Groups, and the Network
This section contains these topics:
•

“About User Login Accounts and Groups”

•

“About User Login Accounts on the Network”

For information about different user types and access privileges, see “About User
Privileges.”

About User Login Accounts and Groups
Each person who uses this system regularly must have a personal login account. A login
account gives a person a unique work area on the system (a home directory) where the
person can store files and customize the desktop environment. The system automatically
labels the work area and all files that the person creates with the person’s login name. Each
time a user begins a session on the system, the user types a login name and, if necessary,
an associated password. For more information on logging in, see “Logging In to Your
System.” For information on creating a user login account, see “Creating a User Login
Account.”
The login account can also include a picture of the person. The picture represents the
person’s account as an icon on the login screen; the user can double-click the picture to
log in to their account. For instructions on how to add a picture to a login account, see
“Adding a Picture to a Login Account.”
In a situation where you want to share files freely with only some people who have
accounts on the system, you can create a user group. The system lets you grant read,
write, and execute permissions for a file or directory to three types of users: the file’s
owner, the members of a specific group of users, and all other users. Once you create a
user group, you can set the permissions on all or some of your files so other members of
your group can view or change them. For information about user groups, see “Managing
User Groups.”
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About User Login Accounts on the Network
In a large, networked environment, the network administrator maintains a list of user login
account information, and makes sure that no two people have the same user login name.
Before you create login accounts in such an environment, consult with the network
administrator.
Whenever you change account information about a person who has a login account on
more than one system on the network, the person’s account information is updated on
only one system; the information on other systems remains unchanged.
If your network uses the optional NIS network management software, the network
administrator maintains a master database of login account information on a special
system called the NIS master. Only the network administrator can change information on
the NIS master.
When you create a login account for a person whose account information is in the NIS
master database, the “Add a User Account” guide does the following:
•

It fills in the appropriate information with information from the NIS database. For
example, it fills in the user ID and the user’s Primary group. You can change this
information for any account, and the account’s owner can change some of their own
information. However, the changes apply to the local system only; it does not
change the information in the NIS database.

•

It marks the account as a network access account. This means the person can log in to
the system only when the network is working correctly and NIS is running.

If a person needs to log in to the system when it’s not connected to the network (for
example, if a person takes the system home for a period of time), you can convert the
account by using the instructions in “Converting Between a Network Access Account
and a Local Account.”
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Choosing Between a Network and Local Access Account
If your network use the optional NIS software, the network administrator maintains a
master list (located on a system on the network called the NIS master) of all users on the
network and their account information. When you create an account on your system, the
system automatically checks the NIS master to see if a user account with the same name
exists in the master list. If it does exist, you have the option of making the account a
network access or local (standalone) account. If it doesn’t exist, you can only make the
account a local (standalone) account.
When you create a network access account, that account’s information is stored in the
master list on the NIS master system. This means you can log into your account on your
system only when your system is connected to the network, and the NIS master system
is up and running.
When you create a local access account, your system finds your account information on
your own system. This means you can log in to the system regardless of whether it’s
connected to the network.
For more information, see “About User Login Accounts on the Network.”

Creating a User Login Account
You can use the “Add a User Account” guide to create a user login account for a person.
If your system is connected to a network, contact your network administrator for an
approved login name and user ID; see “About User Login Accounts on the Network.”
If the System Manager is not already open, start it by choosing “System Manager” from
the System toolchest. Select the category “Security and Access Control” and then click
“Add a User Account.” The guide leads you through the necessary steps to create a new
user login account.
After you create an account, an icon labeled with the user login name and other account
information appears in the User Manager window and, when you log out, the icon
appears on the login screen. The user can then log in to the account to use the system.
If you do not want this account to appear on the login screen, see “Improving System
Security.”
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Viewing User Login Account Information
You can view information about user login accounts in the User Manager.
1.

If the System Manager is not already open, start it by choosing “System Manager”
from the System toolchest.

2. Select the category Security and Access Control
3. Click “User Manager.”
4. Select the name of a user account and then click the Get Info button.
A User Account Info window appears and displays the user’s login name, the
user’s full name, account type, password status, user ID, primary group, home
directory, and default shell program.

Modifying a User Login Account
You can modify an existing user login account. Click a topic for more information.
•

“Modifying Account Information”

•

“Adding a Picture to a Login Account”

•

“Creating, Changing, and Deleting Passwords”

•

“Converting Between a Network Access Account and a Local Account”

Modifying Account Information
You can change system account information only for the system on which you are running
the “Modify a User Account” guide.
If the System Manager is not already running, open it by choosing “System Manager”
from the System toolchest. Select the Security and Access Control category and then click
“Modify a User Account.” The guide leads you through the necessary steps to modify a
user account.

110

Modifying a User Login Account

Adding a Picture to a Login Account
When you add a picture to a user’s login account, the picture appears in the login screen
and the user can double-click it to log into the system.
Follow these steps to add a picture to an account:
1.

Ask the user to store a photo in a file on the system by either of these methods:
•

Use the Capture tool to take the picture (if the system has an IndyCam). To use
the tool, click the word Capture, and use its online help. (Clicking the word
does not start the tool unless the tool is already installed on your system.)

•

Scan in an image on a system that has a scanner. Save the image in a Silicon
Graphics Image file format.

2. Give the file the same name as the user’s login name. For example, if the user’s login
name is “Mary” and she gives you a file named mary.rgb, rename the file mary.
3. Drag the file into the /usr/local/lib/faces directory.
Note: If /usr/local/lib/faces is not a local directory (that is, if it is an NFS mounted

directory), startup time will be noticeably slower for applications that use the photo.

Creating, Changing, and Deleting Passwords
You can create, change, or delete a user account’s password. Any user can change the
password on his or her own account. The root password is required to change the
password on the root account.
To check if a user account has a password, you can open its User Account Info window.
Click “User Manager” in the righthand column of the System Manager window; you
may need to select the “Security and Access Control” category first. In the User Manager,
select the user account and click the Get Info button. (You can also double-click the user
account.) The User Account Info window for that account appears. If the account does
not have a password, you see the word “No” next to “Password Set.” If the account has
a password, you see the word “Yes.”
To create, change, or delete a password on an existing account, use the “Modify Any
Account Password” guide. If you want to create, change, or delete the password for your
own account, use the “Modify My Account Password” guide; the guide automatically
selects your account to modify. You can access both of these guides from the “Common
Tasks” field in a User Account Info window.
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Converting Between a Network Access Account and a Local
Account
When you create a login account, you specify whether it should be a local (standalone) or
network access account. At a later time, you may decide you want to convert the account
from a network access account to a local account, or vice versa. For example, you may
have set up a user login account on a system before it was connected to the network or
before you installed and started running the optional NIS software.
Follow these steps to convert an account:
1.

Open the User Manager by selecting the Security and Access Control category in
the System Manager, and then clicking “User Manager” in the righthand column.

2. Select the name of a user account and click the Get Info button.
A User Account Info window appears and displays information about the user
account. Write down the user’s primary group and home directory, and then close
the User Account Info window.
3. Click Remove in the User Manager window.
The “Remove a User Account” guide appears and lets you remove the existing user
login account.
Caution: Make sure you do not delete the user’s files.
4. If you are converting a local account to a network access account, contact the
network administrator and give them the person’s full name and login name. The
network administrator will use this information to create a network access account
on the NIS master system.
5. Recreate the deleted account using the “Add a User Account” guide. Use the same
login name as before, just choose a different type of account (local or network
access). Make sure that you use the user’s previous home directory and that you
leave the user ID alone.
The person can now log into the converted account. Remember that if the account is a
network access account, the user can log in only when the system is connected to the
network and NIS is running.
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Deleting a User Login Account
When you delete a login account from your system, the person who owns that account
can no longer log in to your system. If the person has accounts on other systems, they can
still log in to those systems.
You can delete a login account using the “Remove a User Account” guide. If the System
Manager is not already running, open it by choosing “System Manager” from the System
toolchest. Select the “Security and Access Control” category from the Table of Contents
and then click “Remove a User Account.”

Managing User Groups
To create, change, and delete user groups, you must know the root password. Once the
group exists, group members can use the “Modify File Permissions” guide to change
permissions on their own files and directories to let other members of the group read or
edit the files. See “Understanding Permissions” in the Desktop User’s Guide for more
information.
A person can belong to several groups, but only one group on this system is the person’s
primary group. To specify a person’s primary group, see “Modifying Account
Information.”

Creating a User Group
You can create a new group by editing the file /etc/group.
Note: Do not change information for any of the special system groups that were on your

system when it was new (groups with ID numbers between 0 and 100 and over 900).
They are critical to system operation; changing them will make the system inoperable.
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To edit /etc/group, follow these steps:
1.

Log in as root through a shell window.
■

Choose “Open Unix Shell” from the Desktop toolchest.

■

Position your cursor within the new window and enter
login root

If a prompt for a password appears, type the password then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
2. Edit the file.
■

Open the file with a text editor such as jot by typing
jot /etc/group

Then press <Enter>. For detailed information on using the jot text editor,
choose a topic from its Help menu.
After the last line in the file, you’ll add a line that specifies the name and ID
number of the new group. The entries that you see have this form:
<group name>:<password>:<group ID #>:<members>

The password and list of members is optional. See “User Account
Administration” in IRIX Admin: System Configuration and Operation for
information on how and why to add these.
■

Create a name for your group that consists of eight or fewer lowercase letters
and does not match any of the group names that you see in this file. Then
choose a group ID number between 101 and 899 that does not match any of the
group IDs in this file. For example, to create a group named drafting with an ID
number of 105, add this line:
drafting::105:

■
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Save your changes and quit jot.
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3. Log out of the root account by typing
logout

Then press <Enter>. The shell window disappears.
You now have a new group that has no members. To assign users to this group, see
“Adding Users to a Group.”
See “Changing Permissions” in the Desktop User’s Guide for information on changing file
permissions so that members of a specific group can read or edit the files.

Adding Users to a Group
The Administrator typically adds users to or deletes users from a group. When you
delete a user from a group, you do not delete that person’s login account. The person no
longer belongs to the group, and cannot access files that other group members have
marked as accessible by group members.
Note: Do not assign a user to any of the special system groups that were on your system

when it was new (groups with ID numbers between 0 and 100 and over 900). They are
critical to system operation; assigning a regular user to the groups severely compromises
stable operation.
Usually a user can belong to only one group. For information on assigning users to
multiple groups, see “User Account Administration” in the IRIX Admin: System
Configuration and Operation.
You can assign a user to a new group and make it the user’s primary group by using the
“Modify a User Account” guide.
To assign a user to a new group, follow these steps:
1.

Open the “Modify a User Account” guide.
If the System Manager is not already running, open it by choosing “System
Manager” from the System toolchest. Select the Security and Access Control
category and then click “Modify a User Account.”

2. Choose the name of the user account whose user ID you want to change.
3. On page 7 of the guide, enter the new user ID.
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4. On page 8 of the guide, assign a new primary group to the user account.
5. Click OK on the last page of the guide to implement the new user ID.
6. Ask the user whose group ID you changed to log out, then log back in.
When they log in, new files and directories that they create are labeled with the new
group name.
The user whose group ID number you changed now has read and execute permissions on
all files created by members of the new group (unless a group member changes
permissions on individual files). See “Changing Permissions” in the Desktop User’s Guide
to give members of the same group write permissions (the ability to change each other’s
files), or to remove read or execute permissions.

Deleting a User Group
When the Administrator deletes a group from your system, the group is no longer
available for membership. This means people who used to belong to the group still have
active user login accounts, but they are no longer members of a common group.
To delete a group, follow these steps:
1.

Assign to a new group all users who belong to the group that you are deleting. See
“Adding Users to a Group.”

2. Log in as root through a shell window.
■

Choose “Open Unix Shell” from the Desktop toolchest.

■

Position your cursor within the new window and type
login root

Then press <Enter>.
If a prompt for a password appears, type the password then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
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3. Edit the /etc/group file.
■

Open the file with a text editor such as jot by typing
jot /etc/group

Then press <Enter>. For detailed information on using the jot text editor,
choose a topic from its Help menu.
■

Find the line that describes the group you want to delete. The entries that you
see have this form:
<group name>:<password>:<group ID #>:<members>

■

Remove the line.

■

Save your changes and quit jot.

4. Log out of the root account by typing
logout

Then press <Enter>. The shell window disappears.
5. Ask all users who previously belonged to the group to log out, then log back in.
When they log in, new files and directories that they create are labeled with the
name of the new group to which you assigned them. For more information, see
“Understanding Permissions” in the Desktop User’s Guide.
The group no longer exists. To create a new group, see “Creating a User Group.”
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Your system comes standard with a system disk that contains the IRIX operating system
and hundreds of megabytes of unused disk space. As you add new user login accounts,
the system creates new directories on this disk for each person. And as you add new
application software, the Software Manager creates the appropriate files and directories
to support it. The files and directories contained on the disk are referred to collectively as
a filesystem. Over time, you may find that your filesystem will begin to approach the
capacity of your disk.
This chapter gives you some possible ways to address this situation by showing you how
to manage your local disk drives, filesystems, and removable media devices.
Click a topic for more information:
•

“Overview of the Disk Manager”

•

“Overview of the Filesystem Manager”

•

“Setting Up a New Hard Disk”

•

“Verifying and Initializing Filesystems on a Hard Disk”

•

“Creating Logical Volumes”

•

“Removing a Disk”

•

“Freeing Disk Space”

•

“Taking Advantage of a Second Disk”

•

“Using Disk Space on Other Systems”

•

“Overview of the Swap Manager”

•

“Overview of the Removable Media Manager”
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Overview of the Disk Manager
The Disk Manager provides information about all disk drives connected to your system,
including the drive address number and the total size of the disk (in megabytes or
gigabytes). The Disk Manager does not provide information about removable media
devices such as CD-ROM, floppy, floptical, tape, and SyQuest drives; see “About the
Menus.”
To open the Disk Manager, select the Hardware and Devices category in the System
Manager window and then click “Disk Manager.”
To view more detailed information about a disk, you can select a disk in the Disk
Manager window and click the Get Info button. The Disk Panel for that disk appears and
displays the following information:
•

The drive’s type (SCSI or VSCSI), its drive address number, its drive controller number
and type, and its size (in megabytes or gigabytes); see also “About SCSI Devices,
Controllers, and Addresses.”

•

The number of partitions on the disk, and the free space that is available on each
partition with a filesystem.
Note: Many disks have only one partition (only one file folder appears below the

picture of the disk). If you have more than one partition, each one is allotted a certain
portion of the disk space.
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•

Whether the disk (or partition) is accessible (is mounted) or inaccessible (is
unmounted).

•

The icon for the disk. You can drag it onto the desktop for easy access to the data on
the disk. You can also drag it into drop pockets in various guides that let you act on
the disk.

•

Several guides that you can use to manage the disk, available in the “Common
Tasks” field.

Overview of the Disk Manager

About the Menus
The Task menu contains these choices:
•

“Initialize a Disk” opens the “Initialize a Disk” guide, which erases all the data on a
filesystem to clean up fragmentation. See “Verifying and Initializing Filesystems on
a Hard Disk” for more information.

•

“Verify a Disk” opens the “Verify a Disk” guide, which erases all data on the disk
and isolate bad blocks so they will not be used. See “Verifying and Initializing
Filesystems on a Hard Disk” for more information.

•

“Mount Disk’s Filesystem” opens the “Mount a Local Filesystem” guide, which lets
you make a hard disk available to your system. See “Setting Up a New Hard Disk”
for more information.

•

“Unmount Disk’s Filesystem” opens the “Unmount a Local Filesytem” guide,
which lets you notify the system that you no longer need to access the filesystem
located on a disk. See “Removing a Disk” for more information.

•

“Create Striped Logical Volume” opens the “Create a Striped Logical Volume”
guide. See “Creating Logical Volumes” for more information.

•

“Create Extended Logical Volume” opens the “Create an Extended Logical Volume”
guide. See “Creating Logical Volumes” for more information.

•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Disk Manager window. Any changes you made using the guides
are saved. This command is equivalent to the Close button.

The Arrange menu contains this choice:
•

“By Name” displays the disks alphabetically according to their names.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.
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Overview of the Filesystem Manager
The Filesystem Manager provides information about all available filesystems, the
directory on your system where you can access a filesystem (its mount point), and the
amount of space (in megabytes) available.
To open the Filesystem Manager, select the Files and Data category in the System
Manager window and then click “Filesystem Manager.”
You can use the Get Info button to display detailed information about a selected
filesystem. Just select the name of the filesystem in the window and click the Get Info
button. A Filesystem Panel appears and displays the type of filesystem, its capacity (in
megabytes), its free space (in megabytes), how full it is (percentage), whether or not it is
mounted, and a couple of related guides that you may want to use.

About the Menus
The Task menu contains these choices:
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•

“Mount Remote” opens the “Mount a Remote Filesystem” guide, which lets you
access a filesystem located on a remote workstation over the network. This
command is equivalent to the Mount Remote button. See “Using the “Mount a
Remote Filesystem” Guide” for more information.

•

“Unmount” opens the “Unmount a Filesystem” guide, which lets you notify the
system that you no longer want to access a local or remote filesystem. This
command is equivalent to the Unmount button. See “Removing Access to
(Unmounting) Remote Directories” and “Removing a Disk” for more information.

•

“Mount Local” opens the “Mount a Local Filesystem” guide, which lets you make a
filesystem located on a local hard disk available to your system. This command is
equivalent to the Mount Local button.

•

“Mount Macintosh or PC” opens the “Mount a Macintosh or PC Filesystem” guide,
which lets you access a remote filesystem located on a Macintosh computer or PC
on the network. This command is equivalent to the Mount PC button. See
“Accessing a Remote Filesystem on a Macintosh or PC” for more information.

•

“Set Space Monitoring” opens the “Set Filesystem Space Monitoring” guide, which
lets you change how the system alerts you when it is running about of filesystem
space. See “Monitoring Disk Space and Setting a Warning Level” for more
information.

Overview of the Filesystem Manager

•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Filesystem Manager window. Any changes you made using the
guides are saved. This command is equivalent to the Close button.

The Arrange menu contains this choice:
•

“By Name” lets you display the filesystems alphabetically according to their names.

•

“By Mount Point” lets you display the filesystems alphabetically according to their
mount points (the directory located on your system where you access the contents of
the filesystem).

The Help menu contains a list of help topics. To view a topic, choose it from this menu.

Monitoring Disk Space and Setting a Warning Level
The Filesystem Manager displays a list of the existing filesystems on your system, the
local directories where you can access them (mount points), and the current amount of
space that’s still available for use. When you first start the Filesystem Manager, it checks
the disk space and gives you up-to-the-second information. If you keep the Filesystem
Manager window open, the system updates these numbers continuously.
If the Filesystem Manager is not running, start it by choosing “Filesystem Manager” from
the System toolchest. You can also access it from within the System Manager. (Open the
System Manager, select the Files and Data category, and then click “Filesystem
Manager.”)
By default, the system warns you when your filesystem is 98% full. The “Set Filesystem
Space Monitoring” guide lets you change this threshold for a particular filesystem or for
all filesystems on your system. It also allows you to customize the way in which your
system notifies you when a filesystem is running low on space.
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To open the guide, use one of these methods:
•

Choose “Set Space Monitoring” from the Task menu in the Filesystem Manager
window.

•

Choose “System Manager” from the System toolchest, select the Files and Data
category, and then click “Set Filesystem Space Monitoring.”

The “Set Filesystem Space Monitoring” guide appears and leads you through the
necessary steps.
To increase the amount of available disk space, see “Freeing Disk Space.” If you have a
second disk and you would like to free space on your system disk, see “Taking
Advantage of a Second Disk.”

Setting Up a New Hard Disk
When you physically connect a new hard disk, you use the “Mount a Local Filesystem”
guide to mount the filesystem located on the disk. By mounting the filesystem, you
inform your system that a new disk is available. In addition, you determine the directory
(mount point) on your system that you want to use to access that new disk.
After you connect the new disk, open the “Mount a Local Filesystem” guide using one of
these methods:
•

If the System Manager is not running, start it by choosing “System Manager” from
the System toolchest. Select the Files and Data category and then click “Mount a
Local Filesystem.”

•

Choose “Filesystem Manager” from the System toolchest. Select the new disk in the
window and then click the Mount Local button.

The “Mount a Local Filesystem” guide leads you through the steps necessary to mount
the filesystem located on the new hard disk.
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Verifying and Initializing Filesystems on a Hard Disk
You may find the need at some point to verify or initialize a filesystem on a disk. The
System Manager provides the following guides, available in the Hardware and Devices
category. (You cannot use these guides on a system disk.)
•

The “Verify a Disk” guide erases all data on the disk and isolates bad blocks so they
can not be used.

•

The “Initialize a Disk” guide erases all the data on a filesystem and cleans up
fragmentation.

Both of these guides collect all usable space on a disk and puts it in a single filesystem.
Note: If you have an extra system disk that you want to format as an option disk, change

its physical drive address number to a free address other than 1, install it in a system that
already has a system disk, and then use the “Initialize a Disk” guide.
Caution: Both the “Initialize a Disk” and “Verify a Disk” guides destroy all data on the
disk or filesystem that you select. If the data is important, back it up onto another system
or onto a tape (see “Backing Up Files”) before you use one of the guides.

Creating Logical Volumes
If you have more than one fixed (hard) disk drive, you can create a logical volume. In effect,
creating a logical volume lets you make one large disk out of several smaller ones. In
doing so, you can increase your system’s efficiency as it reads and writes files to disk. You
can also use a logical volume to provide storage for a new filesystem or to allow an
existing filesystem to grow onto a newly added disk.
You can create several different types of logical volumes; this section describes how to
create a striped logical volume and an extendable logical volume. For more information
about logical volumes, see IRIX Admin: Disks and Filesystems , which is provided online.
Note: The following guides only supports the use of logical volumes created using “xlv.”

See IRIX Admin: Disks and Filesystems for more information.
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Creating a Striped Logical Volume
To open the “Create a Striped Logical Volume” guide, open the System Manager if it is
not already running. Select the Hardware and Devices category and then click “Create a
Striped Logical Volume.” The guide appears and leads you through the necessary steps.
Caution: Creating a striped logical volume erases all the contents of the disks being used
for the logical volume. If you want to keep any of the files and directories on the disks
you’re selecting, make sure you back them up first. See “Backing Up and Restoring” for
instructions.

Creating an Extendable Logical Volume
To open the “Create an Extendable Logical Volume” guide, open the System Manager if
it is not already running. Select the Hardware and Devices category and then click
“Create an Extendable Logical Volume.” The guide appears and leads you through the
necessary steps.
Caution: Creating an extendable logical volume erases all the contents of the disks being
used for the logical volume. If you want to keep any of the files and directories on the
disks you’re selecting, make sure you back them up first. See “Backing Up and
Restoring” for instructions.

Removing a Logical Volume
If you have an existing logical volume and you decide you want to use its disks for other
purposes, you can use the “Remove a Logical Volume” guide to delete the logical
volume.
Caution: Removing a logical volume erases all the contents of the disks being used for
the logical volume. If you want to keep any of the files and directories on the logical
volume, make sure you back them up first. See “Backing Up and Restoring” for
instructions.
To open the guide, open the System Manager, if it is not already running. Select the
Hardware and Devices category and then click “Remove a Logical Volume.” The guide
appears and leads you through the necessary steps.
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Removing a Disk
The “Remove a Disk” guide outlines the steps necessary for physically removing a hard
disk drive from your system. It lists the filesystems that you need to unmount, the swap
space that you need to remove, and the logical volumes (which are using the disk) that
need to be removed. It also provides access to the guides that you’ll use to accomplish
these tasks: “Unmount a Filesystem,” “Remove Swap Space,” and “Remove a Logical
Volume.”
Note: If you do not unmount the necessary filesystem(s) before removing the disk, you

will not compromise any data, but your system may start up more slowly as it spends
time looking for missing filesystems.
To open the “Remove a Disk” guide, use one of these methods:
•

Choose System Manager from the System toolchest. Select the Hardware and
Devices category and then click “Remove a Disk.”

•

Choose System Manager from the System toolchest. Select the Hardware and
Devices category and then click “Disk Manager.” Select the disk that you want to
remove and choose “Remove” from the Task menu.

If you ever reconnect the drive, you’ll need to use the “Mount a Local Filesystem” guide
to mount its filesystem again.

Freeing Disk Space
You can regain used disk space in several ways:
1.

Empty your dumpster by choosing “Empty Dumpster” from the Desktop toolchest.

2. Remove or archive old or large files or directories.
•

To find old or large files, click the the words Search tool to start the Search tool,
then use its online help.
It’s a good idea to search for files named core; these are often very large, and are
created by an application when it encounters a problem.

•

If you remove files from the desktop, empty your dumpster again.

•

To archive (back up) files, use the “Back Up Files” guide. You can access it in the
Files and Data category in the System Manager.
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3. If your system disk is almost full, check the following:
•

/var/tmp and /tmp: These public directories often become full; delete unwanted
files or directories that you find here.

•

/var/adm/SYSLOG: If this file seems very large (over 200 KB), remove all but the
last few lines of it; do not remove the entire file.

•

/var/adm/crash: When the system has a serious failure, it places information into
two files: vmcore.<number> and unix.<number>. If you find files with these
names, back them up so you can give the files to your local support
organization, then remove the files from your system.
If you remove files from the desktop, empty your dumpster again.

•

mbox in all home directories: If these files are large, ask the owners to delete all
but critical mail messages.

4. Remove optional or application software; see “Removing Installed Software.”

Taking Advantage of a Second Disk
Over time, your disk may not be large enough to hold the operating system, the software
applications, and the personal data created by all the people who use the system. In this
case, it’s a good idea to add a second disk drive (see “Setting Up a New Hard Disk”).
When you add a second disk, the system suggests that you name it /disk2. This creates a
new, empty filesystem that has the same storage capacity as the new disk. If you added
a 500 MB disk, you can store 500 MB of information in /disk2. Adding this disk, however,
does not automatically increase the capacity of the system disk. Unless you explicitly
store some personal data files or some applications in /disk2, you will continue to run out
of disk space.
This section offers two options for effectively using a second disk:
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•

“Storing Home Directories on a Second Disk”

•

“Storing Applications or Support Files on a Second Disk”

Taking Advantage of a Second Disk

Storing Home Directories on a Second Disk
Typical users store most data files in their home directory, so you can usually free
substantial space on your system disk by moving home directories to your second disk. To
do this, you must first move the home directory, then change the name of the home
directory to match the new pathname of the directory.
The example below moves user joe’s home directory from /usr/people/joe to the second
disk, /disk2. To find out where the second disk is mounted, open the Filesystem Manager
(available in the Files and Data category in the System Manager). In the Filesystem
Manager window, select the disk and click the Get Info button. A Filesystem Panel
appears and displays the mount point for the disk; this is the directory where you can
access the files located on the disk.
Caution: The steps below move all files and preserve permissions, but please proceed
carefully. Skipping a step or mistyping a command can cause you to lose data. If you are
unfamiliar with UNIX commands, you may want to contact an experienced UNIX
administrator for help.
Follow these steps to move home directories:
1.

Make sure the user(s) whose home directory you are going to move is not logged in.

2. Log out, and log in to the system as root.
3. Use the “Back Up Files” guide to back up all home directories that you plan to
move.
4. Open a shell window by choosing “Open Unix Shell” from the Desktop toolchest.
5. Move into the /usr/people directory and then create a copy of the files on /disk2 by
entering:
cd /usr/people
tar cBf - joe | (cd /disk2; tar xBf -)

The copy may take several minutes depending on how much data the directory
contains. The copy is complete when you see the system prompt (#). The full
pathname of the new directory is /disk2/joe.
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6. Make sure the copy worked.
•

Double-click the /disk2 directory icon on the desktop, and make sure the joe
directory is there.

•

Double-click the joe directory and make sure it is not empty.

•

Select a file or directory in the joe directory, choose “Permissions” from the
Selected toolchest, and then choose “Change Ownership” from the rollover
menu. In the Step 2 of the guide, make sure that “joe” appears as the owner.

•

Open several more directories to verify that the directory structure is intact.

•

When you have determined that the copy was successful, go on to the next step.

7. Remove the old directory and create a link from the old directory to the new (this
ensures that remote access via NFS continues to work). In the shell window, enter
cd /usr/people
rm -rf joe
ln -s ../../disk2/joe .

Be sure to include the period (.) at the end of the last command.
8. Open the “Modify a User Account” guide.
Choose “System Manager” from the System toolchest, select the Security and
Access Control category, and then click “Modify a User Account.”
9. In Step 2 of the guide, choose joe from the menu of user accounts (click the button at
the right of the field).
10. Use the Next button to go to Step 9 and type the new pathname in the Home directory
field, for example, /disk2/joe, then use the Next button to go to the end of the guide.
11. Click the OK button in the last step of the guide to record your changes.
Note: Be sure to do this for every user whose home directory you moved.

The next time the user logs in, the user will find all of their existing files and directories
available in their home directory.
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Storing Applications or Support Files on a Second Disk
Many applications have accompanying support files or data libraries that can take up
many megabytes of disk space. If an application has a particularly large directory of these
types of files, you may want to move that directory to the second disk.
The application knows the full pathname of its supporting directories, so you cannot
simply move the directories onto the second disk. You need to first move the directory,
then make a linked copy of the directory and give that linked copy the full pathname that
the application recognizes.
A good example of such an application is IRIS InSight™, the online document library
viewer. All of the books that IRIS Insight accesses reside in the /usr/share/Insight directory.
If you have many books installed, you may have up to 100 MB of data stored in this
directory. The example below shows you how to move this directory onto your second
disk.
Caution: The steps below move all files and preserve permissions, but please proceed
carefully. Skipping a step or mistyping a command can cause you to lose data. If you are
unfamiliar with UNIX commands, you may want to contact an experienced UNIX
administrator for help.
Only the Administrator can move the support directories onto a second disk. For example,
to move the IRIS Insight support directories onto /disk2, follow these steps:
1.

Log out, and log in to the system as root.

2. Open a shell window by choosing “Open Unix Shell” from the Desktop toolchest.
3. Move into the /usr/share directory and create a copy of the files on /disk2 by entering
cd /usr/share
tar cBf - Insight | (cd /disk2; tar xBf -)

The copy may take several minutes depending on how much data the directory
contains. The copy is complete when you see the system prompt (#). The full
pathname of the new directory is /disk2/Insight.
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4. Make sure the copy worked.
•

Double-click the /disk2 directory, and make sure the Insight directory is there.

•

Double-click the Insight directory and make sure it is not empty.

•

Open several more directories to verify that the directory structure is intact.

•

When you’re comfortable that the copy was successful, go on to the next step.

5. Remove the old directory and create a link from the old directory to the new (this
ensures that remote access via NFS continues to work). In the shell window, enter
cd /usr/share
rm -rf Insight
ln -s ../../disk2/Insight .

Be sure to include the period (.) at the end of the last command.
The full pathname of the linked copy is now /usr/share/Insight, which is the original
name of the directory that you moved to your second disk. The application finds the
linked copy in the appropriate location, and can access all its support files.
For alternate ways to access IRIS InSight books, see “Accessing an IRIS Insight Document
Server” and “Using a CD as a Read-Only IRIS Insight Document Library.”

Using Disk Space on Other Systems
Depending on whether your system and the system whose space you want to access
have the optional NFS software installed and turned on (to check, see “Turning On NIS
and NFS”), you can use another system’s disk space in two ways:
•

With or without NFS, the Administrator on another workstation on the network can
add a login account for you. This lets you access that other workstation and store
files in your personal work area on that workstation.
After the login account is created on the other workstation, you can access it by
choosing “Access Files” from the Desktop toolchest, and then choosing “By Remote
Login” from the rollover menu. Enter the name of the remote workstation, your
login name (assigned by the Administrator of the remote workstation), the type of
view you want to open (desktop or toolchest), and the directory that you want to
access. For more information, see “Accessing Remote Files by Logging Into a
Remote System” in the Desktop User’s Guide.
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•

With NFS, a user on another system can mark an entire disk directory (filesystem)
or a particular directory public (see “Making Your Disk Space Available to Other
Users”); you can then access that directory from your system’s desktop as if it
resided on your own system’s disk.
You can use “Find Remote Resources” to access the remote directory. For
information, see “Accessing a Remote Filesystem Using Automount or Autofs.”
You can also the “Mount a Remote Filesystem” guide. For information, see “Using
the “Mount a Remote Filesystem” Guide.”

For more information about NFS, see “About NFS.”
For more information about sharing directories and accessing remote directories, see
Chapter 9, “Sharing and Protecting Files,” and Chapter 10, “Accessing Remote
Resources,” in the Desktop User’s Guide.

About NFS
If you have NFS installed and turned on (to check, see “Turning On NIS and NFS”), you
can access remote directories using either of these two methods:
•

NFS includes automount and autofs, which let a user drag a public directory onto the
desktop for access. It minimizes the traffic on your network, as NFS contacts the
other system only when you are actively working in the directory. See “Accessing a
Remote Filesystem Using Automount or Autofs.”

•

With a manual mount, you can select a specific location within your own filesystem
from which you want to access the remote directory. See “Using the “Mount a
Remote Filesystem” Guide.”
When you no longer need the mount, you can remove the mount point; see
“Removing Access to (Unmounting) Remote Directories.”
See also “Accessing an IRIS Insight Document Server” for information on creating a
permanent mount point that lets you access online documents that are available on
a server system.
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For more information, click a topic:
•

“Accessing a Remote Filesystem Using Automount or Autofs”

•

“Using the “Mount a Remote Filesystem” Guide”

•

“Removing Access to (Unmounting) Remote Directories”

•

“Accessing a Remote Filesystem on a Macintosh or PC”

•

“Accessing an IRIS Insight Document Server”

Accessing a Remote Filesystem Using Automount or Autofs
You can use automount (or autofs) only if you have the optional NFS software installed
and turned on; to check, see “Turning On NIS and NFS.” If you are unfamiliar with NFS,
see “About NFS.”
To place a public directory from another system onto your desktop, follow these steps:
1.

Choose “Shared Resources” from the Desktop toolchest and then choose “On a
Remote Workstation” from the rollover menu. The Find Remote Resources window
appears. (Or, you can select the Network and Connectivity category in the System
Manager and then click “Find Remote Resources.”)

2. In field at the top of the window, enter the name of the workstation whose resources
you want to access. Lists of the public directories, media, and printers appear.
3. Drag the directory that you want to use from the Directory column onto your
desktop. You can now use the directory just as you use other directories on your
system.
Note: If you cannot drag the directory or peripheral onto your desktop, see

“Troubleshooting Shared Resources Problems.”
4. When you no longer need the directory, select it, and choose “Remove” from the
Selected toolchest. This removes the directory from your desktop.
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Using the “Mount a Remote Filesystem” Guide
You can use the “Mount a Remote Filesystem” guide to access a remote directory. The
guide only works if your system and the other systems you want to access have the
optional NFS software installed and turned on; to check, see “Turning On NIS and NFS.”
If you are unfamiliar with NFS, see “About NFS.” If you want to access a NetWare or
AppleShare filesystem, see the “Accessing a Remote Filesystem on a Macintosh or PC.”
If the System Manager is not already running, start it by choosing “System Manager”
from the System toolchest. Select the Network and Connectivity category and then click
“Mount a Remote Filesystem.” The guide appears and leads you through the necessary
steps.

Accessing a Remote Filesystem on a Macintosh or PC
You can use the “Mount a Macintosh or PC Filesystem” guide to access filesystems
located on a Macintosh computer or PC on the network. Before you open the guide,
check to make sure the following conditions have been met. (You may need to consult
your network administrator.)
•

Your system has the necessary AppleShare (appletalk) or NetWare (netwr_client)
software installed.

•

The system you want to access has the necessary AppleShare and NetWare software
installed and is connected to the network.

•

Your system is connected to a network running either the AppleTalk protocol (for
AppleShare) or the ipx protocol (for NetWare).

•

You have a user login account and password on the system running NetWare that
you want to access.

If the System Manager is not already running, start it by choosing “System Manager”
from the System toolchest. Select the Network and Connectivity category and then click
“Mount a Macintosh or PC Filesystem.” The guide appears and leads you through the
necessary steps.
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Removing Access to (Unmounting) Remote Directories
You can use the “Unmount a Filesystem” guide to unmount a remote directory or
filesystem, making it unavailable to all users on the system.
Note: You cannot use the “Unmount a Filesystem” guide to unmount automounted

filesystems. The system automatically unmounts them after they haven’t been used for a
period of time.
If the System Manager is not already running, start it by choosing “System Manager”
from the System toolchest. Select the Network and Connectivity category and then click
“Unmount a Filesystem.” The guide appears and leads you through the necessary steps.
To mount the filesystem or directory again, see “Using the “Mount a Remote Filesystem”
Guide.”

Accessing an IRIS Insight Document Server
Many sites set up a server system that contains online books (and online help) so you can
seamlessly access the books as if they resided on your own system. If your site has such
a document server, and your system has NFS installed (to check, see “Turning On NIS
and NFS”), you can free up some of your own disk space by removing some of your
books and can set up your system to access the books on the server.
Note: When accessing the IRIS Insight library over the network, the online books and

help will not work as quickly as they would if they were installed on your own system.
If you plan to use online help as well as online books, see “About Online Help” before
accessing the server. Otherwise, see “Setting Up Access to the Document Server.”
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About Online Help

Many of the standard desktop applications provide online help. The content of the help
comes directly from the online book for a particular application. For example, when you
choose a topic from the Help menu in a Directory View window, the help system reads
information from Desktop User’s Guide and displays it in a help window.
The help system finds the correct help for each application using a set of files in the
/usr/share/help directory. Because of this dependency, if you plan to use online help, all
books that the help system accesses must be installed in the same location: either on your
system, on the server system, or on a CD (see “Using a CD as a Read-Only IRIS Insight
Document Library.”) For fastest access to the online help, keep all help books installed on
your system on on a mounted disk (see also “Storing Applications or Support Files on a
Second Disk”).
To find the complete list of books that contain help and are currently installed on your
system, follow these steps:
1.

Choose “Open Unix Shell” from the Desktop toolchest.

2. Position your cursor in the shell window and enter
versions | grep books | grep Help

You see the full list of books that contain help.
3. To close the shell window, enter
logout

You can type this same command on the server system to find the books that contain
help.
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Setting Up Access to the Document Server

To set up your system to access the document server, the Administrator of your system
should follow these steps:
1.

Contact the Administrator of the document server system or your network
administrator for this information:
•

A list of the books that are available on the server.

•

The name of the server system.

•

The full pathname of the directory on the server system (the exported filesystem
or directory) that contains the books.
Often this directory is /usr/share/Insight/library/SGI_bookshelves.

•

The full pathname of the directory on the server that contains the help files.
You need this only if you plan to access books that contain online help (see
“About Online Help”). Often this directory is /usr/share/help.

•

The full pathname of the directory on your system (the local mount point) from
which you will access the directory that contains the books; and, if you’re using
online help, the directory from which you will access the directory on the server
that contains the help files.
If the directory on the server that contains the books is
/usr/share/Insight/library/SGI_bookshelves, your local mount point will be
/usr/share/Insight/library/server_bookshelf. If the directory that contains the help
files is /usr/share/help, your local mount point will be /usr/share/help.

2. Compare the list of books you have installed on your system to the list of books
available from the server to make sure the server has the same or newer versions.
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■

If you plan to use online help, find which books on your system and on the
server system contain help; see “About Online Help.” All the books that contain
help must be installed in the same location: either on your system or on the
server.

■

On the server system, choose “Online Books” from the Help menu.

■

In the InSight viewer window, open each book (by double-clicking it) that you
want to access, and check its version number and publication date by choosing
“Product Info” from the Help menu.

■

On your own system, check the version of your books in the same way.
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3. Remove any books that are currently installed on your system that you would
rather access from the server.
■

Start the Software Manager by choosing Software Manager from the System
toolchest, or by clicking the words Software Manager now.

■

Click the Manage Installed Software button. After several seconds or minutes, the
list of installed software appears in the Software Inventory pane.

■

Choose “Find and Mark” from the Selected menu.

■

In the Find and Mark window, click in the Find field and enter
books

■

Click the Search button; once all matches are found, use the Search and Previous
buttons to move through the matches, and use the Mark button to mark for
removal the books you plan to access from the server.
Click the Help button in the Find and Mark window for more information.

■

When all appropriate books are marked for removal, click the Close button in
the Find and Mark window, then click the Start button in the Software Manager
window.
For more information, see “Removing Installed Software.”

■

When all the books have been removed, choose “Quit” from the File menu in
the Software Manager window.

4. Open the “Mount a Network File System” guide by clicking it in the Network and
Connectivity category in the System Manager.
5. In Step 3 of the guide, enter the name of the server system in the Remote Workstation
field.
6. In the Remote Filesystem field, enter the name of the directory that contains the
books.
7. In Step 4, enter the directory on your system that you want to use as your local
mount point for the books.
8. In Step 5, give yourself “Read Only” permissions.
9. In Step 6, apply your settings and quit the guide by clicking the OK button.
10. Choose “Online Books” from the Help toolchest, and follow the instructions in the
IRIS InSight Help menu to open and use the books.
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If you have trouble viewing the books, try these techniques:
•

Make sure the remote directories are mounted correctly by opening the Filesystem
Manager (accessible from the Network and Connectivity category in the System
Manager) and checking for the remote directories that contain the books and help. If
they are not there, try mounting them again.

•

Physically go to the server system and try to run IRIS Insight from there. If it does
not run, there is a problem with the server. If it does run, ask the Administrator of
the server system or your network administrator to check the setup on your system.

For alternate ways to access IRIS InSight books, see “Using a CD as a Read-Only IRIS
Insight Document Library” and “Storing Applications or Support Files on a Second
Disk.”

Making Your Disk Space Available to Other Users
If you have the optional NFS software installed and turned on (to check, see “Turning On
NIS and NFS”), you can let people who are logged in to other systems on the network
access specific directories on your system from their local desktops. This is called sharing
a directory, and it essentially means you are sharing your disk space.
You need to perform two separate tasks to share a directory.
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•

Use the “Make File(s) Public” guide to make the directory that you want to share
accessible to other users. To open the guide, choose System Manager from the
System toolchest, select the Security and Access Control category, and then click
“Make File(s) Public.” The guide appears and leads you through the necessary
steps.

•

Use the “Share a Directory” guide to share the directory with other users on the
network. To open the guide, choose System Manager from the System toolchest,
select the Security and Access Control category, and then click “Share a Directory.”
The guide appears and leads you through the necessary steps.

Overview of the Swap Manager

To stop sharing a directory, use the “Stop Sharing a Directory” guide, available in the
Security and Access Control category in the System Manager.
You can also access the “Share a Directory” and “Unshare a Directory” guides from the
Shared Resources Manager, available in the Security and Access Control category in the
System Manager. For more information, see Chapter 9, “Sharing and Protecting Files,” in
the Desktop User’s Guide.

Overview of the Swap Manager
The Swap Manager lets you view information about existing swap on your system, as
well as providing access to the swap guides.
Note: You must be familiar with the terms and concepts of swap space use in order to

understand the information in the Swap Manager window. If you are unfamiliar with
swap space, see “Understanding Swap Space.”
To open the Swap Manager, choose “System Manager” from the System toolchest (if it’s
not already running). Select the System Performance category to display the Swap
Manager.
The Swap Manager window displays the following information about a particular swap
space entry:
•

Location shows the pathname of the swap file.

•

Priority shows the priority; the system uses the swap space that has the highest
priority (lowest number in this column) first. The default swap file, /dev/swap,
always has highest priority.

•

Physical shows whether the swap space is logical or virtual; if it’s logical swap
space, the size of the swap file is shown here. If it’s virtual swap space, this column
contains zeros.

•

Virtual shows whether the swap space is logical or virtual; if it’s logical swap space,
this column contains zeros. If it’s virtual swap space, the size that the system believes
the swap file to be is shown here (even though the actual file is empty).

•

Free shows the amount of the total space of each swap area that’s available for use.
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You can use the Get Info button to display detailed information about a swap entry. Select
a swap entry in the Swap Manager window and click Get Info. A Swap Panel window
appears and displays information about the selected entry.
Click a topic for more information:
•

“Understanding Swap Space”

•

“Adding Real Swap Space”

•

“Adding Virtual Swap Space”

•

“Deleting Swap Space”

About the Menus
The Task menu contains these choices:
•

“Add Real Swap” opens the “Add Real Swap Space” guide, which lets you create
real (logical) swap space on your system. This command is equivalent to the Add
button. See “Adding Real Swap Space” for more information.

•

“Add Virtual Swap” opens the “Add Virtual Swap Space” guide, which lets you
create virtual swap space on your system. See “Adding Virtual Swap Space” for
more information.

•

“Remove a Swap Entry” opens the “Delete an Element of Swap Space” guide,
which lets you remove either virtual or real swap space from your system. This
command is equivalent to the Remove button. See “Deleting Swap Space” for more
information.

•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Swap Manager window. Any changes you made using the guides
are saved. This command is equivalent to the Close button.

The Arrange menu contains this choice:
•

“By Name” lets you display the swap entries alphabetically according to their
names.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.
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Understanding Swap Space
Each time you start an application, it communicates to the system that it needs a certain
amount of memory in order to run. The system then reserves the amount of physical
memory (RAM) that the application requires. If the application needs more memory than
is available in RAM, the system then uses a portion of your disk as supplemental
memory. This portion of your disk (the file) is known as swap space.
Once the system reserves the required memory (RAM plus swap space), the space is no
longer available for use by other applications. If you regularly run an application that
requires more memory than the system provides by default (the amount of physical
RAM plus the default 40 MB /dev/swap file), or if you run several large applications at
once, you may need to add more swap space.
When you are nearly out of swap space, applications run very slowly; when you are
completely out of space, the system may stop an application or UNIX process from
running to avoid a system crash. The system notifies you that you need more swap space
in three ways:
•

The System Monitor warns you when you are almost out of swap space, and warns
you again when you are completely out of space.

•

The Console window displays an “Out of logical swap space” message when you
have run out of swap space.

•

The system adds information to the /var/adm/SYSLOG file each time you run out of
swap space.

You can add one or both of the following types of swap space:
•

Logical swap space is actual disk space that the system uses as if it were memory
(RAM). By default, your system allocates 40 MB of your disk in the /dev/swap file.
The only disadvantage to adding logical swap space is that it creates a file that
consumes a portion of your disk space. To add swap space by creating a file on your
system, see “Adding Real Swap Space.”
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•

Virtual swap space is a file that the system considers to be a certain size (for
example, 40MB) but actually occupies no disk space. This is useful because many
programs request much more swap space than they really need in order to run, and
tie up the real swap space unnecessarily. When you add virtual swap space, the
system lets you start applications even when they request more swap space than is
actually available. In most cases this is fine, because there is enough real swap space
for them to run.
The advantage of virtual swap space is that it does not consume any disk space. The
disadvantage is that the system can let you start an application when there isn’t
enough real swap space available for it to run.
For example, say you have 40 MB of logical swap space and 40 MB of virtual swap
space. The system considers your total swap space to be 80 MB. You start app1,
which requests 30 MB but uses only 15 MB; then you start app2, which requests
40 MB but uses only 20 MB. Your system runs correctly because app1 and app2 are
using a total of 35 MB of logical swap space, even though they requested a total of
70 MB.
Now you perform a memory-intensive operation in app1, and it needs its
maximum amount of swap space (30 MB). Your system cannot complete the
operation because app1 needs 30 MB and app2 needs 20 MB of real swap space (50
MB total), and the system actually has only 40 MB of real swap space available. In
this case, the system runs out of real swap space, it arbitrarily stops an application
or UNIX process from running, and you may lose data.
To add virtual swap space, see “Adding Virtual Swap Space.”

Adding Real Swap Space
When you add real (logical) swap space, you increase the amount of real swap space
available to your system by the size of the swap file. For example, when you add 50 MB
of swap space, a 50 MB file is created for the system to use as swap space. At the same
time, the amount of disk space available for data storage is reduced by the size of the file.
For more information, see “Understanding Swap Space.”
To add real swap space, open the System Manager if it isn’t already open. Select the
System Performance category and then click “Add Real Swap Space.” The guide takes
you through the necessary steps.
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Adding Virtual Swap Space
When you add virtual swap space, you create a file that the system considers to be a certain
size (for example, 40MB) but actually occupies a very small amount of disk space. In this
way you virtually increase the amount of available swap space. This lets you run more
applications at the same time, but may cause you to run out of logical swap space and
potentially lose data. For more information, see “Understanding Swap Space.”
To add virtual swap space, open the System Manager if it isn’t already open. Select the
System Performance category and then click “Add Virtual Swap Space.” The guide takes
you through the necessary steps.

Deleting Swap Space
You can use the “Remove Swap Space” guide to delete virtual swap space and logical swap
space that you created using the Swap Manager. You cannot use it to delete the default
logical swap space (the /dev/swap file) or to delete the virtual swap space created with the
chkconfig command (/.swap.virtual). When you delete logical swap space (a swap file), you
regain disk space; for example, when you delete 40 MB of logical swap space, you regain
40 MB of disk space.
If the System Manager is not already running, start it by choosing “System Manager”
from the System toolchest. Select the System Performance category and then click
“Remove Swap Space.” The guide takes you through the necessary steps.
You can also access the guide by selecting a swap entry in the Swap Manager window
and clicking the Remove button.

145

Chapter 6: Managing Disks and Filesystems

Overview of the Removable Media Manager
The Removable Media Manager displays information about the removable media
devices connected to your system. It also provides access to the removable media guides,
which let you format floppy or floptical disks, eject disks, and share your removable
media devices with other users on the network. A removable media device is a storage
device, such as a tape drive or floppy disk drive, from which you can remove the
medium upon which the data is actually stored.
To open the Removable Media Manager, choose System Manager from the System
toolchest, select the Hardware and Devices category, and then click “Removable Media
Manager.”
You can use the Get Info button to display detailed information about a selected device.
Select a device in the Removable Media Manager window and click Get Info. A
Removable Media Panel appears and displays the name of the device, the workstation it
is attached to, the type of device, the type of media, and where you can access it (mount
point).
Click a topic for more information:
•

“Connecting a New Removable Media Drive”

•

“Sharing a Removable Media Device”

•

“Ejecting a Removable Media Disk”

•

“Formatting Floppy and Floptical Disks”

•

“Using Disk Space on CDs and Floppy Disks”

About the Menus
The Task menu contains these choices:
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•

“Eject” lets you eject a disk from the selected removable media device. This
command is equivalent to the Eject button. See “Ejecting a Removable Media Disk”
for more information.

•

“Format” opens the “Format Removable Media” guide, which lets you create a
Macintosh, PC, or UNIX (EFS) filesystem on a floppy, floptical, Zip, or Jaz disk. This
command is equivalent to the Format button. See “Formatting Floppy and Floptical
Disks” for more information.
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•

“Share” opens the “Share a Removable Media Device” guide, which lets you share a
removable media device with other users on the network. This command is
equivalent to the Share button. See “Sharing a Removable Media Device” for more
information.

•

“Stop Sharing” opens the “Stop Sharing a Removable Media Device” guide, which
lets you prevent other users on the network to access a removable media device.
This command is equivalent to the Unshare button. See “Stop Sharing a Removable
Media Device” for more information.

•

“Monitor” opens the “Monitor Removable Media” guide, which lets you instruct
the system to monitor the selected device to see if media has been inserted into the
device.

•

“Stop Monitoring” opens the “Stop Monitoring Removable Media” guide, which
lets you instruct the system to stop monitoring the selected device to see if media
has been inserted into it.

•

“Schedule Backup” opens the “Back Up Files” guide, which lets you perform a
backup (after completing the guide) or schedule a backup for a later date. The guide
lets you choose between performing a full system backup or selecting specific files
or directories to back up. See “Backing Up Files” for more information.

•

“Restore Files” opens the “Restore Files From Backup” guide, which lets you restore
files to your system from a previous backup. See “Restoring Files From a Backup”
for more information.

•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Removable Media Manager window. Any changes you made
using the guides are saved. This command is equivalent to the Close button.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.

Connecting a New Removable Media Drive
When you physically connect a new tape, CD-ROM, floppy, floptical, SyQuest, Jaz, or Zip
disk drive, the system automatically mounts the drive so it is ready to use the next time
you start the system (for details on each mount point, see “Setting Up SCSI Peripherals”).
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Monitoring a Removable Media Device
You can instruct your system to monitor a removable media device (attached to your
workstation) to check whether media has been inserted.
To monitor a device, follow these steps:
1.

Open the Removable Media Manager, if it isn’t already open.

2. Select a device.
3. Choose “Monitor” from the Task menu.
The “Monitor a Removable Media Device” guide appears; follow the instructions in
the guide.
Stop Monitoring a Removable Media Device

To tell your system to stop monitoring a device, follow these steps:
1.

Open the Removable Media Manager, if it isn’t already open.

2. Select a device.
3. Choose “Stop Monitoring” from the Task menu.
The “Stop Monitoring a Removable Media Device” guide appears; follow the
instructions in the guide.

Sharing a Removable Media Device
You can share a removable media device attached to your workstation with other users
on the network. You may want to do this to let other users take advantage of the extra
storage provided by the device.
To open the “Share a Removable Media Device” guide, use one of these methods:
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•

Open the Removable Media Manager, if it isn’t already open, select a device, and
click the Share button.

•

Open the System Manager, if it isn’t already open. Select the “Hardware and
Devices” category and click “Share a Removable Media Device.”

Overview of the Removable Media Manager

Stop Sharing a Removable Media Device

When you stop sharing a device, users on the network no longer have access to the drive
or to the media that may be inserted in it.
To open the “Stop Sharing a Removable Media Device” guide, use one of these methods:
•

Open the Removable Media Manager, if it isn’t already open, select a device, and
click the Unshare button.

•

Open the System Manager, if it isn’t already open. Select the Hardware and Devices
category and click “Stop Sharing a Removable Media Device.”

Ejecting a Removable Media Disk
You typically remove a floppy, floptical, SyQuest, or CD-ROM disc by selecting the drive
icon and choosing “Eject” from the Selected toolchest. If the icon doesn’t appear on your
desk, you can choose “Eject Media” from the Desktop toolchest. You can also eject a disk
from the Removable Media Manager window by selecting the disk in the window and
clicking the Eject button.
Caution: The manufacturer does not recommend ejecting removable media using the
hardware eject button on the device; you may lose data if the removable media is
writeable.

Formatting Floppy and Floptical Disks
When you format a new floppy or floptical disk or change its existing formatting
information, you remove all data from that disk. The format window lets you create PC,
Macintosh, or UNIX (EFS) disks.
Note: Files that you plan to copy onto PC disks must follow DOS naming conventions;

they can contain no more than eight characters, a period (.), and a three-character
extension (for example, projects.exe uses the maximum filename length). If your file
names are too long, or are in an incorrect format, you will not be able to copy files onto
the floppy or floptical disk. You will see an error message that reports an “I/O Error.”
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To use a disk that you have previously formatted, insert the disk in your drive and
double-click the drive’s icon to access the disk. You can then freely copy files back and
forth between your system and the disk. To eject the disk, select the drive’s icon and
choose “Eject” from the Selected toolchest.
Note: The floppy drive cannot read or format 800 KB Macintosh diskettes. It can both

read and format 720 KB diskettes.
To format a disk, use one of these methods:
•

Open the Removable Media Manager, if it isn’t already open, and click the Format
button. A guide appears and takes you through the necessary steps.

•

Open the Removable Media Manager, if it isn’t already open. Insert the disk into the
drive, click the icon to select it, and then, when the Desktop Access icon in the
Removable Media Manager changes to show that it contains the disk, click the
Format button. A guide appears and takes you through the necessary steps.

You can now access the formatted disk by double-clicking the drive icon on your desktop
or in the Removable Media Manager window.
If you ever experience problems with the system not recognizing floppy or floptical
disks, or not allowing you to write to them, see “Troubleshooting Problems With
Removable Media.”

Using Disk Space on CDs and Floppy Disks
This section describes how to use CDs and floppy (or floptical) disks in two ways:
•

“Using Removable Media to Transfer and Store Information”

•

“Using a CD as a Read-Only IRIS Insight Document Library”

Using Removable Media to Transfer and Store Information

You can view the data on CDs or floppy disks by inserting the media into a drive, then
double-clicking the desktop icon that corresponds to the drive. When the media contains
standard directories and files, this opens a standard Directory View window. When you
double-click a CD drive icon whose CD contains a distribution directory, the Software
Manager starts.
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You can copy information to and from a writable floppy disk by dragging icons between
Directory View windows (see also “Copying Files to and From a Floppy Disk” in the
Desktop User’s Guide). You can copy information from a CD onto your system by dragging
files from its Directory View window to another Directory View window.
You can use the same desktop methods to view and copy files between your system and
CD and floppy drives that are connected to other systems on the network. To locate and
access remote CD or floppy drives, follow these steps:
1.

Choose “Shared Resources” from the Desktop toolchest and then choose “On a
Remote Workstation” from the rollover menu.
The Find Remote Resources window appears.

2. Enter the name of the remote workstation that has the CD and floppy drives you
want to access.
3. Icons for all the available resources on the remote workstation appear in the
window, including CD and floppy drives.
4. Drag the icon(s) for the drive(s) that you want to use onto your desktop.
Using a CD as a Read-Only IRIS Insight Document Library

CDs are very useful for storing large amounts of information that you want to access but
do not want to change. The manufacturer of your system uses CDs to distribute software
products and associated IRIS InSight libraries of online books.
You typically use the CD one time to install software; you may want to use the library of
books daily. You could install all the books on your system’s disk(s) for convenient
access, or you could install a few, frequently-used books on your disk and set up your
system so it can access the remaining books directly from the CD.
Each product CD that has associated online books stores those books in the directory
named insight. Once you set up your system, you can access the books on any product
CD by inserting the CD in the drive, then choosing “Online Books” from the Help
toolchest. As long as the CD is in the drive, the books are accessible.
Note: The manufacturer recommends keeping the standard end-user books installed on

your system, because the online help system accesses those books to provide
context-sensitive help for each tool; see also “About Online Help.”
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The example in this section assumes that you have one CD drive, and that it’s mounted
at /CDROM (for more information on the mount point, see “Setting Up SCSI
Peripherals”). Follow these steps to set up the system to access the books on a CD:
1.

Log out, and log in to the root account.

2. Insert the CD into the drive.
3. Double-click the root (/) folder on the desktop to see its Directory View window,
then double-click the /usr folder. You should now have two open Directory View
windows, one for / and one for /usr.
4. In the / Directory View window, edit the pathname (text entry) field so it reads
/CDROM/insight

5. In the /usr Directory View window, edit the pathname (text entry) field so it reads
/usr/share/Insight

Now the two Directory View window show the contents of /CDROM/insight and
/usr/share/Insight.
6. Press and continue to hold down the <Ctrl> and <Shift> keys, then drag the
SGI_bookshelves folder icon from the /CDROM/insight Directory View window into
the /usr/share/Insight Directory View window. After dragging the icon, release the
<Ctrl> and <Shift> keys.
7. In the /usr/share/Insight Directory View window, rename the SGI_bookshelves folder
CD_bookshelf.
8. Drag the CD_bookshelf folder onto the library folder that is also in the
/usr/share/Insight Directory View window.
9. Choose “Online Books” from the Help toolchest. The IRIS Insight viewer shows the
same set of bookshelves that were there before you accessed the CD, but now the
bookshelves contain both the books that are installed on your disk and those that
are on the CD.
When you eject the CD, the books that are on the CD will not appear the next time
you start IRIS Insight.
When you insert another product CD that contains a different set of books, the new
books appear on the appropriate bookshelf the next time you start IRIS Insight.
For alternate ways to access IRIS InSight books, see “Accessing an IRIS Insight Document
Server” and “Storing Applications or Support Files on a Second Disk.”
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If you have books installed on your system that you can now access from the CD, you
may want to remove them from your system to free some disk space. Remember,
however, that the books are available to you only when the appropriate CD is in your
drive.
It’s best to keep the books you use most frequently, along with the standard end-user
books, installed on your system.
Note: If you decide to remove the standard end-user books, you will remove the book

you are now using. Please print out this section before you continue.
To remove the standard end user books and access both the books and their associated
online help from the CD, follow these steps:
1.

Log out, and log in to the root account.

2. Remove all the books that contain help.
■

Start the Software Manager by choosing Software Manager from the System
toolchest, or by clicking the words Software Manager.

■

Click the Manage Installed Software button. After several seconds or minutes, the
list of installed software appears in the Software Inventory pane.

■

Choose “Find and Mark” from the Selected menu.

■

In the Find and Mark window, remove the checkmark from the Ignore Case
check box, then click in the Find field and enter
Help

■

Click the Search button; once all matches are found, click the Mark Matches
button to mark for removal all books that contain help.
Click the Help button in the Find and Mark window for more information.

■

When all appropriate books are marked for removal, click the Close button in
the Find and Mark window.

■

In the Software Manager window, the Conflicts button is active; click this button.

■

In the Conflicts window, specify that you do not want to remove
insight.sw.sgihelp; the window closes automatically after you resolve all
conflicts.
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■

Click the Start button in the Software Manager window.
For more information, see “Removing Installed Software.”

■

When all the books have been removed, choose “Quit” from the File menu in
the Software Manager window.

3. Insert the standard system software CD into the drive.
4. When the CD drive icon shows the inserted CD, double-click it to see a Directory
View window that shows the contents of the CD (/CDROM).
5. Open the / directory on your desktop to see its Directory View window, then edit
the pathname (text entry) field so it reads
/usr/share

You should now have two open Directory View windows: one shows the contents
of /CDROM, and the other shows /usr/share.
6. In the /usr/share Directory View window, select the help folder, and choose
“Remove” from the Selected menu.
7. Press and continue to hold down the <Ctrl> and <Shift> keys, then drag the help
folder icon from the /CDROM Directory View window into the /usr/share Directory
View window. After dragging the icon, release the <Ctrl> and <Shift> keys.
The /usr/share Directory View window now contains a folder named help, which is a
linked copy of the directory on the CD.
8. Try the online help by choosing a help topic from the Help menu in the /usr/share
Directory View window.
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7. Maintaining the System

This chapter contains these sections:
•

“Managing System Information”

•

“Setting System Administration Privileges”

•

“Improving System Security”

•

“Backing Up and Restoring”

•

“Shutting Down or Restarting the System”

Managing System Information
This section describes how to use the System Manager to manage system information. It
covers these topics:
•

“Overview of the System Manager”

•

“Checking the Hardware Configuration”

•

“Checking the Software Configuration”

•

“Monitoring System Activity”

•

“Setting the Time and Date”

Overview of the System Manager
The System Manager window on your system provides access to the System
Administration interactive guides described throughout this book. It also provides
information about your system’s hardware and software configuration, and lets you
monitor your system’s activity. For more information, see “Using the System Manager’s
Interactive Guides.”
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You can also access System Manager windows for other systems on the network to view
their system information, to access their shared resources, and to log in. For information,
see the Desktop User’s Guide.

Checking the Hardware Configuration
You use the “About This System” item in the lefthand column of the System Manager
window to check your system’s hardware configuration. The “About This System”
window displays the following information:
•

workstation name

•

model

•

serial number

•

IP address

•

processor speed

•

operating system

•

main memory

•

caches (if present)

The window also includes items that you can click to find out additional information
about the system’s hardware configuration.
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•

“Audio” displays the type of audio hardware installed on the system.

•

“CPU” displays the type, speed, and version of your system’s central processing
unit (CPU). If you have more than one CPU, the “CPU” choice has a rollover menu
that lists all CPUs.

•

“Graphics” displays the type of graphics hardware installed on the system.

•

“Video” displays the type of video hardware installed on the system.

•

“SCSI” displays a list of all the valid SCSI addresses on the system and the devices
using those address.

Managing System Information

Checking Disk Information

You can view information about disks connected to your workstation using the Disk
Manager. Choose System Manager from the System toolchest, select the Hardware and
Devices category, and then click “Disk Manager.” A window appears and displays
information about the disks currently mounted on your system. For more detailed
information about a disk, select it in the window and click the Get Info button.
Checking Removable Media Device Information

To find out information about removable media devices on your system, such as tape,
CD-ROM, floppy, floptical, or SyQuest drives, use the Removable Media Manager, also
available in the Hardware and Devices category in the System Manager. To view
information about a specific device, select it in the Removable Media Manager window,
and click the Get Info button.
About SCSI Devices, Controllers, and Addresses

You can connect several Small Computer System Interface (SCSI) devices, such as hard
disks, tape drives, floppy drives, and printers, to your system. Your system has at least
one SCSI controller (an internal board that sends data to and from the devices). The SCSI
controller to which your system disk is connected has an ID number of 0. Each SCSI
controller can support up to seven devices.
The instructions that come with each SCSI device show you how to physically set its
address; your system’s owner’s guide shows you how to connect the device to the SCSI
port, and how to daisy-chain several SCSI devices together.
To check the available SCSI addresses, click “SCSI” in the “About This System” window.
(To open the window, choose System Manager from the System toolchest and click
“About This System.”) You can find out the type, controller, and address of each SCSI
device that is connected to the system.
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Checking the Software Configuration
To view a list of all installed software products, select the Software category in the System
Manager window and then click “List Installed Products.” A guide appears and lets you
open the Software Manager. The Software Manager automatically displays the products
currently installed on the system.
You can use the Software Manager to remove an existing product or to install a new
product. See “Installing Software” for more information.

Monitoring System Activity
The System Manager provides several graphical tools that display the changing activity
levels of your system. Select the System Performance category. You see the following
items:
•

View the System Log
The System Log is where information about important events that occur on the
system are recorded. These include messages about system errors and possible
security problems.

•

View the System Administration Log
The System Administration Log is where actions taken on the system, as well as
warning and error messages, are recorded.

•

Set System Admin Log Options
This guide lets you set preferences for how information is recorded and displayed
in the System Administration Log.
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Setting the Time and Date
Once you set the date and time, the system can accurately stamp the time of events, such
as when you last changed a file. On most networks, the current date and time are
periodically provided to all workstations on the network.
You set the date and time with the IRIX date command, which has this format:
date [mmddhhmm[yy]]

mm specifies the month, dd the day, hh the hour, and mm the minutes. You can also specify
the last two digits of a year (yy). For more information and options, see the date reference
(man) page.
To set the date and time, follow these steps:
1.

Log in as root through a shell window.
■

Choose “Open Unix Shell” from the Desktop toolchest.

■

Position your cursor within the new window and type
login root

Then press <Enter>.
If a prompt for a password appears, type the password and press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
2. Check the current time and date of the system by typing
date

Then press <Enter>.
3. Specify the date and time. For example, if today is March 17 (0317) at 2:30 p.m.
(1430) in the year 1992 (92), type
date 0317143092

Then press <Enter>.
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4. To check the date and time, type
date

Then press <Enter>. You see a line similar to this:
Tue Mar 17 14:30 1992

5. Log out of the root account by typing
logout

Then press <Enter>. The shell window disappears.

Setting System Administration Privileges
The Privilege Manager and related guides let you, as the Administrator of your system,
determine whether other users on the system will be able to perform system
administration tasks. You do this by enabling privileges on your system and then
assigning privileges, either all of them or selected ones, to individual users. You can also
delete privileges for individual users or disable privileges for the entire system (this
prevents any user but the Administrator from performing system administration tasks).
Note: If the root account on your system does not have a password, privileges are

enabled by default. This means that any user on the system can perform system
administration tasks.
To open the Privilege Manager, choose System Manager from the System toolchest, select
the Security and Access Control category, and then click “Privilege Manager.”

About Default Privileges
By enabling privileges on your system, you assign a set of default privileges to all the
users on the system. These default privileges allow users to view information about the
system.
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Overview of the Privilege Manager
When you open the Privilege Manager, you see the currently assigned privileges on the
system. (If the window is empty, it means that the root account does not have a password
or that you haven’t enabled privileges on the system.)
The Task menu contains these choices:
•

“Grant Privileges to a User” opens the “Grant Privileges to a User” guide, which
allows you to assign all or selected privileges to individual users. This command is
equivalent to the Grant button. See “Granting Privileges to Users” for information.

•

“Revoke Privileges from a User” lets you remove selected privileges from
individual users. This command is equivalent to the Revoke button. See “Revoking
Privileges from Users” for information.

•

“Enable Use of Granted Privileges” allows you to enable users who have bee
granted privileges to use them. This command is equivalent to the Enable button.
See “Enabling Privileges” for information.

•

“Disable Use of Granted Privileges” lets you prevent users from using privileges
that they may have previously been granted. The command prevents any user
except the Administrator from performing system administration tasks. This
command is equivalent to the Disable button. See “Disabling Privileges” for
information.

•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Privilege Manager window. Any changes you made using the
guides are saved. This command is equivalent to the Close button.
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The View menu contains these choices:
•

“By User” lists the privileges for each user account on the system. It also lists the
privileges available to all users on the system; see “About Default Privileges” for
more information.

•

“By Privilege” lists each privilege available on the system and then includes the
names of the users on the system who have been assigned the privilege. It also lists
whether a privilege is a default privilege and thus automatically assigned to every
user on the system; see “About Default Privileges” for more information.

•

“By Task” lists privileges according to the individual tasks that require them. For
example, to use the “Add an Outgoing PPP Connection” task, a user must be
assigned the “Add Outgoing PPP” and “Test PPP Outgoing Existence” privileges.

Note: Be aware that some tasks have more than privilege associated with them. If you

want to allow a user to perform a specific task, you must assign the user all the necessary
privileges associated with that task. To view the privileges for each task, choose “By
Task” from the View menu.
The View menu also includes the following options for viewing privileges:
•

“Hide Users With No Privileges” means that only user accounts that have been
assigned privileges appear in the Privilege Manager window. This includes “All
Users,” which is used to display the default privileges.

•

“Hide Unused Privileges” displays default privileges and those privileges that have
explicitly been assigned to a user or users. It does not display other privileges that
haven’t otherwise been assigned (either by default or explicitly).

•

“Hide Default Privileges” shows only the privileges that have explicitly been
assigned to a specific user. It does not show any of the default privileges that are
automatically assigned to other users when you enable privileges.

•

“Use Descriptive Privilege Labels” lists the tasks and privileges by their descriptive
names.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.
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Granting Privileges to Users
You can give individual users the ability to perform specific system administration tasks
by using the “Grant Privileges to a User” guide. For example, you may want the user
“joe” to be able to add a modem to the system and create an outgoing PPP connection.
To allow “joe” to perform these tasks, you use the “Grant Privileges to a User” guide and
grant privileges on a task basis, selecting “Add a Modem” and “Add an Outgoing PPP
Connection” on the appropriate page in the guide.
You can open the “Grant Privileges to a User” guide using one of these methods:
•

Choose System Manager from the System toolchest. Select the Security and Access
Control category and click “Privilege Manager.” In the Privilege Manager window,
click the Grant button. The guide appears and leads you through the necessary
steps.

•

Choose System Manager from the System toolchest. Select the Security and Access
Control category and click “Grant Privileges to a User.” The guide appears and
leads you through the necessary steps.

Revoking Privileges from Users
You can revoke privileges that you previously assigned to a user by using the “Revoke
Privileges from a User” guide.
You can open the “Revoke Privileges from a User” guide using one of these methods:
•

Choose System Manager from the System toolchest. Select the Security and Access
Control category and click “Privilege Manager.” In the Privilege Manager window,
click the Revoke button. The guide appears and leads you through the necessary
steps.

•

Choose System Manager from the System toolchest. Select the Security and Access
Control category and click “Revoke Privileges from a User.” The guide appears and
leads you through the necessary steps.
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Enabling Privileges
You can open the “Enable Use of Granted Privileges” guide using one of these methods:
•

Choose System Manager from the System toolchest. Select the Security and Access
Control category and click “Privilege Manager.” In the Privilege Manager window,
click the Enable button. The guide appears and leads you through the necessary
steps.

•

Choose System Manager from the System toolchest. Select the Security and Access
Control category and click “Enable Use of Granted Privileges.” The guide appears
and leads you through the necessary steps.

Disabling Privileges
You can open the “Disable Use of Granted Privileges” guide using one of these methods:
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•

Choose System Manager from the System toolchest. Select the Security and Access
Control category and click “Privilege Manager.” In the Privilege Manager window,
click the Disable button. The guide appears and leads you through the necessary
steps.

•

Choose System Manager from the System toolchest. Select the Security and Access
Control category and click “Disable Use of Granted Privileges.” The guide appears
and leads you through the necessary steps.

Improving System Security

Improving System Security
The System Manager provides several options to help you, as the Administrator for your
system, improve the system’s security. In general, improving security means controlling
and limiting access to the system by other users, including local users or users on remote
systems on the network.
The “Improve System Security” guide lets you make the following settings:
•

Assign a password to the root account, if it doesn’t already have one.
The most important method for improving security is creating a password for the
root account. If the root account does not have a password, any person can log in to
the root account and deliberately or accidently destroy files or directories that are
essential for the system to operate.
Note: Make sure you remember the root password. The system does not provide a

way to log into the root account without its password.
•

Assign passwords to each active user account on the system or lock unused
accounts to prevent unauthorized people from logging in.
For active user accounts (accounts that people are currently using), you can either
consult each user to find out their preferred password or simply assign them a
password and then let them change it later using the “Modify My Account
Password” guide (available in the User Manager). For user accounts that aren’t
currently being used, you can lock them to prevent unauthorized people from
trying to use the accounts to log in to the system.

•

Disable Java or JavaScript for each user account, including the root account.
Java and JavaScript are commonly used programs that support certain features of
the World Wide Web. When you use a browser to visit a Web site, your system can
download and run a Java program without you being aware of it. Once on your
system, the program has access to and can corrupt your files and directories. By
disabling Java and JavaScript for a user account, you prevent this type of access.
Note: If the root account on the system does not have a password, your system is

particularly vulnerable to Java and JavaScript programs. Make sure you either assign
a password to the root account or disable Java and JavaScript for the root account.
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•

Disable logins to NIS accounts.
When you create a user account on the system, you have the option of creating a
network access account if the system is connected to a network and if NIS is being
used on that network. (See “Creating a User Login Account.”) Users on the network
can use those NIS accounts to log in to your system if NIS is turned on. If you want
to limit access to your system to local users only, you can disable logins to NIS
accounts.

•

Use shadow passwords.
When you create passwords for user accounts on the system, the system encrypts
the passwords and places them in a special file. Any user on the system can view
the file and see the encrypted passwords. This gives a user the opportunity to
possibly decipher the passwords, thereby gaining unauthorized access to another
user’s account. To prevent any user but root from viewing the password file, you
can have the system use a shadow password file.

•

Require passwords at login.
By requiring passwords, you can ensure that unauthorized people can’t gain access
to the system using an open user account. An open user account is an account that is
neither locked nor has a password assigned to it. (As a rule, it’s a good idea to either
lock an account or assign a password to it.)

•

Disable the Visual Login Screen.
When you start up your workstation, by default you see a login screen with the
names of all the user accounts on the system. (You may also see photographs
representing user accounts, depending on how users customize their accounts.) By
displaying information about the users, the login screen may provide information
that unauthorized people can use to gain access to one or more of the user accounts.
To prevent this from happening, you can disable the Visual Login Screen.

•

Disable privileged users.
The Privilege Manager, available in the System Manager, allows the Administrator to
assign selected privileges, normally assigned only to the root user, to other users on
the system. Depending on the privileges assigned, these other users may be able to
affect essential operations of the system. To prevent this from happening, you can
disable privileged users from being able to log in to the system.
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•

Protect new users’ files.
This setting means that when you create a new user account on the system, the
account’s files are protected from other users on the system. Other users can view
the account’s files but only the owner of the account can make changes to the files.

•

Disable remote display.
By disabling remote display, you prevent applications running on remote systems
from being able to display on your system’s screen.

•

Disable IP forwarding.
IP forwarding allows systems on a network to share information, such as hostnames
and IP addresses, about one another. Unauthorized people may be able to use this
information to breach the security of systems on the network. To prevent your
system from sharing information about itself with other systems, you can disable IP
forwarding.

To open the “Improve System Security” guide, open the System Manager (if it isn’t
already open), select the Security and Access Control category, and click “Improve
System Security.”

Backing Up and Restoring
This section contains the following information:
•

“Developing a Backup Strategy” explains how to make a schedule for regular
backups and describes how to select the right kind of tape on which to make your
backup.

•

“Overview of the Backup and Restore Manager” describes what each guide does,
how to start it, and explains how to use the guides to back up your system’s files.

•

“About Tape Formats and Capacities” describes the different available formats and
discusses compatibility issues.

•

“Backing Up Files” explains how to perform and schedule a backup of files on your
system.

•

“Restoring Files From a Backup” explains how to restore files to your system from a
previous backup.
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•

“Unscheduling a Backup” describes how to unschedule a previously created
backup.

•

“Using Other Tools to Back Up and Restore Files” describes other standard IRIX
tools for backing up and restoring information. It also explains how to use the IRIX
tar utility.

Developing a Backup Strategy
The first step toward ensuring the safety of your system’s information is to develop a
backup strategy. You should plan on performing incremental backups each day and
backing up the entire system at least once a week. See your network administrator to
coordinate your backup strategy with the overall scheme of network backups.
Note: Always make a new backup of the entire system after you work on user accounts,

add devices, or install new software. Only a full system backup can completely restore
your system in the event of a serious system software failure. If a system failure occurs,
customized system information will be lost.
Make sure all users agree to and are aware of the set time for the weekly backup. Try to
schedule it for a time when the system is not usually being used, such as early on
Monday morning or late Friday afternoon.
Always use at least two sets of backup tapes between which you alternate the weekly
backup. When you start a backup, the system copies this new information over the old,
which effectively deletes the old information. If you use last week’s backup tape to
perform this week’s backup, you run the risk of having a system failure when the tape
contains some combination of new and old information.
Finally, the tape drive is an option on the system. If you do not have a tape drive, you can
back up your system using the tape drive of another system that is part of your network.
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Overview of the Backup and Restore Manager
The Backup and Restore Manager provides access to several guides that you use in
combination to back up and restore the entire contents of a disk or selected directories and
files and onto a tape or disk. The tape can be located in either a local tape drive (one that
is physically connected to your system) or a remote tape drive (one that is physically
connected to another system on the network). The Backup and Restore Manager also
displays information about the backups that you create, including the name of the
backup, the location where the backed up files will be stored, the user who created the
backup, and when and how often the backup will be performed.
To open the Backup and Restore Manager, select the Files and Data category in the
System Manager and then click “Backup and Restore Manager. (To open the System
Manager, choose System Manager from the System toolchest or click the words “System
Manager.”)
You can use the Get Info button in the Backup and Restore Manager window to display
detailed information about a specific backup. Select the name of the backup in the
window and click Get Info. A Schedule Backup Info window appears and displays the
file(s) that are included in the backup, as well as other information about the backup.
About the Menus

The Task menu contains these choices:
•

“Schedule Backup” opens the “Back Up Files” guide, which lets you perform a
backup (after completing the guide) or schedule a backup for a later date. The guide
lets you choose between performing a full system backup or selecting specific files
or directories to back up. This command is equivalent to the Backup button. See
“Backing Up Files” for more information.

•

“Restore Files” opens the “Restore Files From Backup” guide, which lets you restore
files to your system from a previous backup. This command is equivalent to the
Restore button. See “Restoring Files From a Backup” for more information.

•

“Unschedule Backup” opens the “Unschedule a Backup” guide, which gives you
the opportunity to cancel a previously scheduled backup. This command is
equivalent to the Unschedule button. See “Unscheduling a Backup” for more
information.
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•

“System Manager” opens the System Manager window, which gives you access to
all of the system administration interactive guides.

•

“Close” closes the Backup and Restore Manager window. Any changes you made
using the guides are saved. This command is equivalent to the Close button.

The Help menu contains a list of help topics. To view a topic, choose it from this menu.
Note: As an alternative to the backup and restore guides, you may want to use a IRIX

utility called bru. For more information on bru, see “Using Other Tools to Back Up and
Restore Files.”

About Tape Formats and Capacities
Silicon Graphics supports a number of different 8mm and DLT drives, including the
8505XL and 2000XL drives, as well as several of the more high-end tape drives.
Third-party drives are not directly supported; see the file /var/sysgen/master.d/scsi for
information about configuring third-party drives.
When you purchase additional tapes, be sure to specify the type of drive you have. To
check which type you have, open the Removable Media Manager (available in the
Hardware and Devices category in the System Manager). See “About the Menus” for
more information.
You also insert and lock tapes into the drive differently depending on the type of drive.
See the installation guide included with the drive or your system owner’s guide for this
information.
Note: Silicon Graphics no longer ships QIC drives but it does still provide support for

them.
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Backing Up Files
You use the “Back Up Files” guide to back up files on your system. You can access the
guide in one of these ways:
•

In the System Manager, select the Files and Data category, and click “Back Up Files.”

•

In the System Manager, select the Files and Data category, click “Backup and
Restore Manager,” and then click the Backup button.

Before using the “Back Up Files” guide, you should consider the following issues:
•

•

Do you want to perform a full system backup or selected backup?
–

A full system backup requires the root password. For this reason, the
Administrator typically performs full system backups to back up all the files on
the system.

–

You do not need to know the root password to back up selected files and
directories that you own. If you try to back up files that you do not have
permission to view (read), the system won’t back up those files.

Do you want to perform the backup now, later, or on a recurring basis?
–

“Now” means that the system will begin backing up files when you click the
OK button on the last page of the guide.

–

“Later” means that the system will perform the backup at the time and date (in
the future) that you specify. You specify the date of the backup by selecting a
date some number of days in the future. For example, if the current date is July
25 and you want the backup to occur on July 30, then you would enter “5” in
the field labeled “Days from today.”

–

“Recurring” means that the system will regularly perform the backup on a
daily or weekly basis. For example, you can set the backup to occur every
Friday at 5:00 pm. Or, you can set the backup to occur every day at midnight.
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•

Where do you want to store the backed up files?
–

If you want to store the files on a tape, make sure that you have a tape drive
connected to your system or that you have access to a remote tape drive
connected to another system on the network.
Note: If an existing Ethernet network is available, follow the instructions in

“Setting Up Network Connections” to put your system on a network where you
can access a remote tape drive. If there is no network available, contact the
system’s manufacturer to order a tape drive for your system.
–

To store the files on a disk, make sure you have enough disk space available.
(You can use the Filesystem Manager to view available disk space.) You need to
specify the full path name of the file in which you want to store the backed up
files. For example, /usr/people/benjamin/backup.7.25.

Restoring Files From a Backup
If you accidentally remove a file or directory, or something goes wrong with the system,
you can restore your files and information from a backup tape or a backup file. (You can also
restore an old version of a file.) If you’re backing up from a tape, make sure you have the
most recent backup tape when you restore files. If you’re backing up from a file, make
sure you know the name and location of the file on your system.
If you do not have a local tape drive, you can restore files using a tape drive connected
to a remote system on the network. If possible, use the same remote tape drive to back up
and restore information. That way you’ll be sure the drive can read your backup tape.
(For more information on tape formats, see “About Tape Formats and Capacities.”)
Users can restore files that they own, but only the Administrator can restore an entire
system.
Caution: If you restore files to a directory in which files of the same name exist, the files
on the hard disk will be replaced with the files from the tape.
Note: In the event of a serious system failure, you may need to restore the entire

operating system. See your owner’s guide or IRIX Admin: Backup, Security, and
Accounting.
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To restore a file or filesystem, open the “Restore Files From Backup” guide, available in the
Files and Data category in the System Manager. A guide appears and leads you through
the necessary steps.
After you finish restoring your files from tape, remove your tape from the drive and store
it in a safe place.

Unscheduling a Backup
You may decide at some point that you don’t want the system to perform a backup that
you previously scheduled. To remove a backup from the list of scheduled backups, open
the “Unschedule a Backup” guide, available in the Files and Data category in the System
Manager. A guide appears and leads you through the necessary steps.
Once you unschedule a backup, it no longer appears in the Backup and Restore Manager.
If you want to back up the same files again, you need to use the “Back Up Files” guide to
create and schedule another backup.
Note: If the backup you want to unschedule was created by the Administrator, you must

have the necessary privileges or know the root password in order to unschedule it. For
information about privileges, see “Enabling Privileges.”

Using Other Tools to Back Up and Restore Files
IRIX provides several tools for backing up and restoring files. This section describes each
tool and shows you how to use tar, one of the most widely used tools.
The tools described in this section come standard on every system.
bru

bru (backup/restore utility) can back up and restore an entire filesystem
or individual directories and files. It can compress and decompress files,
find and back up files based on modification date, check space
requirements, and verify whether a backup was successful. See the
bru(1) reference (man) page for more information.

tar

tar (tape archiver) backs up specific files and directories. You can copy
files to tape, create tar files, compare files on tape to files on disk, read
standard input, and pipe the output of tar to other processes. See also
“About tar.” See the tar(1) reference (man) page for more information.
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cpio

Like tar, cpio (copy in/out) archives files and directories. With cpio you
can copy files to tapes or disks, archive empty directories, swap byte
order, create portable ASCII archives, and read from and write to
standard output. See the cpio(1) reference (man) page for more
information.

dump/restore

dump and restore are standard filesystem backup and restore utilities
available on most UNIX systems. dump makes incremental backups of
entire filesystems; restore retrieves files from archives created by dump.
restore can restore an entire filesystem or individual files and lets you
browse the contents of an archive and select specific files for restoration.
For more information, see the reference (man) pages for dump(1M) and
restore(1M).

About tar

tar is a very portable, general-purpose backup and restore tool. Most systems that run the
UNIX operating system support tar. This section gives you a brief introduction to using
the basic features of tar. For more information, see the reference (man) page for tar.
Only the owner of a directory or file can back it up with tar. You must be logged in as root
if you’re backing up files that belong to multiple users.
Copying Files to a Tape With tar

To copy files to a tape in a local or remote drive, follow these steps:
1.

Open a shell window by choosing “Open Unix Shell” from the Desktop toolchest.
To back up files that are owned by several different users, log in as root by typing:
login root

Then press <Enter>.
If a prompt for a password appears, type the password, then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
2. Make sure that a tape is in the tape drive. (See “About Tape Formats and Capacities”
to make sure you have the correct type of tape for your drive.)
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3. Run the tar command.
The command has this format:
tar options device pathname

options are letters that describe how you want to use tar; for example, c specifies
copy to tape, and v (for “verbose”) specifies that tar should list the files while
copying them. device is the name and location of the tape drive; you do not need to
specify the device when you’re copying to the default local drive. pathname is the
full pathname of a file or directory.
■

To copy the /usr/charts directory to a tape in a local drive and to view the
contents of the directory while it’s being copied, type
tar cv /usr/charts

Then press <Enter>. tar replaces any information on the tape with the contents
of the /usr/charts directory.
■

To copy the same directory to a tape in a remote drive, add the f option before
the tape device name (the device name consists of a login name, remote hostname,
and device file, which is usually /dev/tape). To copy /usr/charts to the tape drive
connected to the system mars through the guest account, type
tar cvf guest@mars:/dev/tape /usr/charts

Then press <Enter>.
Note: This example uses the guest account because it usually does not have an

associated password. If yours is a very secure environment, this account may
have a password. If so, work with the Administrator of the remote system or the
network administrator to set up an account through which you can access the
drive.
While tar copies the directory, you see a listing similar to this:
a
a
a
a

/usr/charts/north 83 blocks
/usr/charts/south 102 blocks
/usr/charts/east 124 blocks
/usr/charts/west 86 blocks

To stop the copy, press <Ctrl-C>. The copy is complete when you see the
system prompt.
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Viewing the Contents of a Tape Using tar

To view the contents of a tape created with tar, follow these steps:
1.

Open a shell window by choosing “Open Unix Shell” from the Desktop toolchest.

2. Insert the tape in the drive.
3. Position your cursor in the shell window and issue the tar command.
■

To list the contents of a tape in a local drive, type:
tar tv

Then press <Enter>.
■

To list the contents of a tape in a remote drive; for example, for the drive
connected to the system mars, type
tar tvf guest@mars:/dev/tape

Then press <Enter>.
rwxr-xr-x

dir

Feb 11 08:41 1992

/usr/charts

rwxr-xr-x

42004

Feb 11 08:41 1992

/usr/charts/north

rwxr-xr-x

51869

Feb 11 08:41 1992

/usr/charts/south

rwxr-xr-x

63217

Feb 11 08:41 1992

/usr/charts/east

rwxr-xr-x

43554

Feb 11 08:41 1992

/usr/charts/west

To stop the listing, press <Ctrl-C>. The listing is complete when you see the
system prompt.
Restoring Files From a Tape Using tar

To copy files onto your disk that you previously archived to tape using tar, follow these
steps:
1.

Open a shell window by choosing “Open Unix Shell” from the Desktop toolchest.
To restore files that are owned by several different users, log in as root by typing
login root

Then press <Enter>.
If a prompt for a password appears, type the password, then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
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2. Compare the contents of the directory to which you want to restore the files with the
contents of the tape.
Caution: If files on the tape have the same name as files in the directory to which
you are restoring files, the files on your hard disk will be replaced by the files on the
tape.
■

View the contents of the directory (for example, /usr/charts) by typing
ls -al /usr/charts

Then press <Enter>.
■

View the contents of the tape using the appropriate command from “Viewing
the Contents of a Tape Using tar.”

■

Look for files in the directory that have the same names as files on the tape. If
you do not want the files on the tape to replace those of the same name on your
hard disk, you may want to rename or move the files on the hard disk.

3. Position your cursor in the shell window and issue the tar command with the x (for
“extract”) option.
■

To restore the entire contents of a tape in a local drive to its original location on
your hard disk, type
tar xv

Then press <Enter>.
■

To restore a specific file or directory (for example, /usr/charts/north) from a tape
in a local drive to its original location on your hard disk, type
tar xv /usr/charts/north

Then press <Enter>.
■

To restore a specific file or directory (for example, /usr/charts/north) from a tape
in a local drive to a different location on your hard disk (for example, /usr/tmp),
type
cd /usr/tmp;tar xvR /usr/charts/north

Then press <Enter>. The name of this file is now /usr/tmp/usr/charts/north.
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■

To restore the entire contents of a tape in a remote drive (for example, the drive
connected to the system mars) to its original location on your hard disk, type
tar xvf guest@mars:/dev/tape

Then press <Enter>.
■

To restore a specific file or directory (for example, /usr/charts/north) to its
original location on your hard disk, type
tar xv guest@mars:/dev/tape /usr/charts/north

Then press <Enter>.
■

To restore a specific file or directory (for example, /usr/charts/north) from a tape
in a remote drive to a different location on your hard disk (for example,
/usr/tmp), type
cd /usr/tmp;tar xvR guest@mars:/dev/tape /usr/charts/north

Then press <Enter>. The name of this file is now /usr/tmp/usr/charts/north.
While tar restores the file(s), you see a listing similar to this:
x
x
x
x

/usr/charts/north, 42004 bytes, 83 blocks
/usr/charts/south, 51869 bytes, 102 blocks
/usr/charts/east, 63217 bytes, 124 blocks
/usr/charts/west, 43554 bytes, 86 blocks

The restoration is complete when you see the system prompt.
To stop the restoration, press <Ctrl-C>. For more information on the tar command
and its options, see the reference (man) page for tar.

Managing Processes
IRIX is a multi-tasking operating system. This means that your system can perform many
operations simultaneously. For example, you can run an application, print a file, and read
your mail at the same time, without having to wait for each operation to complete before
beginning the next one.
Every program that you run on the system is assigned a process ID that allows IRIX to
keep track of what it is doing. By identifying the process numbers assigned to tasks, you
can manage your operations more effectively.
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About Processes
When you are working at your system, the IRIX process that you are currently working
with, either from the keyboard or with the mouse, is known as the foreground process.
Any other IRIX processes running on the system are known as background processes.

Monitoring Processes
While many of the processes you are performing may be readily identifiable from your
desktop, many others, including printing and some complex graphics operations, may
be hidden from you. To identify quickly all the processes running on your system, you
can enter the IRIX ps (processor status) command in an IRIX shell.
To monitor processes, follow these steps:
1.

Choose “Open Unix Shell” from the Desktop toolchest.

2. Position your cursor within the shell window and type
ps -a

Then press <Enter>.
When you enter the ps -a command, IRIX lists a process ID number (PID), a terminal
ID (TTY), time, and name of each process that you started on your system; it does
not show all running processes. For example:
PID
7662
7668
7670

TTY
ttyq1
ttyq1
ttyq1

TIME
4:54
15:04
15:14

COMMAND
csh
ps
cedit

To check all running processes for a specific process, such as dmb, type
ps -ef | grep dmb

Additional parameters in the ps command line provide more comprehensive
listings. For more information on the command, see the man page for ps.
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Stopping Processes
Occasionally you may want to stop a process—for example, a PostScript® printing
process that measurably slows down system operations. In many cases, you can use an
application command to stop a process from the desktop. But in some instances, you
must stop the process from the shell by using the kill command. A regular user can use
the command to kill only his or her own processes; the Administrator can stop any process
running on the system.
Note: If a system process is stopped by the Administrator, the termination may cause the
system to hang or crash. Always save your current work before stopping a system
process as the Administrator.

To stop a process, follow these steps:
1.

Choose “Open Unix Shell” from the Desktop toolchest.
To stop a process started by the Administrator, or to stop processes started by
several different users, log in as root by typing
login root

Then press <Enter>.
If a prompt for a password appears, type the password, then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
2. Position your cursor within the new window and type
ps -ef

Then press <Enter>.
The listing provides a full listing, including the process ID (PID), of all processes
that are currently running. Find the one that you want to terminate.
3. Use the kill command with the PID as the parameter. For example, to kill process
number 754, type:
kill 754

Then press <Enter>.
Additional parameters in the kill command line provide variations on process
terminations. For example, the command kill -9 is a “sure-kill,” stopping almost any
type of process. For more information on the kill command, see the reference (man)
page for kill.
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Shutting Down or Restarting the System
Shutting Down the System
When you shut down the system, the IRIX operating system closes down all processes
and files in a specific order so that no information is lost. You should always close your
own files and stop running applications before you shut down the system.
To shut down the system, follow these steps:
1.

Choose “System Shutdown” from the System toolchest.

2. The “System Shutdown” guide appears with several options available, depending
on the type of workstation you have.
•

If your workstation does not have the ability to automatically power off, no
options appear in the notifier; click the OK button to continue the shutdown,
then turn off the workstation when you see the message that says the
workstation is ready to be powered off.

•

If your workstation can power off automatically, you can choose to have it do
so, and choose to have it automatically power on at a certain time. After you set
the options, click the OK button continue the shutdown.

Restarting the System
When you restart the system, the IRIX operating system closes down all processes and
files in a specific order so that no information is lost, then it restarts the system.
You should always close your own files and stop running applications before you restart
the system.
To restart the system, choose “Restart System” from the System toolchest.
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8. Troubleshooting

This chapter contains detailed troubleshooting information on these topics:
•

“Responding to System Monitor Warnings”

•

“Troubleshooting Disk Space Problems”

•

“Troubleshooting Problems With Removable Media”

•

“Troubleshooting Shared Resources Problems”

•

“Troubleshooting Network Errors”

•

“Troubleshooting Standard Printing Problems”

•

“Troubleshooting lpr Printing”

•

“Running Confidence Tests”

•

“Software Installation”

Responding to System Monitor Warnings
The System Monitor keeps track of system activity, and notifies you when a critical error
has occurred or is about to occur. It also provides online help that often gives you enough
information to solve the problem. Always respond to these messages as quickly as
possible to avoid losing valuable information.
To change the way the System Monitor notifies you of problems, you can use the “Set
Filesystem Space Monitoring” guide. See “Monitoring Disk Space and Setting a Warning
Level” for more information.
To get more detail on a particular message, you can view the System Log. Open the
System Manager (choose “System Manager” from the System toolchest), select the
System Performance category, and then click “View the System Log.”
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Troubleshooting Disk Space Problems
For information on managing and freeing disk space, see Chapter 6, “Managing Disks
and Filesystems.”

Troubleshooting Problems With Removable Media
When you insert a CD, tape, or disk (including floppy, floptical, SyQuest, Zip, Jaz, or
PCCard disk) into a drive, the drive’s icon should change to show that it recognizes the
new media.
If the icon doesn’t change within one minute of inserting the media, eject the media using
the hardware eject button, and insert it again. (The system sometimes takes up to 30
seconds to recognize tape media.) If the system still does not recognize the media, save
your work, and restart the system by choosing “Restart System” from the System
toolchest. After you log in, the system should show the inserted media.
If the floppy icon changes to generic drive icon, or if you ever double-click the floppy
icon and see an error message that says “Unknown Device”, there is an unformatted
floppy or floptical disk in the drive. To format it, see “Formatting Floppy and Floptical
Disks”.
If you are trying to copy files onto a disk that’s formatted for DOS files and you get an
error message that says “I/O Error”, your file names are too long or do not conform to
the DOS naming conventions. DOS file names can contain no more than eight characters,
a period (.), and a three character extension (for example, projects.exe uses the maximum
file name length).
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Troubleshooting Shared Resources Problems
If you cannot share resources, or cannot drag shared resources from other systems on to
your own desktop, either the optional NFS software is not installed or is not turned on,
or an important NFS utility called autofs (or automount) probably is not turned on.
To turn on NFS, open the System Manager window if it’s not already open (choose
System Manager from the System toolchest). Select the Network and Connectivity
category and then click “Set up and Start NFS” in the righthand column. The guide
appears and leads you through the necessary steps, including the step necessary for
enabling autofs (or automount).

Troubleshooting Network Errors
When you see error messages when you try to perform an operation that uses the
network, wait for a few minutes, then try the operation again. The network may just be
temporarily overloaded.

Troubleshooting General Network Errors
If the operation cannot succeed after a few tries, test the connection by following these
steps:
1.

Choose “Open Unix Shell” from the Desktop toolchest.

2. Use the /usr/etc/ping command with the hostname of a system that appears in your
Networking tool. For example, if the remote hostname is mars, type:
/usr/etc/ping mars

Then press <Enter>.
•

If your system can reach the remote system, you see messages similar to these:
PING mars (192.0.2.2): 56 data bytes
64 bytes from 192.0.2.2:icmp_seq=0 ttl=255 time=0ms
64 bytes from 192.0.2.2:icmp_seq=1 ttl=255 time=0ms
64 bytes from 192.0.2.2:icmp_seq=2 ttl=255 time=0ms

These messages will repeat indefinitely; to stop them, press <Ctrl-C>. Your
connection is working; try the operation again. If it still fails, see
“Troubleshooting General Network Errors”.
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•

If your system cannot reach the remote system, you see only one line similar to
this:
PING mars (192.0.2.2): 56 data bytes

Or you may see a line similar to this:
ping: mars: Unknown host

Press <Ctrl-C>, then try the ping command with a different hostname. If this
does not work, go on to the next step.
3. Check the console window for error messages.
■

Position your cursor over the console icon, click the left mouse button once, and
look for this message:
ec0: no carrier: check Ethernet cable

■

If you see this message, the physical connection between your system and the
network is not working. Make sure the Ethernet cable is firmly connected to
your system, then go back to step 2.

■

If you do not see this message, go on to step 4.

4. Make sure TCP/IP is turned on, and, if your system is on an NIS network, make sure
NIS is turned on and the correct NIS domain name is entered.
•

Use the “Set Up and Start Networking” guide to make sure TCP/IP is turned
on. See “Setting Up an Ethernet Connection” for more information.

•

Use the “Set Up and Start NIS” guide to make sure NIS is turned on and to
verify that your NIS domain name is correct. See “Turning On NIS and NFS” for
more information.
If these guides confirm that your settings are correct and you still can’t connect
to the network, contact your network administrator to report that your network
connection is not working correctly.
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Troubleshooting Standard Printing Problems
Once you’ve used the Printer Manager to set up the printers that you want to access,
printing files is usually very straightforward — you ask an application to print a file, then
pick up your completed job from the printer.
The work that the system does to make files print, however, is fairly involved —
especially when you are sending files over a network to printers that are not directly
connected to your workstation. If printing problems do arise, the information in this
section should help you correct them quickly.
The information applies to you only if you are printing from within an application or
from the desktop.
If you are printing from the command line using lp, see “Understanding the lp Spooler”
in IRIX Admin: Peripheral Devices for more information about lp. If you’re using lpr, see
the lpr reference (man) page for information on basic use.
This section covers two main topics:
•

“A Troubleshooting Roadmap” gives you a brief overview of the printing process,
plus step-by-step information to isolate and resolve printing problems. You’ll get
more out of this section if you also read “Understanding the Printing Process”, but,
if you’re anxious to resolve a problem without reading through background
information, start with this section.

•

“Understanding the Printing Process” describes the process in detail, outlines how
and when the process may fail, and describes the troubleshooting tools that are
available to you.
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A Troubleshooting Roadmap
A successful printing process includes these four basic steps:
•

You must issue a print command and specify a printer that is set up to work with
your system.

•

Your system (the local system) must correctly process the request and send it to the
system to which the printer is physically attached (the printing system).
Note: If the printer is physically attached to your system, the local system is also the

printing system; if the printer is attached to another system on the network, that
system is the remote, printing system.
•

The printing system must process the print request and send it to the printer.

•

The printer must be in working order; if it’s out of paper or toner, it cannot print.

See “Understanding the Printing Process” for a more detailed description of what the
system does at each step.
The troubleshooting steps below show you how to determine which part of this process
is failing. Be sure you know the Administrator’s password; various steps require that
you become the Administrator.
1.

If you sent your job to the printer more than 30 minutes ago, send it again. This way
you can monitor its progress from the start.

2. Start the Printer Manager by choosing “Printer Manager” from the System
toolchest.
3. Find the icon for the printer to which you sent your job.
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•

If the icon is there, double-click it to open it.

•

If you don’t see the icon, that printer has not been set up to work with your
system. See “Setting Up Printing Software”.
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4. Find your print job in the queue.
The entries in this window are jobs that have already reached the printer’s queue.
•

If you see your job in the queue and the printer is attached to the local system,
skip ahead to step 6.

•

If you see your job in the queue and the printer is attached to a remote system,
go on to step 5.

•

If you don’t see your job, see “Job Never Appears in the Local Queue”.
Note: Your job may not appear in the queue immediately after you issue the

print command; either it printed so quickly that the system didn’t have time to
display it in the queue, or there is a problem. If the printer did not print the job,
wait several minutes before assuming it’s not going to appear in the queue.
5. Physically go to the system to which the printer is connected. Its queue contains all
print jobs that have actually reached the system. Find your print job in the remote
queue.
Your job is labeled with your login name and is the same size as it is in the local
queue. It does not have the same job number.
•

If you see your job in the remote queue, go on to step 6.

•

If you don’t see your job, see “Job Never Appears in the Remote Queue”.

6. Watch the queue of the printing system (the system to which the printer is attached).
•

If your job disappears from the queue, skip ahead to step 9.

•

If after several minutes no jobs disappear from the queue, go on to step 7.

•

If all the jobs ahead of yours disappear, and jobs behind yours disappear while
yours remains at the top of the queue, delete your job and try to print it again.

7. Make sure the printer is printing requests. Physically go to the system to which the
printer is attached, open the printer’s queue window, and choose “Printer Printing
Your Queued Jobs” from the Queue menu.
•

If your job disappears from the queue, skip ahead to step 9.

•

If no jobs disappear from the queue, go on to step 8.
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8. Check whether lpsched, the print spooler that controls the flow of jobs out of the
queue, is running. On the printing system, open a shell window and type:
lpstat -r

Then press <Enter>.
•

If the lpsched spooler is running, you see this message:
scheduler is running

Go on to step 9.
•

If the lpsched spooler is not running, you see this message:
scheduler is not running

See “Checking and Restarting lpsched” to turn it on.
9. Check the physical state of the printer; for example:
•

Turn the printer off and on.

•

Make sure the paper or transparencies are properly loaded, there is enough
toner, and the printer isn’t physically jammed.

•

Check all status lights and panels on the printer for error messages.

•

Make sure the cable is securely connected to the correct ports on both the
system and the printer. If the cable appears frayed you may need to replace it.
Note: If you’re not using a printer cable supplied by Silicon Graphics, Inc., the

pinouts may not match the workstation ports, even though the cable seems to fit.
Refer to the printer’s owner’s guide for details.
•

If you find a physical problem, correct it and try printing again.

•

If you find no physical problem and no jobs disappear from the queue, the job’s
owner (possibly you) should cancel the job and try to print it again. If the next
job in the queue does not disappear, go on to step 10.

•

If you find no physical problem and your job disappears from the queue but
does not print, see “Job Disappears from a Queue but Never Prints”.

10. Remove all jobs from the queue and choose “Send Test Page” from the Printer menu
to send a test page.
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•

If the test page prints, try printing your job again.

•

If the test page doesn’t print, contact your local support organization.
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Job Never Appears in the Local Queue

Use this section if the printer icon to which you sent your print job appears in the Printer
Manager, but your job does not appear in the local queue. You should be looking at the
printer’s queue window.
1.

Choose “Send Test Page” from the Printer menu to test the printer setup.
•

If the test job appears in the queue, try printing your job again. If your job still
doesn’t appear, go on to step 2.

•

If the test job does not appear in the queue, make sure both “Printer Accepting
Your Jobs” and “Printer Printing Your Queued Jobs” are chosen in the Queue
menu. Send another test job. If it still doesn’t appear, contact your local support
organization.

2. Make sure you followed the correct steps to specify a particular printer for your job.
•

If you chose from a list of available printers and the job doesn’t appear in the
queue, go on to step 3.

•

If you typed the printer name into a field, or if the application filled in the field
for you, make sure the name exactly matches that of a printer that appears in
the Printer Manager; then try printing again. Remember that names are
case-sensitive; “Printer1” is not the same as “printer1”. If it still doesn’t appear,
go on to step 3.

•

If you didn’t explicitly specify a printer when you made the print request, either
you or the application previously specified a default printer; the job may be in
another printer’s queue.
See the user’s guide that came with the application to find out how it specifies a
default printer and how you can change it. (For example, when you select a file
and choose “Print” from the Selected toolchest or menu, the file is automatically
sent to the printer that you specified as the default in the Printer Manager.)
Change the default and try printing again. If it still doesn’t appear, go on to
step 3.
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3. Make sure you gave the application all the printing information it needs.
Some applications (such as IRIS Showcase™) have both a print command and a
print dialogue box. If a dialogue box appeared and you didn’t notice it, didn’t fill it
out correctly, or didn’t confirm your information (that is, click an Accept or OK
button), the job will not go to the queue.
•

If there is a dialogue box, fill it out completely, then try printing again. If the job
still doesn’t appear in the queue, go on to step 4.

•

If there is no dialogue box, go on to step 4.

4. Open the console window and check for error messages.
Note: You must look in the console; error messages will not be reported to any other

shell window.
•

If there are no error messages, contact your local support organization.

•

If a message states that you’re out of disk space, then there isn’t enough space
for the system to create a version of the file that is in the correct format for the
printer. Remove files or directories that you no longer need and try to print
your job again. You could also try just printing a range of pages rather than the
entire file.

•

If a message specific to the application from which you are printing appears, for
example, a message stating that the application couldn’t find a necessary file,
refer to the documentation that came with the application.

5. Look in the file /var/spool/lp/log for error messages.
Job Never Appears in the Remote Queue

Use this section if your print job appears in your local queue, but does not appear in the
queue when you view it on the system that’s connected to the printer. You should be
looking at the printer’s queue window.
1.
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See if there is already a different job in the remote queue that was sent from your
local queue (that is, a job that belongs to you or to another user on your local
system).
•

If no jobs from your local queue appear in the remote queue, go on to step 2.

•

If your local queue has already sent one job to the remote queue, it will not send
another job to the remote queue until the first one prints. Wait until the first job
disappears and, if your next job still does not appear in the remote queue, go on
to step 2.
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2. Make sure the local printer queue is sending print requests to the remote system.
•

Make sure “Printer Printing Your Queued Jobs” is chosen in the Queue menu. If
no jobs from your local queue appear in the remote queue, go on to step 3.

3. Make sure the information about the remote system and remote printer that is
shown in the printer’s queue window is accurate.
•

If someone changed the name of the printer or physically moved the printer and
connected it to another workstation, your jobs cannot reach it. See “Changing
the Setup of a Printer” to give the system the new information. Then try
printing again.

•

If the information about the remote system and printer is accurate, go on to step
4.

4. Check whether lpsched, the print spooler that controls the flow of jobs from the local
queue to the remote system, is running. On your own system, open a shell window
and type:
lpstat -r

Then press <Enter>.
•

If the lpsched spooler is running you see this message:
scheduler is running

Go on to step 5.
•

If the lpsched spooler is not running you see this message:
scheduler is not running

See “Checking and Restarting lpsched” to turn it on.
5. Test the network connection by opening a shell window and using the /usr/etc/ping
command with the remote system’s hostname. For example, if the remote hostname
is mars, type:
/usr/etc/ping mars

Then press <Enter>. You see some messages that will repeat indefinitely; to stop the
messages, press <Ctrl-C>. You see a summary of the connection. Look for these
lines:
mars PING statistics
<#>packets transmitted,<#> packets received,0% packet loss
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•

If this line reports 0% packet loss, your connection to the remote system is
working. Go on to step 6.

•

If this line reports between 1% and 100% packet loss, your connection to the
remote system is not stable.
Make sure the remote system is communicating with the network; use the
/usr/etc/ping command on the remote system to try to reach a system on the
network other than your system.
If the remote system can communicate with any other system on the network,
your system may not be connected to the network properly. On your own
system, try the /usr/etc/ping command with another hostname; also make sure
your network cable is properly connected to your workstation. If you cannot
communicate with any system over the network, or if a high percent packet loss
continues, contact your network administrator. Either your network connection
or the network itself has a problem.

6. Check the access permissions on the remote system by trying to copy a file to the
remote system using the same login account that lpsched uses to copy over your job.
For example, use jot to create a small text file named testit, then copy it to the remote
system (mars) using the lp account; type:
su lp
rcp testit lp@mars:/usr/tmp

•

If you see no error messages, the file successfully reached the remote system. Go
on to step 7.

•

If you see an error message saying that the login was incorrect or that
permissions were denied, contact the Administrator of the remote system; the
Administrator needs to make changes to the lp account.

7. Choose “Send Test Page” from the Printer menu in the Printer Manager on your
own system to test the printer setup.
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•

If the test job appears in the remote queue, go on to step 8.

•

If the test job does not appear in the remote queue, physically go to the remote
system, open the queue window for the printer, and turn off and on “Printer
Printing Your Queued Jobs” and “Printer Accepting Your Jobs” in the Queue
menu. Go back to your own system and send another test job. If the test job
appears, try to print your job again.
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8. Physically go to the remote system and open the console window to check for error
messages.
Note: You must look in the console on the remote system; error messages will not be

reported to any other shell window.
•

If a message states that the system is out of disk space, then there isn’t enough
space for the system to accept the file or to make a copy of the file to print. Have
the Administrator of the remote system remove files or directories that are no
longer needed and try to print your job again.

•

If a message specific to the application from which you are printing appears, for
example, a message stating that the application couldn’t find a necessary file,
refer to the documentation included with the application.

•

Look in the file /var/spool/lp/log for error messages.

•

If there are no error messages, try to print your job again. If your job still does
not appear in the remote queue, contact your local support organization.

Job Disappears from a Queue but Never Prints

Use this section if your print job disappears from a local or remote queue but the printer
never prints it out.
1.

Check your mail messages.
•

If the Administrator of the printing system deletes your job, you receive a mail
message to that effect. Contact the Administrator to make sure you may try to
print the job again.

•

If there is no such mail message, go on to step 2.

2. Check whether the printer is printing any jobs.
•

If the printer prints the next job in the queue, there is something wrong with
your particular job; go on to step 3.

•

If all jobs are disappearing from the queue but the printer does not print them,
skip ahead to step 4.
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3. Send the job again, and check whether the printer receives it.
Most printers have a status mechanism (a blinking light or digital message) that
shows that the printer has received a job and is trying to print it.
•

If the status mechanism shows that it is trying to print your job but never does,
the job is too complex; the printer either gave up after a specified period of time
(that is, it “timed out”), or the printer does not have enough memory to hold the
job. If possible, break it up into smaller jobs and try printing it again (for
example, send only two pages of a ten-page document). If it still doesn’t print,
go on to step 4.

•

If the status mechanism doesn’t show that it is trying to print a job, the printer
didn’t receive data that it could understand. This means the initial processing
that your application or other filter did to prepare the file for printing did not
produce a file in the correct format for this printer. You may be missing some
filtering software. Try printing the file on a different type of printer. For
example, if you initially sent your job to a color image printer connected to a
parallel port, now send it to a black and white PostScript printer connected to a
serial port. If it still doesn’t print, go on to step 4.

4. Remove all jobs from the queue on the printing system and choose “Send Test Page”
from the Printer menu to send a test page.
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•

If the test page prints, the printer is set up correctly, but cannot print the types of
files you are sending it. Contact your local support organization.

•

If the test job disappears from the queue but doesn’t print, contact your local
support organization.
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Checking and Restarting lpsched

Use this section to check whether lpsched is running, and to restart it if necessary.
1.

Check whether lpsched is running by typing:
lpstat -r

Then press <Enter>.
•

If the lpsched spooler is not running, you see this message:
scheduler is not running

Go to step 2 to turn it on.
•

If the lpsched spooler is running, you see this message:
scheduler is running

2. Turn on lpsched if it is not running.
■

Open a shell window on the system where it is not running, then log in as root
by typing:
su

Then press <Enter>.
If a prompt for a password appears, type the password then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
■

Start lpsched by typing:
/etc/init.d/lp start

Then press <Enter>.
■

Log out of the root account by typing:
exit

Then press <Enter>.
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3. Make sure lpsched is now running by typing:
lpstat -r

Then press <Enter>.
•

If the lpsched spooler is running, you see this message:
scheduler is running

Jobs that were not reaching a remote queue because lpsched was not running on
the local system should now reach that queue; jobs that were not disappearing
from the printing queue because lpsched was not running on the printing system
should now print out.
•

If you do not see this message, contact your local support organization.

Understanding the Printing Process
This sequence of steps describes the process that your system uses to print files. The
details (such as system name, application name, and job IDs) are only examples.
1.

On your own system (saturn), you ask an application (IRIS Showcase) to print a file
(slide1), and explicitly or implicitly request a particular printer (color-seiko).

2. Showcase (or another filter program) creates a new version of slide1 (a new file) that
is in the correct format for color-seiko.
3. Showcase runs the lp command on the file on saturn. lp assigns the file a job ID
number (10), sends it to color-seiko’s queue, and alerts lpsched (the spooler that
controls the flow of jobs out of the queue) that the file (job #10) is ready to be
printed. The printer’s queue displays job #10 in the local queue for color-seiko.
4. color-seiko is actually connected to another system on the network (mars) where it is
named seiko1. When job #10 reaches the top of color-seiko’s queue, lpsched copies it
across the network to lpsched on mars.
5. lpsched on mars assigns your job a new ID number (20) that doesn’t conflict with
other IDs on mars, and puts it in seiko1’s queue. The Printer Manager on mars shows
job #20 in seiko1’s local queue; the Printer Manager on saturn continues to show job
#10 in color-seiko’s queue.
6. When job #20 reaches the top of the queue, lpsched sends the job over a cable to
seiko1.
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7. seiko1 receives job #20 and prints out slide1 on paper or a transparency.
8. Job #10 disappears from color-seiko’s queue; job #20 disappears from seiko1’s local
queue. lpsched sends the next job in color-seiko’s local queue to mars.
Where the Process May Fail

This section shows how the process may fail at each step shown in “Understanding the
Printing Process”; it does not describe how to correct the failure. See “A Troubleshooting
Roadmap” for a step-by-step approach for isolating and correcting failures in the
printing process.
1.

When you ask an application to print a file on a certain printer:
•

The file may go to a printer other than the one you expect because a hidden
default is set.

•

You may specify a printer that’s not currently set up on your system.

•

You may not actually complete the print request.

2. When the application or filter tries to create a new version of the file:
•

There may not be enough memory or disk space in the system for the new file. If
this is the problem, you see an error message in the console window.

•

The new file it creates may not be in the correct format for the printer (usually
due to missing filter software). You will not find out that this has happened
until the printer fails to print it. An error message appears in the /var/spool/lp/log
file.

3. When the application runs lp on the file:
•

The printer may not be allowing new jobs to enter its queue, that is, “Printer
Accepting Your Jobs” is not chosen in the printer’s Queue menu.

•

If lp tries to make a copy of the file in /var/spool/lp/request, there may not be
enough memory or disk space in the system for the new file. If this is the
problem, you see an error message in the console window.

•

lp may not be able to find the printer you specified. If you typed in a printer
name that does not exist, lp cannot submit your job to that printer’s queue.
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4. When lpsched tries to copy the file to the remote system:
•

If lpsched is not running, it cannot direct the file to a printer or remote system.
Typing lpstat -r determines whether lpsched is running.

•

The remote queue may already contain a job that came from your local queue.
lpsched on your system waits until the job that is already in the remote queue
disappears from that queue before it sends the next job.

•

The printer may not be allowing jobs to exit from its queue, that is, “Printer
Printing Your Queued Jobs” is not chosen in the printer’s Queue menu.

•

The network may be down.

•

Your system may not be communicating with the network; for example, your
networking software is not working or your network cable is loose.

•

The remote system may not be communicating with the network; for example,
it may be turned off.

•

The remote system may not allow your system to use the printer. The remote
system can use the “Share a Printer” guide to give you access to the printer; see
“Sharing Media Devices and Printers With Other Systems” in the Desktop User’s
Guide.

•

The remote system may not have enough disk space to accept the file.

5. When lpsched on the remote system tries to process the file:
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•

When lpsched tries to make a copy of the file in /var/spool/lp/request, there may
not be enough memory or disk space in the remote system for the new file.

•

The remote printer may not be allowing new jobs to enter its queue, that is,
“Printer Accepting Your Jobs” is not chosen in the printer’s Queue menu.

•

The printer on the remote system may be gone or renamed. For example, if
someone changed the name of seiko1 to seiko2, lpsched on the remote system
cannot find seiko1. lp does not report this back to your system, so your job
remains in the local queue as if it were printing, but never appears in the remote
queue. lp does record the problem in the /var/spool/lp/log file on the local system.
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6. When lpsched sends the job over the cable to the printer:
•

If lpsched is not running, the file will never be directed to a printer. Use the lpstat
-r command on the remote (printing) system to check lpsched.

•

The printer may not be allowing jobs to exit from its queue, that is, “Printer
Printing Your Queued Jobs” is not chosen in the printer’s Queue menu on the
remote (printing) system.

•

The cable may be loose or disconnected.

•

The cable may be broken or frayed.

•

The cable may not have the correct pinouts to match the printer or the system.

•

The printer may be turned off.

7. When the printer receives the job and tries to print it:
•

The printer may be jammed or out of supplies such as paper or toner.

•

The printer may not have enough memory to print a complex job. In this case,
the printer’s status mechanism shows it is trying to print, but then the printer
gives up after a specified period of time, removes the job from the queue, and
prints nothing.

•

The printer may not understand the format of the job because the application or
filter did not convert the file correctly. In this case, the printer’s status
mechanism never shows that it is trying to print, and the printer removes the
job from the queue but never prints it.

8. When jobs disappear from the queue:
•

Jobs may disappear from the queue but never actually print as described above.

•

Jobs may never disappear from the queue if the physical printer is not working
correctly.

•

If jobs ahead of yours in the queue disappear, then jobs behind yours disappear
while yours remains at the top of the queue, there is something wrong with
your job; cancel it and try to print it again.
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Troubleshooting Tools

When you troubleshoot printing problems using “A Troubleshooting Roadmap,” you
use a number of different tools and techniques. This section summarizes the tools, and
suggests other sources of information on isolating and correcting problems.
“Send Test Page”
This choice appears in the Printer menu in the Printer Manager window
and in each individual printer’s queue window. When you choose
“Send Test Page,” you run the lp command on a sample file that is
already in the correct format for that printer; in other words, you bypass
steps 1 and 2 of the printing process described in “Understanding the
Printing Process”.
lpstat

This IRIX command provides an alternate view of the queues that the
Printer Manager displays; it also reports whether lpsched is running. To
see a full lpstat listing that includes queues for every printer on the
system plus the status of lpsched, you would type: lpstat -t

/var/spool/lp/log
This file contains a history of all printing activity and errors. Its
messages are often difficult to understand, but you may find some
useful error information that you can use for troubleshooting. For
example, a “login incorrect” message that has a timestamp near a time
when your job could not reach a remote queue may make you suspect
that there is a password on the lp account on the remote system.
/etc/init.d/lp start
This IRIX command restarts the scheduler, lpsched.
Other documentation
Chapter 9, “Administering Printers” in the optional IRIX Advanced Site
and Server Administration Guide contains a detailed table of printing error
messages and describes how to use the lp system from an IRIX shell; the
lp man page gives a complete listing of all the command line options for
lp.
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Troubleshooting lpr Printing
This section shows you how to diagnose and fix these common problems:
•

The print request never reaches the printer’s queue.

•

The print request reaches the queue, but never disappears from the queue because it
cannot reach the remote host (printing system).

•

The print request reaches the printing system and disappears from the queue, but
the printer either never prints it or prints something unexpected.

If the print request never reaches the printer’s queue (if you don’t see the request when
you type lpq), follow these steps:
1.

Make sure you entered the print command correctly.
•

If you set up the printer you are trying to use as the default, use this format:
lpr filename

•

If you did not set up the printer you are trying to use as the default, use this
format:
lpr -Pprintername filename

2. Check for error messages.
•

In the window from which you issued the lpr command, look for this message:
lpq:printername unknown

This tells you that the printer name you specified (either by editing .cshrc or
.profile, by setting the default with a command line, or by using the -P option)
does not match a printer name in the /etc/printcap file. Check the print request
you typed in step 1 and the edits you made to /etc/printcap for typing errors.
•

Choose “View System Log” from the System toolchest, and look for lpd or lpr
errors.
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3. Send a simple file to the printer, such as /etc/group.
•

If this file reaches the queue, lpr is working correctly, but there is something
wrong with the file you originally sent.

•

If it does not reach the queue, type:
/usr/etc/lpc status

Then press <Enter>. You should see messages like these:
printername:
queuing is enabled
printing is enabled
jobs in queue
no daemon present

Note: The no daemon present line always appears; this is a known bug.

•

If the queue or printing is not enabled, enable these functions by typing:
/usr/etc/lpc up all

Then press <Enter>.
If it still doesn’t reach the queue, contact your local support provider.
If the print request reaches the queue, but never disappears from the queue because it
cannot reach the remote host (printing system), follow these steps:
1.

Check for error messages:
•

Open the window from which you issued the lpr command.

•

Look for this message:
Waiting for remote queue to be enabled

If you see this message, ask the Administrator of the printing system to add
your system’s hostname to the /etc/hosts.equiv file on the printing system and
your system’s hostname and IP address to the /etc/hosts file.
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•

Look for this message:
lpr: connection refused
jobs queued but cannot start daemon

If you see this message, stop the lpr daemon (lpd) by typing:
/etc/init.d/bsdlpr stop

Then press <Enter>.
Restart the daemon by typing:
/etc/init.d/bsdlpr start

Then press <Enter>. Try printing the job again.
•

Look for this message:
connection to hostname is down

Your system cannot reach the printing system. Follow the instructions in step 2
to check the network connection.
2. Make sure you can access the printing system by using the /usr/etc/ping command
with the printing system’s hostname.
For example, if the printing system’s hostname is mars, open a shell window and
type:
/usr/etc/ping mars

Then press <Enter>. You see some messages that will repeat indefinitely; to stop the
messages, press <Ctrl-C>. You see a summary of the connection. Look for these
lines:
mars PING statistics
<#>packets transmitted,<#> packets received,0% packet loss

•

If this line reports 0% packet loss, your connection to the system is working.

•

If this line reports between 1% and 100% packet loss, your connection to the
system is not stable. Try using the same command with a different hostname. If
the line still reports a packet loss, see “Troubleshooting Network Errors.”
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3. Ask the Administrator of the printing system to verify that your system’s hostname
is in the /etc/hosts.equiv file on the printing system and that your system’s hostname
and IP address are in the /etc/hosts file. Also ask the Administrator to verify that the
printer is enabled and ready to print requests. When this is done, try printing again.
•

If the job still doesn’t reach the printing system, follow the instructions in
“Testing the Network Connection” for a more comprehensive test.

If the print request reaches the printing system and disappears from the queue, but the
printer either never prints it or prints something unexpected, follow these steps:
1.

Log in as root through a shell window.
■

Choose “Open Unix Shell” from the Desktop toolchest.

■

Position your cursor within the new window and type:
login root

Then press <Enter>.
If a prompt for a password appears, type the password then press <Enter>. If a
prompt appears but the root account has no password, just press <Enter>.
2. Send a test job to check whether lpr on your system is spooling jobs correctly.
■

Cancel all jobs in printer color’s queue and stop it by typing:
/usr/etc/lpc stop color

Then press <Enter>.
■

Send /etc/group as a test file by typing:
lpr /etc/group

Then press <Enter>.
■

Change directories so you are in your spool directory, for example,
/var/spool/lpd, and list its contents by typing:
cd /var/spool/lpd; ls -l

Then press <Enter>. You see a listing similar to this:
-rw-rw----rw-rw----rwxr-----rw-rw-r--
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1
1
1
1

joe
joe
joe
joe

lp
lp
lp
lp

25
69
00
12

Mar
Mar
Mar
Mar

17
17
17
17

14:02
14:02
14:02
14:02

cfA117mars
dfA117mars
lock
status
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■

Compare the copy of the file to print (the one that starts with df; in this example,
it is dfA117mars) with the test file you sent (/etc/group) by typing:
diff dfA117mars /etc/group

Then press <Enter>. If the system prompt returns and you see no listing of
differences, lpr is working correctly on your system. Go on to step 3.
If the system lists differences, lpr is not working correctly on your system.
Repeat the steps in “Setting Up lpr” to make sure you set up lpr correctly.
3. Once you know that lpr is working correctly on your system, you can assume that
there is a problem with the printing system. Contact the Administrator of the
printing system; this person will have to perform some of the steps in the rest of this
troubleshooting procedure.
■

On the printing system, the Administrator should log in as root, then cancel all
jobs in printer colorful’s queue and stop the printer by typing:
/usr/etc/lpc stop colorful

Then press <Enter>.
■

On your system, start printer color by typing:
/usr/etc/lpc start color

Then press <Enter>.
■

On your system, send /etc/group as a test file by typing:
lpr /etc/group

Then press <Enter>.
■

On the printing system, the Administrator should change directories to the
spool directory, for example, /var/spool/lpd, and list its contents by typing:
cd /var/spool/lpd; ls -l

Then press <Enter>.
The listing should be similar to this:
-rw-r----x
-rw-rw----rw-rw----rwxr-----rw-rw-r--

1
1
1
1
1

joe
joe
joe
joe
joe

lp
lp
lp
lp
lp

25
25
69
00
12

Mar
Mar
Mar
Mar
Mar

17
17
17
17
17

14:02
14:02
14:02
14:02
14:02

.seq
cfA117mars
dfA117mars
lock
status
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■

On the printing system, the Administrator should compare the copy of the file
to print (the one that starts with df; in this example, it is dfA117mars) with the
test file you sent (/etc/group) by typing:
diff dfA117mars /etc/group

Then press <Enter>. If the system prompt returns and there is no listing of
differences, lpr is working correctly on the printing system. Go on to step 4.
If the system lists differences, lpr is not working correctly on the printing
system. The Administrator of the system should check the printer setup.
4. Once you know lpr is working correctly on the printing system, the Administrator
should restart the printer (named colorful) on that system by typing:
/usr/etc/lpc start colorful

Then press <Enter>.
•

If the test job (/etc/group) prints, you should be able to print other files. If you
cannot print a particular file, there is a problem with the file, for example, it may
be too complex or in a format that the printing filter on the printing system
cannot interpret.

•

If the test job doesn’t print, the Administrator of the printing system should
check for physical problems, such as disconnected cables.

Software Installation
For troubleshooting information, see “Troubleshooting Software Installation.”

Running Confidence Tests
If any of your physical devices are not working properly, run the appropriate confidence
test. Follow these steps:
1.

Choose “Run Confidence Tests” from the System toolchest.

2. Double-click the device that you want to test. On-screen instructions guide you
through the test.
3. If a device is faulty, contact your local service organization.
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account
See login account.
active window
The only window that recognizes input (activity) from the keyboard and mouse; only
one window is active at a time. Make a window active by placing the cursor within its
boundaries.
Administrator
The person who can use the most privileged account, root. This person must have his
own personal login account for daily use, but, when there are serious system problems
to correct, the person logs in to the root account to change system information using the
graphical tools or using the IRIX shell.
The Administrator has all the capabilities of a privileged user, plus the capability to
change information in the root account (such as the password) and to log in to an IRIX
shell as root. Because there is only one root account, there is only one Administrator per
system.
ASCII text
An ASCII file contains text only. When you save a file as ASCII text, you save only the
characters, not the size, the font, the style, the color, or the format.
automount
An NFS utility that lets you share directories with other systems as if the directory
resided on your own disk. When automount is turned on, you can drag a directory icon
from the Shared Resources area of another system’s System Manager window onto your
own desktop.
back up
To copy a certain set of files and directories from your hard disk to a tape or other storage
media.
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backup tape
A tape that contains a copy of a set of files and directories that are on your hard disk. A
full backup tape contains a copy of all files and directories, including IRIX, that are on
your hard disk.
baud rate
The speed (calculated as bits per second) at which the system sends information to a
serial device, such as a modem or a terminal.
belongs to a particular person.
Berkeley Internet Name Domain (BIND)
A name server that implements the Internet Domain Name Service (DNS) for the IRIX
operating system (as well as other UNIX systems). DNS is a distributed database of
information about systems on a network. It enables a system to find information about
other systems on the network, such as their IP addresses and hostnames.
button
On a mouse, a button is a switch that you press with a finger. In a window on your screen,
a button is a labeled rectangle that you click using the cursor and mouse.
cache
A small fast memory holding recently-accessed data, designed to speed up subsequent
access to the same data. Most often located close (electronically) to the CPU (Central
Processing Unit) in your workstation. Data and instructions are temporarily stored in the
cache to reduce main memory access time
CD-ROM disk (CD)
A flat metallic disk that contains information that you can view and copy onto your own
hard disk; you cannot change or add to its information. CD-ROM is short for
compact-disk: read-only memory.
centralized network
A network where a central server controls services and information; the server is
maintained by one or more individuals called network administrators. On a centralized
network that uses NIS, this server is called the NIS master, and all other systems on the
network are called NIS clients. See also network administrator, NIS, NIS client, NIS domain,
and NIS master.
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choose
To press the left mouse button to bring up a pop-up menu, move the cursor to highlight
the command that you want to run, then release the button.
click
To hold the mouse still, then press and immediately release a mouse button.
command line option
Options that let you specify how you want to run an IRIX command. See the man page
for a command for a list of the available command line options.
confidence test
A test that you run to make sure a particular device (such as the keyboard, mouse, or a
drive) is set up and working properly.
configuration file
A system file that you change to customize the way your system behaves. Such files are
sometimes referred to as customization files.
console
The window that appears as a stowed icon each time you log in; IRIX reports
status and error messages to this window.
CPU
The CPU (Central Processing Unit) is the chip that processes data. Depending on the type
and version of a CPU, the system will run at different speeds.
current working directory
The directory within the file system in which you are currently located when you are
working in a shell window.
cursor
The small red arrow on the screen that echoes the movements of the mouse. It changes
shape depending on its location on the screen.
daisy-chain
A series of SCSI devices that are connected to each other, with one device connected to
the SCSI port on a system.
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DAT
A magnetic tape from which you can read and to which you can copy audio and digital
information.
data cache
A specialized, very small, very fast portion of memory where recently accessed data is
stored. It can help system performance.
default printer
The printer to which the system directs a print request if you do not specify a printer
when you make the request. You set the default printer using the Printer Manager.
default subsystems
Portions of a product that will be installed automatically if you do not customize a
product installation.
defaults
A set of behaviors that Silicon Graphics specifies on every system. You can later change
these specifications, which range from how your screen looks to what type of drive you
want to use to install new software. For example, when you run IRIS Showcase, the
Master gizmo opens by default You can change the default settings using the Preferences
gizmo.
delete
To permanently remove an object from an IRIS Showcase page. You can’t retrieve objects
you delete by choosing Paste.
desk
The collection of windows and icons that appears on your computer screen. You can
create multiple desks and switch between them. When you switch from one desk to
another, the screen changes, almost as if you had several different monitors.
desktop
The screen background. By default, several icons are placed on the desktop: a folder icon
representing your home directory, a dumpster icon, several application icons, and an
icon for each peripheral you have installed. You can place other icons on the desktop so
that you can access them more easily.
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directoryserver
The tool that maintains an accurate list of all network systems, users, and peripherals; it
runs on the network master system. When you search for one of these resources on your
network, your system contacts the directoryserver to find the information.
Directory View window
The window you see when you open a folder (directory) icon. It displays the files,
folders, and applications that the directory contains.
disk directory
A directory that represents an entire disk or a partition of a disk. When you open a disk
directory, you view the contents of the disk.
disk use
The percentage of space on your disk that contains information.
distributed network
A network where there is no automated central control of services or information. Each
system’s administrator must work with the network administrator to keep each system’s
network information up to date.
distribution directory
A directory that contains software that can be installed using Software Manager or Inst.
Typically this directory is copied from a CD into a directory on a server system so users
can install software across the network from a directory rather than from a CD.
domain
A group of hosts on a network whose hostnames have the same suffix. See also NIS
domain.
domain name
The common suffix found in all hostnames that are in the same domain on a network. See
also NIS domain.
double-click
To hold the mouse still, then press and release it twice, very rapidly. When you
double-click an icon it opens into a window; when you double-click the Window menu
button the window closes.
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drag
To press and hold down a mouse button, then move the mouse. This drags the cursor to
move icons or to highlight menu items.
drive
A hardware device that lets you access information on various forms of media, such as
hard, floppy, and CD-ROM disks, and magnetic tapes.
drive address number
The unique number that identifies each drive (such as hard, floppy, and CD-ROM drives)
to the system. See also SCSI address.
drive controller number
The unique number that identifies each controller (a board that controls the flow of
information from the system to a drive) to the system. See also SCSI controller.
drop pocket
A drop pocket is the small blue square into which you can drop icons. You can drag a folder
icon and place it into the drop pocket on a Directory View window. The window displays
the contents of that folder.
You can also drag a file or application icon and place it in the drop pocket on a Directory
View window. The window displays the contents of the directory in which that icon is
stored.
dumpster
A temporary holding place for icons that you remove using the “Remove” command. To
retrieve files from the dumpster, double-click the dumpster icon; to empty the dumpster,
choose “Empty Dumpster” from the Desktop toolchest.
electronic mail
A utility that lets users on a network send messages from one system to another.
electronic mail address
Your login name plus location information so you can receive electronic mail. The
address is usually assigned by the network administrator.
Ethernet cable
The cable that connects your system to a network that runs TCP/IP.
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Ethernet port
The outlet on your system to which you can connect an Ethernet cable. This connection
lets you communicate on a network that runs TCP/IP.
field
An area in a window in which you can type text.
file
A container in which you store information such as text, programs, or images you create
using an application.
file hierarchy
See filesystem.
filesystem
A hierarchy of directories and files. Directories contain other directories and files; files
cannot contain directories. The root (/) directory is at the top of the hierarchy.
FPU
A hardware chip inside the system that speeds up calculations that use floating point
numbers. FPU stand for Floating Point Unit.
full name
A person’s actual name, as opposed to their login name.
group
A collection of login names. Members of a group can make file permissions apply to all
other members of a group.
handshake
The protocol that controls the flow of information between a system and a printer. A
hardware handshake uses only cable wires and pins to control the flow. A software
handshake (also called xon/xoff flow control) uses a combination of pins, wires, and
software.
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home directory
A directory in which you create and store your work. Usually, the home directory is
named /usr/people/loginname, where loginname is the name of your login account. A folder
icon for your home directory appears on the desktop by default.
host
Any workstation connected to the network.
hostname
The name that uniquely identifies each host (system) on the network.
host resolution order
The sequence in which network connection names (such as hostnames) are mapped to
Internet addresses (IP addresses). The sequence determines the order in which various
services, such as BIND, NIS, and a local database (hosts file), perform the mapping.
hosts file
A file or map used to perform host resolution; contains the IP addresses and hostnames
of systems on the network.
icon
A small picture that represents a stowed or closed file, directory, application, or IRIX
process.
icon finder
The area of a window that contains the drop pocket, the pathname field, the path bar, and
the recycle button. You use these fixtures to move from one directory to another.
image
A logical grouping of the parts that make up an installable product; see also product and
subsystem.
incompatible products
One or more software products that cannot be installed on a system at the same time. For
example, a product that runs on version 3 or higher of the operating system is
incompatible with version 2 of the operating system.
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input focus
Only one window at a time recognizes mouse movement and typing. The window that
does is said to have the input focus.
inst
The software tool that you use to install system software, software options, and
maintenance releases that come from Silicon Graphics. It is the command-line version of
Software Manager.
installation conflicts
The Software Manager and inst report these when you select a combination of software
for installation or removal that cannot be safely installed or removed. The installation
tool gives you choices for resolving the conflicts to complete the installation.
installed products
Products that are currently installed on your system.
instruction cache
A specialized, very small, very fast portion of memory where recently executed machine
instructions are stored. It can help system performance.
IP address
The number that uniquely identifies each system on the network.
IP forwarding
A process in which network messages are received from a computer (host) on one
network and relayed to a destination on a different network.
IRIS
Any graphics workstation manufactured by Silicon Graphics.
IRIX
Silicon Graphics version of the UNIX operating system. See also system software.
IRIX processes
Tasks that IRIX carries out to keep the system running correctly or to complete an explicit
command. Each process has a unique process ID number.
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ISDN
Integrate Services Digital Network (ISDN) - A set of communications standards allowing
a single wire or optical fibre to carry voice, digital network services and video.
Java
An object-oriented, platform-independent programming language developed by Sun
Microsystems; used extensively on the Internet and the World Wide Web.
JavaScript
A simple, cross-platform, World Wide Web scripting language used by Netscape.
Kb (Kilobyte)
A standard unit for measuring the information storage capacity of disks and memory
(RAM and ROM); 1000 bytes make one Kilobyte.
launch icon
An arrow-shaped icon that appears in the right margin of the IRIS InSight viewer and the
Help viewer. Double-click this icon to run an application.
linked copy
A pointer to a file or directory that exists in a different location in the file system. When
you make a linked copy of a file, you are not creating another instance of the file; you are
creating another location from which you can access the original file.
local IP address
The local IP Address refers to your workstation's IP address.
local workstation, drive, disk, filesystem, or printer
The physical workstation whose keyboard and mouse you are using, all hardware that is
connected to that workstation, and all software that resides on that hardware or its
removable media.
log in
To give the system your login name so you can start a session on your workstation.
log out
To end a session on your workstation.
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logical swap space
Actual disk space that the system uses as if it were memory (RAM). By default, your
system allocates 40 MB of your disk in the /dev/swap file. See also virtual swap space.
logical volume
A logical volume is a number of areas on one or more hard disks that the system
considers as one filesystem. The fact that the areas of disk space are not contiguous is
hidden from the user. See also striping.
login account
A collection of information about a person who can log in to the system. The information
includes the person’s full name, login name, contact information, and the name of a
home directory in which the person can store directories and files.
login name
A short version of your own name or your initials; you type it to log in to the system, and
the system uses it to label files that belong to you. If your system is on a network, the
network administrator usually must approve of the name to make sure it is unique.
login screen
The window that you see after powering on the system, before you can access files and
directories. The window contains one icon for each login account on the system.
lpr
Printing software that lets you access a printer that’s connected to a system that runs the
BSD version of UNIX.
main memory
The location where all user programs and data, and all operating system programs and
data reside. Also called RAM (Random-Access Memory).
man page
Reference information about UNIX commands. You can view man pages by choosing
“Man Pages” from the Help toolchest.
Mb (Megabyte)
A standard unit for measuring the information storage capacity of disks and memory
(RAM and ROM); 1000 Kilobytes make one Megabyte.
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menu
A list of operations or commands that the workstation can carry out on various objects
on the screen.
menu button
A button that reveals a pop-up menu. Place the cursor over the button; then press the left
mouse button.
mount
To make a file system that is stored on a local or remote disk resource accessible from a
specific directory on your workstation.
mount point
The directory on your workstation from which you access information that is stored on
a local or remote disk resource.
mouse
A hardware device that you use to communicate with windows and icons. You move the
mouse to move the cursor on the screen, and you press its buttons to initiate operations.
An optical mouse must always be on the mouse pad for the IRIS to interpret its
movements; a mechanical mouse works on any clean, flat surface.
mouse pad
For an optical mouse, this is the rectangular, metallic surface that reads the movements
of the mouse. For a mechanical mouse, this is a clean, soft rectangular surface that makes
the mouse’s trackball roll efficiently.
multi-tasking system
A system that can run several processes (such as running applications, printing files, and
updating files) simultaneously.
multiuser system
A system that several users can work on simultaneously and maintain private files.
netmask
An addressing scheme that creates a logical grouping of a subset of systems on your
network.
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NetWare
Novell, Inc.'s proprietary networking operating system for the IBM PC.
network
A group of computers and other devices (such as printers) that can all communicate with
each other electronically to transfer and share information.
Network Access account
A person who has a Network Access account on a system can log in to the system only
when the network and the optional NIS software are running properly. The information
in a Network Access account is entered by the network administrator on the NIS master
system.
network administrator
The network administrator is the person who maintains a network of systems. If the
network runs the optional NIS software, the network administrator maintains the master
database of login account information.
new products
The Software Manager considers a product to be new when the product is available for
installation, has never been installed on the system on which Software Manager is
running, and has never been available during a previous installation session.
NFS
A networking software option that lets you access files and directories that reside on the
disks of other workstations as if they resided on a local disk in your own workstation.
NFS stands for Network File System.
NIS
A networking software option that lets you control network information and services
from a central server called the NIS master. NIS stands for Network Information Service.
See also centralized network, NIS client, NIS domain, and NIS master.
NIS client
Any system on a centralized network that runs NIS other than the NIS master. The NIS
client receives services and information from the NIS master.
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NIS domain name
The unique name of a network (or sub-network) that runs NIS. All hostnames in the NIS
domain have the NIS domain name as their suffix.
NIS master
The server that stores the complete database of information about all the hosts (systems)
and users on a centralized NIS network. The NIS master periodically updates host
information on all other systems on the network (NIS clients); its user information is
always available to every host. The network administrator is responsible for setting up,
maintaining, and troubleshooting the NIS master.
notifier
A form that appears when the system requires you to confirm an operation that you just
requested, or when an error occurs.
open
To double-click an icon, or to select an icon then choose “Open” from a menu in order to
display a window that contains the information that the icon represents.
operating system
The low-level software that schedules tasks, allocates storage, handles the interface to
peripheral hardware and presents a default interface to the user when no application
program is running.
owner
The user who created a particular file or directory and can specify which other users of
the system can access the file.
pane
A distinct region within a window. Usually you can choose to display all or some panes.
parent directory
A relative term that refers to a directory that contains another directory. If directory A
contains directory B, then A is the parent directory of B.
password
A combination of letters and/or numbers that only you know; it is an optional element
of your login account. If you specify a password for your account, you must type it after
you type your login name before the system lets you access files and directories.
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path
A list of directories the system searches when trying to find a file or run a program. You
can add directories to and delete directories from your path.
pathname
The list of directories that leads you from the root (/) directory to a specific file or
directory in the file system.
peripheral
A hardware device that adds more functionality to the basic workstation, such as a tape
drive.
permissions
The information attached to each directory and file that specifies which users can access
it and to what degree.
point-to-point link
A connection between two systems using PPP (Point-to-Point Protocol).
PPP
(PPP) The Point-to-Point Protocol provides the Internet standard method for
transmitting IP packets over serial point-to-point links. You can use PPP to communicate
with a remote computer over an ISDN or modem connection.
prerequisite products
Software products that must be installed in order for other products to work. If product
A must be installed for product B to work, product A is a prerequisite product for
product B.
primary group
A user can belong to several different groups, but one group must be the person’s
primary group. When a user creates a new file or directory, the system automatically sets
permissions on the file that determine whether other members of a group can view or
change the information. By default, the system labels the file with the user’s primary
group. This means if the user wants members of a different group to which the user
belongs to access the file, the user must explicitly change the group ownership of the file
to the other group.

223

Glossary

Printer Manager
A tool that you use to set up printer software and monitor jobs that you send to the
printer. You access it through either the System toolchest or the System Manager, where
it is called the Printer tool.
Privileged User
A person whose standard login account includes administrative privileges. There can be
more than one privileged user on the same system.
product
A product is the largest module of software that Software Manager or Inst can install. The
operating system consists of several products that are required for the system to run. See
also subsystem and image.
port
An outlet to which you attach cable connectors.
power cable
The cable that connects the workstation to a grounded electrical outlet.
power down
To turn off the power switches on the workstation chassis and the monitor.
power up
To turn on the power switches on the workstation chassis and the monitor.
PROM monitor
The interface that you use to communicate with the system after it is powered up, but
before it is booted up and running IRIX.
prompt
A character or word that the system displays in an IRIX shell that indicates that the
system is ready to accept commands. The default prompt for regular user accounts is %;
the default prompt for the root account is #.
queue
A list of print jobs waiting to be printed on a particular printer.
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quit
To stop running an application.
remote IP address
The remote IP Address refers to the IP address of a workstation on a network or over an
ISDN or modem connection.
remote workstation, drive, disk, file system, or printer
A hardware device or the information or media it contains that you can access across the
network; they are not physically connected to your workstation.
removable media device
A removable media device is a storage device, such as a tape drive or floppy disk drive,
from which you can remove the medium upon which the data is actually stored.
reset button
A physical button on the workstation that you press to cut off then immediately restore
power to the workstation. You should never press this button while IRIX is running,
unless all attempts to shut down the system using software fail. See also shut down.
restore (files)
To copy files that once resided on your hard disk from another disk or a tape back onto
your hard disk.
root account
The standard IRIX login account reserved for use by the system administrator. This
account’s home directory is the root (/) directory of the filesystem; the user of the root
account has full access to the entire filesystem (that is, can change and delete any file or
directory). The user of this account is sometimes referred to as the superuser.
root (/) directory
The directory at the top of the file system hierarchy.
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route
Also referred to as a link. A group of addresses on a network that define a path from one
station (the source address) to another station (the destination address). Each address
within a route provides the next step along that route. And, each address for an
intermediate station is a where the packet stops (is picked up) and is transferred to
another local area network. A complete route from source to destination may consist of
one or numerous addresses.
routing
The process of discovering and assigning a route from a sending computer (the source
address) to an intended receiving computer (the destination address). The routing
method used for any particular packet/datagram can be either source routing or
transparent routing. The exact manner in which routing is done differs from protocol to
protocol.
same products
The Software Manager considers a product to be “same” when the product is available
for installation, and is the same version as a product that is currently installed on the
system on which Software Manager is running.
SCSI
An acronym that stands for Small Computer System Interface protocol. SCSI is a
standard protocol for transferring information from a computer to another device.
SCSI address
A number from one to seven that uniquely identifies a SCSI device to a system. No two
SCSI devices that are physically connected to the same SCSI controller on a system can
have the same SCSI address.
SCSI cable
A cable that connects a SCSI device to a SCSI port on a workstation.
SCSI controller
An internal board that sends data to and from SCSI devices. You can have more than one
SCSI controllers.

226

Glossary

SCSI device
A hardware device that uses the Small Computer System Interface (SCSI) protocol to
communicate with the system. The system disk, floppy drives, CD-ROM drives, and tape
drives are all SCSI devices.
select
To position the cursor over an icon then click the (left) mouse button. Once an icon is
selected, it is the object of whatever operation you select from a menu.
serial device
Any hardware device that requires a serial cable connection to communicate with the
workstation.
serial port
An outlet on the workstation to which you connect external serial devices.
server
A system that other systems on the network access to use its disk space, software, or
services.
shadow password file
For secure systems, a file where encrypted passwords are stored, making it more difficult
for unauthorized users to break into the system.
shelf
The shelf is a place for you to put icons that you need to use frequently while working in
a particular directory. For example, if the directory contains many files, you might want
to place the files you use most frequently on the shelf. Or, if the directory contains many
color Showcase slides, you might want to place the icon for a color printer onto the shelf.
shell
A window into which you type IRIX commands.
shell program
A program that issues and interprets a sequence of IRIX commands.
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shut down
To safely close all files, log out, and bring the workstation to a state where you can safely
power it down. You choose “System Shutdown” from the System toolchest menu to do
this.
SLIP
Standard system software that lets you connect to a network using a serial cable and a
modem rather than using an Ethernet cable. Once you’re connected, you can use the
network as if you were connected by an Ethernet cable. SLIP stands for Serial Line
Internet Protocol.
Software Inventory list
The list of available and/or installed software that the Software Manager provides when
you click the Customize Installation or Manage Installed Software button, and when you
have chosen to display the Software Inventory pane using the Panes menu.
software option
Any software product that you buy from Silicon Graphics other than the standard system
software that comes on your system disk.
Standalone Access account
An account that you can log in to whether or not the system is connected to the network
or NIS is running. The account information is stored on the local system rather than on
the NIS master system.
standalone system
A system that is not connected to a network.
striped volume
A logical disk volume comprising multiple disk drives, in which segments of data that
are logically in sequence (“stripes”) are physically located on each drive in turn. As many
processes as there are drives in the volume can read concurrently at the maximum rate.
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striping
The method of minimizing disk access time when creating logical volumes. On a striped
volume, the workstation lays out the filesystem in stripes and allocates information
alternately between the stripes. The principle at work is that the seek time for the disks
is shorter because successive read and write operations will take place on different
stripes and a different head will be used for each read or write operation. See logical
volume.
subnet
A logical subset of all systems on a network. Typically, all systems on a subnet are
physically close to each other, for example, are all located in the same building.
subsystem
A portion of a software product. Each product consists of several subsystems; some are
required and some are optional. See also product and image.
superuser
An alternate name for the user of the root login account. See also system administrator.
swap space
When a workstation is running many programs at once, it might run short of available
memory. When this happens, sections of program that are not immediately being
executed are written out to a special area of the disk, where they can be easily retrieved.
That area of disk is known as “swap space” and the action of moving pages of program
in and out is known as “swapping” or “paging.” See also logical swap space and virtual
swap space.
system
All the hardware and software that makes up the computer.
system administration
A collection of tasks and responsibilities carried out by a system’s Administrator to set
up the system and keep it in good running order.
system disk
The disk that contains the IRIX operating system software and Silicon Graphics tools.
system resources
Directories and peripherals that physically reside on your system.
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system software
The standard IRIX operating system software and Silicon Graphics tools that come on the
system disk and on the tape or CD-ROM that you use in the event of a system crash.
System toolchest
The toolchest in the upper left portion of the screen from which you can access all system
administration tools.
TCP/IP
The standard networking software that’s included in the system software.
terminal
A display and keyboard, or a printer and keyboard, for entering programs and data to a
computer and for receiving output from a computer
UNIX
A multiuser, multi-tasking operating system from AT&T upon which Silicon Graphics
Inc.’s IRIX operating system is based.
unmount
To make a file system that is accessible from a specific directory on your system
temporarily unavailable.
upgrade products
The Software Manager considers a product to be an upgrade when the product is
available for installation, and is a newer version of a product that is currently installed
on the system on which Software Manager is running.
user
Any person who has a standard login account on the system. When a User logs in, he can
change only his personal work area. A User can run the graphical administration tools,
but the features of the tools that change system information are not available.
user account
A collection of information about a person who can log in to the system. The information
includes the person's full name, login name, contact information, and the name of a home
directory in which the person can store directories and files.

230

Glossary

user ID
A number that uniquely identifies a user to the system.
UUCP
Standard system software that lets you connect to a network using a serial cable and a
modem rather than using an Ethernet cable. Once you’re connected, you can log into a
single system through one window; your system essentially behaves like a dumb
terminal.
virtual swap space
A file that the system considers to be a certain size (e.g., 40MB) but actually occupies no
disk space. This is useful because many programs request much more swap space than
they really need in order to run, and tie up the real swap space unnecessarily. When you
add virtual swap space, the system lets you start applications even when they request
more swap space than is actually available. In most cases this is fine, because there is
enough real swap space for them to run. See also logical swap space.
wildcard
A character, usually an asterisk (*), that you use alone to specify all files and directories
that are available, or with a few other letters to specify a group of files and directories that
have a common element in their names. For example, to specify all files and directories
that begin with the letters “ch”, you would type: ch*
window
A portion of the screen that you can manipulate that contains text or graphics.
window close box
The small box in the upper left corner of a window that contains a horizontal bar. You
double-click this box to close a window.
window manager
The system program that draws and controls windows. It lets you create and manipulate
windows — move them, resize them, and close them.
workstation
The physical hardware that contains the CPU and graphics boards, a system disk, and a
power supply. You connect it to a monitor, keyboard, and mouse to configure a working
system. It is also sometimes referred to as the chassis.
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X Window System
A standard for device-independent windowing operations on bitmap display devices,
developed originally at MIT (Massachusetts Institute of Technology). X is based on a
client-server model in which, unlike other client-server models, the server is the
computer or terminal with the screen, keyboard, and mouse, and the clients are
application programs.
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D

4mm, drives and tapes, 170
See also DAT
8mm, drives and tapes, 170
See also NTSC, PAL, P5, P6

DAT, drives and tapes, 170
See also 4mm
dial-in/dial-out modem software
testing, 31
dialing out to another modem, 31
dial-out modem software
testing, 31
drives
local tape
defined, 169
restoring files using, 172
remote tape
defined, 169
restoring files using, 172
tape, 169, 170

B
background processes, defined, 179
backing up files
about standard IRIX tools for, 173
choosing tapes for storing data, 170
developing a backup strategy, 168
inserting tapes in IRIS workstations, 170
using tar, 174
Backup and Restore tool
described, 169
restoring files, 172
See also System Manager
baud rate
for modems, 30

C

F
files
backing up with tar, 174
restoring with Backup and Restore tool, 172
restoring with tar, 176
foreground processes, defined, 179

capacities, tapes, 170
choosing tapes, 170
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P

installing tapes, 170
IRIS workstations
choosing tapes for, 170
installing tapes in, 170
IRIX operating system, 2
See also system disk
system administration and, 2

P5 tapes, 170
See also 8mm, PAL
P6 tapes, 170
See also 8mm, NTSC
PAL tape format, 170
See also 8mm, P5
processes
about, 179
background, 179
foreground, 179
monitoring, 179
processor status (ps) command, using to monitor
processes, 179
ps (processor status) command, using to monitor
processes, 179

L
local drives. See drives, local

M
monitoring processes, 179

Q
N
network administrator
role defined, 5
See also system administrator
networks
responsibilities of single-system administrator on,
4
NTSC tape format, 170
See also 8mm, P6

O
operating system
See IRIX operating system and system disk

234

QIC 150, 170
QIC 24, 170

R
remote drives. See drives, remote
Restore tool. See Backup and Restore tool
restoring files
about standard IRIX tools for, 173
using Backup and Restore tool, 172
using tar, 176
root account
responsibilities of single-system administrator, 3

Index

S
single system
responsibilities of system administrator on, 3
superuser, defined, 8
system
single, 3
system administration
defined, 2
IRIX operating system and, 2
system administration tools
about, 5
See also Backup and Restore tool, Disk and File
tool, IRIX shell, Networking tool, Printer tool,
root account, Serial Ports tool, System
Manager, Users tool
system administrator
responsibilities on network, 3
responsibilities on single system, 3
System Manager
See also Backup and Restore tool, Disk and File
tool, Networking tool, Printer tool, Serial Ports
tool, Users tool, 5

testing
hardware. See owner’s guide
modem setup by dialing out, 31
turning off IRIS workstations. See owner’s guide
turning on
IRIS workstations. See owner’s guide

V
versions
checking for eoe2.sw.uucp (uucp software), 30
viewing
a backup tape using tar, 176

W
WorkSpace
using. See IRIS Essentials

T
tape archiver (tar) program. See tar
tape drives
about formats, 170
inserting tapes into, 170
installing in IRIS workstations. See owner’s guide
tapes, about formats and capacities, 170
See also QIC 24, QIC 150, 4mm, 8mm, DAT, P5, P6,
PAL, NTSC
tar (tape archiver)
using to back up and restore files, 174
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